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Chapter 1 - Understanding General Ledger 
 
 

The following are definitions of key words used in this Manual. 
 

Accounting 

"Accounting" is the methodical collection, categorization, and organized presentation of 

financial records. 

 

 

General Ledger 

General Ledger is the area of accounting where all accounting records are brought together to be 

classified and summarized. Financial Statements are printed based on this data. 

 

As used here, "general" means "pertaining to many areas".  General Ledger is often abbreviated 

"G/L" or "GL". 

 

"Ledger" means a book where accounting records are kept.  (This term evolved from 

pre-computer times when accounting records were kept exclusively by hand in large books 

called "ledgers").  

 

 

General Ledger Account 

A "General Ledger Account" is a specific category under which all financial activity of a certain 

kind is classified.  For example, you might have a general ledger account called "telephone 

expenses", under which you categorized your telephone bills.   

 

Accountants are experts at defining the various G/L accounts (financial activity categories) 

needed by a business.  Part of this definition process involves assigning an "account number" to 

each G/L account. 

 

Independent businesses usually use a 3- or 4-digit account number.   For example, you may have 

a G/L account called "100 - Cash in the bank", and one called "400 - Sales of Product A", and 

one called "410 - Sales of Product B". 

 

Typically, an independent business will have a hundred or more G/L accounts.  In Samco 

accounting Packages, each time any financial activity occurs in any area of accounting, the dollar 
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amount of the activity is recorded under the appropriate G/L account. 

 

Chart of Accounts 

Here "chart" means "a list".  Your "Chart of Accounts" is the list of all of your G/L accounts. 

 

 

Profit Centres and Sub-Accounts 

Sub-Accounts 

A "sub-account" is a number which you can set up as part of the G/L account number. 

 

You can use sub-accounts to categorize expenses in whatever way you choose.  Their use is 

optional. 

 

One of the main uses of a sub-account is to represent a profit centre.  Profit Centres are often 

used in other Samco Packages (A/R, A/P, O/E, P/I, etc.)  This use is discussed in the next 

section. 

 

A sub-account may also be used to categorize expenses for different types of merchandise.  For 

example, you could use sub-account 001 for CD players and sub-account 002 for VCRs, etc.  

Then the following G/L accounts could be set up: 

 

• 5000-001  Purchases - CD players 

• 5000-002  Purchases - VCRs  

 

 

Profit Centres 

A "profit centre" is a part of your Company for which sales and/or expenses (and sometimes 

profits) can be calculated separately from the total sales and expenses of the whole Company. 

 

For example, let's say your "office supplies" G/L account is number 5200.  And let's say you 

want to track office supply expenses independently for each of your three major departments 

(Dept. A, Dept. B, and Dept. C.).   

 

Rather than use a different main account number for each department (such as "5201", "5202", 

and "5203"), you could append "-001", "-002", and "-003" to the "5200" main account number as 

follows: 

  

• 5200-001 Office supplies, Dept. A  

• 5200-002 Office supplies, Dept. B  

• 5200-003 Office supplies, Dept. C  

 

Then, whenever you're allocating office supply expenses to G/L accounts, you use the above 

7-digit numbers.  Later, when you're printing Reports, you can specify that you want to see only 

the information for Dept. A, or Dept. B, or Dept. C. 

 

Profit Centres also apply to sales.  A typical use for tracking sales by profit centre is for a 

Company which has several sales offices.  By making each sales office a profit centre, you can 

separately track the sales performance of each office. 
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When you want to produce Financial Statements for the whole Company, the General Ledger 

Package can combine all activity for all profit Centres (sub-accounts), so you get the complete 

picture. 

 

 

Transactions 

As used in accounting, "transaction" means a business event involving money and goods or 

services.  For example, a transaction occurs each time you gas up your car:  you pay money in 

exchange for gasoline (goods).   

 

Because computer software deals primarily with business events which have already taken place, 

"transaction" means the record of a completed business event involving money and goods or 

services. 

 

The records of sales made and payments received are examples of transactions from the area of 

accounting called "accounts receivable".  The records of your purchases and the payments you 

make for such purchases are transactions from the accounting area called "accounts payable".  

The records of quantities of goods received or sold are transactions from the area of accounting 

called "inventory control". 

 

In Samco software, when a transaction is entered into the system (into a file), it is often referred 

to as an "entry". 

 

 

Source (of a Transaction) 

The "source" of a transaction (entry) is simply the accounting area where the entry originated 

(where it was first entered into the computer). For example, a salary expense typically starts in 

the area of accounting called "payroll". 

 

When hundreds (or even thousands) of entries are generated in other areas of accounting and 

then gathered together in G/L, it is helpful to know the source of each one.  Samco G/L has, as 

part of each entry, an abbreviation representing the source of that entry.   

 

 

Debit and Credits 

In addition to handling a particular area of accounting, as described above (such as accounts 

receivable or accounts payable), each Samco Package also keeps track of the effect of those 

entries on G/L.  For example, when you make sales to, or receive payment from your Customers, 

this activity affects not only A/R, but also G/L. 

 

These entries must be recorded both in the proper A/R Customer accounts and in G/L under the 

proper G/L account numbers. 

 

The terms "debit" and "credit" refer to the types of entries which must be recorded in G/L 

accounts to accurately reflect the activity occurring in all accounting areas. 

 

In A/R, a debit memo issued by you to a Customer increases what that Customer owes you, and a 

credit memo decreases what is owed.  Unfortunately, debit doesn't always mean "an increase in 
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an account" and credit doesn't always mean "a decrease in an account".  In some accounting 

areas, a debit increases a G/L account and a credit decreases a G/L account.  In other areas, a 

debit decreases, and a credit increases, a G/L account. 

 

This occurs because of the system called "double entry accounting" (also called "double entry 

bookkeeping") which is the standard method of accounting used today.  

 

 

Double Entry Accounting 

The concept behind double entry accounting is that every entry (transaction) results in 

balancing debit and credit entries into the General Ledger. 

 

Let's look at the debits and credits involved when a typical independent business pays for goods 

or services bought earlier on credit:  

 

The debit:  The disbursement (payment you make) results in a debit entry which decreases your 

"money owed others" account (usually called the "accounts payable" account).  This is a "debit 

to accounts payable". 

 

The credit:  The payment also causes a credit entry which decreases one of your "cash on hand" 

accounts.  This is a "credit to cash". 

 

Two entries are made into G/L which balance each other.  These balancing entries form the basis 

of double entry accounting.  If you or your accountant ever find your G/L accounts "out of 

balance", it means that the proper balancing entries were not made.  

 

No attempt is going to be made in this Manual to teach you all about accounting, especially 

about what types of entries cause what accounts to be debited or credited.  Unless you're an 

accountant or fully responsible for maintaining your Company's general ledger, don't worry if 

you don't remember whether a debit increases or decreases a particular type of G/L account. 

 

When using Samco accounting software, you will occasionally be asked to enter the G/L account 

to be debited or credited.  Just refer to the appropriate Chapter in this User Manual, where you'll 

find exact instructions about what to enter. 

 

Within all Samco Power Accounting Modules, the software automatically takes care of double 

entry accounting as you enter the required information on the screen.  

 

 

Function 

As used here, "function" means one or more programs that accomplish a specific task. 

 

Each selection on the main Menu for a Samco Package is a function.  When you select a function 

from a Menu, one or more programs automatically execute, thereby allowing you to accomplish 

the task you selected. 

 

 

General Journal  

A "Journal" is actually a Report or book where the activity in some specific area of accounting is 
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recorded on a regular basis (usually daily). 

 

For example, in the area of accounting called Accounts Receivable, there is a function that 

allows you to enter your cash receipts (the payments you receive).  As part of that function, a 

Report called the "Cash Receipts Journal" is printed, showing all the payments, you received for 

that period of time (usually a day). 

 

In the Samco G/L Package, the term "general Journal" refers to the entire function for entering 

miscellaneous entries into the system.  It includes the entry program, as well as the program 

which prints the Journal showing what entries you made. 

 

Using the general Journal function, you can make a debit or credit entry for any G/L account. 

 

When the G/L Package is used by itself (that is, not in conjunction with other Samco accounting 

Packages), the general Journal function is used to enter all (or almost all) the entries into the 

system. 

 

However, when G/L is used with other Samco accounting Packages, many entries are fed into 

G/L from Journals in these other Packages.   

 

For example, entries from the Sales Journal and Cash Receipts Journal in Accounts Receivable 

are automatically fed into the general Journal, so they do not need to be re-entered in G/L.   

 

In this case, the general Journal selection is used primarily to enter adjustments and other 

miscellaneous entries. 

 

 

Standard Journal 

The "standard Journal" is the G/L selection used to enter those entries which normally occur 

once in every accounting period.   

 

Your rent is an example of a typical standard Journal entry.  It is an expense which occurs every 

month at a fixed rate. 

 

In G/L, a standard Journal entry which occurs every month can also have a variable amount.  An 

example of this would be your electric bill.  

 

 

All entries which are not automatically fed into G/L from other Samco Packages enter the system 

through either the general Journal selection or the standard Journal selection.  Entries in the 

standard Journal remain on file until you delete them. 

 

NOTE: A Recurring Journal selection is also provided to handle groups of entries which 

may recur at intervals other than each accounting period.  See the Chapter titled 

Recurring Journal.  

 

 

Journal Number 

In G/L and other Samco Packages, references are made to the "Journal number" of a Journal 
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printout, or to the "Report number" of a printed Report. 

 

Every Report that is printed has its own Report number.  You will see this number on the very 

first printed line of the Report. 

 

The very first Report that you print, no matter what it is, will be automatically assigned Report 

number 0001.  The next Report will be assigned number 0002.  Each new Report that you print 

will automatically be assigned the next number in sequence 0003, 0004, 0005, etc. until the 

number 9999 is reached.  After number 9999, the next Report number assigned is again number 

0001. 

 

This numbering system helps you identify your Reports.   

 

 

Journal Codes 

Every Journal that is printed has a Journal number.  The Journal number begins with a two-letter 

designation, or "Journal code".  The Journal code for the General Journal is "GJ".  The Journal 

code for the A/P Check Register in the Accounts Payable Package is "AK". 

 

The Journal Codes are listed in the Chapter titled General Journal. 

 

The Journal number is the two-letter Journal Code, followed by a four-digit Report number.  For 

example, if an entry has a Journal number of GJ0126, this means that the entry can be found on 

the General Journal Register that has Report number 0126.  

 

The Journal number is kept (stored) along with the entry and tells you the exact Journal on which 

the entry was printed. 

 

 

Date Sensitivity 

In Samco G/L, you tell the computer what the starting and ending dates are for your current 

accounting period (the period you are processing), as well as the current reporting period.  

Thereafter, many of the selections in the Package will automatically ignore any entries which fall 

outside your current accounting period. 

 

You can enter General Journal entries dated outside your current period for the purpose of 

adjustment. 

 

 

Trial Balance 

A "trial balance" is a trial run (a test run) made before printing the actual Financial Statements. 

 

The G/L Trial Balance Report shows all the entries for one or more accounts within one or more 

accounting periods.  (You choose which accounts and accounting periods to print).  

 

The Trial Balance Report (and its cousin, the G/L Worksheet Report) are often used by an 

accountant to figure out what adjusting entries need to be made before the final copy of your 

Financial Statements can be printed. 
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Financial Statements 

These are the summarized Reports, produced by the G/L Package, which state how your 

Company did financially over a specified period of time. 

 

Many businesses pay their accountants to prepare Financial Statements every quarter (three 

months).  Virtually all businesses prepare some kind of Financial Statements at least once a year. 

 

The "Income Statement" (also called the "Profit and Loss Statement" or the "P & L") is one of 

the most important Financial Statements.  It typically shows your gross revenues, the direct costs 

of the goods or services you sold to get such revenues, your other operating expenses, and your 

profits. 

 

The "Balance Sheet" is another important Financial Statement.  Simply stated, your balance sheet 

shows your assets and liabilities at a particular point in time, and therefore shows your net worth 

at that time. 

 

With a little help from your accountant, you can tell a lot about the condition of your Company 

from your current Financial Statements. 

 

 

Integrated 

When a set of accounting Packages is "integrated", any information generated in one area which 

is needed in another area is automatically supplied to that other area.   

 

You don't have to enter the information twice. 

 

Samco accounting software is fully integrated.  When G/L is used with other Samco Packages, 

any information recorded in those other Packages which G/L should know about can be 

automatically transferred to G/L. 

 

 

Data Organization 

The information you enter into your computer is stored on your disk.  In order for computer 

programs to be able to locate specific pieces of data (within large masses of data), and to be able 

to process data logically, data must be organized in some predictable way.  Samco accounting 

software organizes your data for you automatically as it stores it on your disk. 

There are five terms you should understand about the way the data is organized: 

 

Character:  A "character" is any letter, number, or other symbol you can type on your computer 

keyboard. 

 

 

Field:  A "field" is one or more characters representing a single piece of data.  For example, an 

account number, a date, and a dollar amount are all fields. 

 

 

Record:  A "record" is a group of one or more related fields.  For example, the fields 

representing the account number, the amount, and the distribution date might be grouped 
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together into a record called the "entry record".  

 

 

Entry:  A record in a data file is often referred to as an "entry". 

 

 

Data file:  A "data file" is a group of one or more related records.  A data file is often referred to 

simply as a "file" (without the word "data"). 

 

The General Journal File in General Ledger is an example of a data file.  Such a file is made up 

of several records, each of which contains the account number, amount etc. for one entry. 

 

Each file is kept separate from other files on the disk. 

 

There are other types of files in addition to data files.  For example, programs are stored on the 

disk as "program files".  However, references to "file" in this User Manual mean "data file" 

unless specifically stated otherwise. 

 

 

Post 

To "post" means to take entries from a temporary file and move them to a permanent file (where 

other entries probably already exist).  For example, in G/L, entries are initially entered into the 

temporary General Journal File.  After entries have been entered and verified as correct, they are 

posted to the more permanent General Ledger File. 

 

Often, during entry posting, information in other data files is also updated.  For example, when 

sales from Accounts Receivable are posted, the account balance and historical sales figures in the 

Customer File are also updated. 

 

 

Alphanumeric 

When the manual refers to "alphanumeric", it means letters of the alphabet, numerals (numbers), 

special symbols (*, &, $, etc.) or any combination of all three kinds.  In contrast, "numeric" (or 

"digits"), means only numbers. 

 

 

Multi-Company 

"Multi-Company" refers to the capability to do accounting functions for multiple companies with 

the same set of software.  A User wanting to do accounting functions for more than one 

Company on Samco Packages can use the System functions > Multiple Companies selection. 

 

 

Company Consolidation 

"Company Consolidation" is the action of summarizing the accounting activity of several 

companies into a whole, as though they were one Company.  For example, the entries from 

companies A, B, and C could be summarized into Company X, and an overall set of Financial 

Statements produced for "Company X" (the Consolidation Company).   
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Product Description:  Samco General Ledger  

The General Ledger system includes those features most asked for by tens of thousands of Users 

whose experiences over the past eleven years with earlier versions of this Package have helped 

refine it to its current mature level. 

 

• Handles up to thirteen accounting periods. 

• Supports a 16-character, 5 section G/L account number 

• Supports multiple profit centres. 

• Supports multiple companies. 

• Produces an overall set of Financial Statements from a consolidation of multiple 

companies. 

• Allows Reports to be stored on disk to save computer time, then printed later at your 

convenience. 

• Allows use of multiple printers.  

• Provides maintenance and a listing of the Chart of Accounts File. 

• Allows general Journal entering, editing, and posting, with edit list and Journal. 

• Allows standard Journal entering, editing, and posting, with edit list and Journal. 

• Recurring general Journal entries allow for automatic distribution by percentage or 

allocation. 

• Prints the G/L Worksheet and Trial Balance Reports. 

• Allows on-line G/L account detail inquiry. 

• Prints the Source Cross Reference (for audit trails). 

• Prints the Financial Statements in flexible formats which you design. 

• Financial Statements can be printed for a set of sub-accounts. 

• "Wild-carding" and account ranges are allowed in Financial Statement layouts. 

• Key accounting ratios can be calculated (such as "Current Ratio").  User-defined 

accounting ratios can also be set up. 

• Allows you to keep entry detail for the year if disk space is available and has a flexible 

year-end closing procedure. 

• Contains a loan amortization program which gives you information about fixed rate 

loans. 

• Includes password protection and data-integrity checks. 

• G/L data can be copied to a new Company for prior year reporting. 

• May be used either independently or interfaced to other Samco Modules 

 

 

Accounting Periods 

Using the Accounting periods selection, you can define a fiscal year containing from one to 

thirteen accounting periods.  You can also define a separate period for use in reporting purposes. 

 

 

G/L Account Number Format 

Companies with multiple sales departments or branches often require separate Profit and Loss 

Statements for each "profit centre". 

 

Samco's General Ledger supports sub-accounts to represent multiple profit Centres.  When you 

set up the format of your account numbers, you are offered the option of selecting one of the 
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sections as a profit centre (this is optional).  Sub-accounts may also be used to categorize 

expenses in different departments, not necessarily profit Centres.  See the explanation under 

"Profit Centres and Sub-Accounts" earlier in this Chapter.  

 

Each account number can be up to 16 alphanumeric characters (User defined) which can further 

be divided up into a maximum of 5 sections (also User defined), with User selectable section 

dividers. This is discussed in detail in later Chapters. 

 

 

Chart of Accounts 

In addition to the G/L account number and account description, the chart of accounts record 

contains various codes which govern the handling of the account throughout the system. 

 

Up to thirteen periods of budgeting and/or prior year comparative information can be stored for 

each account. 

 

You can print the Chart of Accounts List any time you wish. 

 

 

General Journal Entries 

In the general Journal, you can make new entries (enter transactions), change or delete existing 

entries, and post entries to the General Ledger Transaction File. 

 

General Journal entries can be made in such a way that they will be automatically reversed next 

period (for accrual purposes). 

 

As an aid in the editing process, you can print the General Journal Entry Edit List before posting.  

It can be printed in order by account number or in the order the entries were made. 

 

When general Journal entries are posted to the General Ledger Transaction File, the General 

Journal Entry Register is automatically printed. 

 

 

Standard Journal Entries 

A Standard Journal Transaction File may be maintained for Journal entries which recur each 

accounting period. 

 

Each standard Journal entry may be set up with either a fixed amount or with a variable amount 

to be entered each period.  You can then post these entries to the General Ledger Transaction 

File. 

 

The Standard Journal Entry Edit List may be used to assist in maintaining this file.  The Standard 

Journal Entry Register is automatically printed when these entries are posted. 

 

 

Recurring Journal Entries 

This selection is similar to standard Journal entries, but more flexible, since it allows you to set 

up Journal entries which recur weekly, quarterly, etc., instead of just once per accounting period.   
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It also saves you time because if you want to do an allocation to a set of accounts, you can 

distribute by percentage (in the standard Journal, you must distribute one transaction at a time). 

 

You can set a time limit on a recurring entry.  You can also limit recurring entries in terms of the 

number of times used. 

 

 

View Accounts 

The View accounts selection allows all entries for a selected account and within a specified date 

range to be displayed on the computer monitor. 

 

 

Source Cross Reference 

The Source Cross Reference Report shows all entries for any time period, for one or more 

sources and/or one or more Journal numbers.  This Report prints detail (individual) entries in 

order by source or by Journal number, whichever you select. 

 

You can always associate a Journal number with a printed, physical document, and (provided 

you have not compressed the general ledger) you can reconstruct a lost Journal printout by using 

this selection.  To reconstruct, specify all sources and dates for a particular Journal number. 

 

Because you select the ranges of starting and ending source codes, starting and ending Journal 

numbers, and starting and ending dates, this Report is a very powerful tool for identifying 

unusual transactions and their origins. 

 

As in nearly all Samco Reports, you can display this Report on your screen.  This allows you to 

rapidly review large numbers of entries within a selected range to isolate any problems. 

 

 

Financial Statement Formats 

With Samco General Ledger, you can design your own Financial Statements.  Up to 999 

different financial report formats can be defined if disk space allows. 

 

Layout functions allow you to format Financial Statements by entering the relative position of 

titles, headings, accounts, text lines, sub-totals, totals etc.  The User-defined formats are saved on 

disk and can be easily added to, changed, or deleted whenever necessary. 

 

"Wild-carding" and account ranges are allowed in Financial Statement layouts. 

 

A Financial Statement Specifications List and sample Financial Statements (showing statements 

as they will print, but without real dollar amounts) may be printed. 

 

 

Financial Statement Printing 

Samco General Ledger prints the User-formatted Financial Statements on request.  These include 

the Income Statement (Profit and Loss Statement), Balance Sheet, Supporting Schedules, 

Expanded Cash Flow Statement (FASB 95 Cash Flow Statement), and the Source and 

Application of Funds (SAF) Reports:  Statement of Cash Flow, Components of Working Capital, 

and Changes in Financial Position.  
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Financial Statements may be printed at any time, for any accounting period which you define, 

and for a set of sub-accounts (profit Centres) which you define. 

 

Budget and/or comparative figures may be shown on selected Financial Statements along with 

budget or comparative "variances".  A "variance" is the difference between the current amount 

and the budgeted amount (budget variance), or the difference between the current amount and 

last year's amount (comparative variance). User-defined notes, disclaimers, etc., may also be 

printed on any of the Financial Statements. 

 

 

Accounting Ratios 

User-defined accounting ratios can be set up and calculated.  These can be standard ratios or 

customized to meet specific business needs. 

 

 

Year-To-Date Entries 

If your system has sufficient disk storage capacity, all detail entries (transactions) for the year 

may be retained.  When detail is stored for the entire year, the Trial Balance Report may be 

printed showing all such detail. 

 

However, if disk space is not available, detail may be compressed (summarized) on request.  The 

Summarize selection totals and compresses entries, either by date or by accounting period, at the 

User's option. 

 

Date sensitivity is always maintained during a compression, allowing Reports (without detail) 

and Financial Statements to be re-run for prior periods, even after compression. 

 

 

Year End Procedure 

The Close a year selection automatically clears all profit and loss account activity and 

consolidates balance sheet entries into one beginning balance entry for the new-year.  This 

procedure also rolls the year-ending account totals over into the last-year comparative figures. 

 

 

Interface to Other Samco Systems 

Samco's Accounts Receivable, Accounts Payable, Job Cost, Canadian Payroll and Inventory Plus 

systems may be interfaced to the General Ledger, provided each Package interfaced is the same 

version number, running on the same machine (computer). 

 

 

Password Protection 

You have the option to specify that passwords are required.  A password is a unique code you 

assign to each individual using your Samco software.  When passwords are required, each 

potential User must first enter a valid password before he or she will be allowed to use a 

protected selection. 
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Data Integrity Check 

A data integrity check compares the actual numbers in the system to the calculated or projected 

numbers.  If these numbers do not match, you are warned that information might have been lost 

due to a machine or power failure.  By running this function at the start or end of the day, you 

can detect several possible types of data file corruption (sometimes due to hardware or operating 

system errors). 

 

 

File Utilities 

This selection provides the capacity to recover corrupted data files.  You can also use it to 

convert important data files to a format which can be easily interfaced to common data base and 

word processing Packages. 

 

 

Printers 

You can easily select any one of more than two dozen of the most popular printers.  

Additionally, instructions are given to allow you to interface the software to other printers. 

 

 

Archiving G/L Data 

Data from one Company ID can be copied into a new Company ID for transaction entry and 

reporting of prior year data 

 

 

Loan Payment Calculation 

This general-purpose program is useful to accountants and is included for your convenience, 

although it is not an integral part of General Ledger.  The program is described in the Chapter 

titled Calculate Loan Payments. 

You don't need any Chart of Accounts information or Financial Statement Layouts to calculate 

loans, but you are required to have entered the Company File information 

 

 

___________________.
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Chapter 2 - Getting Started 
 

 

We assume at this point that you have installed General Ledger on your computer according to 

the Installation Guide.  If you have not done so, refer to that Manual and install the G/L Package 

before proceeding. 

 

Your Accountant 

We advise you to consult with your accountant before using Samco software.  Your accountant 

should be familiar with your accounting software in order to serve you well and may have good 

advice on converting from your existing G/L system. 

 

 

The General Ledger Data Files 

In order to use this Package, you first need to enter certain information describing your General 

Ledger system and how you want your entries handled. There are several different "data files" 

which you enter before you can begin using the Package on a regular basis.  Here is a brief 

explanation of those files: 

 

 

Company File 

This file contains basic information about your Company and some system wide settings.  If you 

are using multiple companies, there is a Company File for each Company.  In this file, you 

specify information such as your Company's name and address, the use of passwords, whether 

you are U.S. or Canadian, and whether you use profit centres (sub-accounts).   

 

 

G/L Control File 

This file contains a number of parameters which define your general ledger structure.  Each 

parameter defines specific values to be used in other selections.  
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Accounting Period File 

With this file, you define the starting and ending dates of your accounting periods.  Although 

most independent businesses use the 12 calendar months as their 12 accounting periods, you can 

define as few as one or as many as 13 accounting periods here.  You also specify a "reporting 

period" which is used in printing various Reports and statements.  It can be the same or different 

from your "current period".  

 

 

Chart of Accounts File 

This File contains a list of all your G/L accounts.  In addition to account numbers and 

descriptions, you may enter budgets and last year comparative figures into this File.  (The use of 

budgets and comparatives is optional.)  You also use this File to define any sub-accounts you are 

using. 

 

 

 General Journal Transaction File 

Although this File is regularly used on a day-to-day basis after the initial set-up procedure, it is 

also used during these initial steps to make a beginning balance entry for each of your accounts.  

 

 

Recurring and Standard Journal Transaction Files 

These Files contain any entries which recur each accounting period.  (By storing recurring 

entries on the disk, you avoid having to enter them anew each accounting period.)  

 

 

Sub-account Group File 

This File contains sub-account groups.  Each sub-account group is a set of sub-accounts which 

you group together for reporting purposes.  Use of sub-account groups is optional.  You may 

create sub-account groups for any defined "section" of your Chart of Accounts. 

 

 

Layout File 

In this file you custom-design and store the layouts (formats) of your Financial Statements.  

 

 

Text File  

You enter into this File any pieces of text (such as instructions, explanations, footnotes, etc.), that 

are to be printed on your Financial Statements.  

 

 

Statement Specification File 

Use this File to enter additional instructions for printing your Financial Statements.  For 

example, instructions are stored in this File to direct whether to show budgets or comparative 

figures on any or all Financial Statements. 

 

 

Setting-Up General Ledger 

Perform these steps to start using Samco General Ledger:  
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1. Study the Chapter titled General Rules in the System Functions Guide. 

 

2. Start G/L according to the instructions in the Chapter titled Using Samco General Ledger. 

 

3. The Company File will be set up for you as part of the installation procedure.  Use 

Company information to modify the Company File to be appropriate for your Company.  

See the Chapter titled Maintain Company Data in the System Functions Guide.  

 

4. Define your accounting periods using Accounting periods.  (See the Chapter titled 

Accounting Periods.) 

 

5. Enter G/L control information using Control Information.  The information in the G/L 

Control File controls how G/L is used by your Company. 

 

6. Set up your Chart of Accounts.  If you are adding the G/L Package after other Samco 

Packages are in use, you may load accounts from the Valid G/L Accounts file into the 

Chart of Accounts as described in the Chapter titled Set-up Procedures.  If other Samco 

Packages are not already in use (or you do not wish to load the Chart of Accounts from 

the Valid G/L Account File), then enter your Chart of Accounts using Chart of accounts 

as described in the Chapter titled Chart of Accounts. 

 

In setting up your Chart of Accounts, you may choose to enter budgets (for the current 

fiscal year) and comparative account information for the previous fiscal year.  If you do 

not enter this information, then you will not be able to print Financial Statements which 

show budgets and comparatives during the initial fiscal year in which you are using the 

software. 

 

When you close the fiscal year, the software will store account balances from the year 

being closed as the comparatives for the New Year.  Additionally, you can set budgets 

based on these comparatives.  Thus, even if you do not enter budgets and comparatives 

now, you will be able to print Financial Statements in the next fiscal year which show 

budgets and comparatives, since the software will generate this information for you when 

the current fiscal year is closed. 

 

7. Set up beginning balances for your balance sheet accounts using Set beginning balances 

as described in the Chapter titled Set-up Procedures.  In order to use this procedure, you 

must first enter comparatives for each balance sheet account.  If you have chosen to not 

enter comparatives, then this function will not work correctly. 

If you do not use Set Beginning Balances to set up beginning   balances, use General 

Journal to enter the beginning balances.   Enter a debit or credit for each balance sheet 

account (with a reference of "BBF" for "balance brought forward").  These entries should 

be dated on the last day of the previous fiscal year.  These entries correspond to your final 

balance sheet for the previous fiscal year. 

 

8. If you are setting up Samco G/L as of the beginning of your   fiscal year, then no other 

Journal entries need to be made.   However, if you are setting up G/L during the fiscal 

year, then you must make Journal entries to bring Samco G/L up-to-date with your 

manual ledger.  In this case, you would enter a debit or credit for each account for each 

period which you have already completed in the current fiscal year.   
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9. The debit or credit entered would be the net change for that account for that period. For 

example, if your cash account increased by $1,000 as of the end of the first period, you 

would debit cash for $1,000 with an entry dated on the last date of the first period. 

 

For the current period, you would enter a debit or credit for each account which 

summarizes the net change to that account for the current period. 

 

A quicker way to bring Samco G/L up-to-date is to make a single entry which 

summarizes the net change to each account from the beginning of the fiscal year up to the 

current date in the current accounting period.  However, if you do this, then the software 

will not be able to generate budgets and comparatives for all accounting periods when 

you close this fiscal year.  This is because you will not have entered enough information 

for the computer to determine the ending balance for each account for each period that 

has already been completed in the current fiscal year. 

 

10. Set up the standard Journal, using Standard Journal.  This Journal is for debits and 

credits which are made each accounting period and is described in the Chapter titled 

Standard Journal. 

 

11. Set up the recurring Journal, using Recurring Journal Trx.  This Journal is for debits and 

credits which occur periodically (but not necessarily just once each accounting period.)   

This Journal can also be used to set up allocations to accounts on a percentage basis.  See 

the Chapter titled Recurring Journal. 

 

12. Enter text that will be used on Financial Statement layouts using Texts as described in the 

Chapter titled Texts. 

 

13. Enter Financial Statement Layouts for your Profit and Loss Statement, Balance Sheet 

Statement, and supporting schedules for each, as needed.  Financial Statement Layout 

entry is described in the Chapter titled Financial Statement Layouts. 

 

14. If you wish to print Financial Statements for sets of sub-accounts, then enter each set as a 

sub-account group using Sub-account groups, as described in the Chapter titled 

Sub-account Groups. 

 

15. Enter Statement Specifications using Financial Statement Specifications.  These 

specifications are used to control the sequence in which Financial Statements are printed 

and to specify whether budgets, comparatives, or ratios are to be printed on the Financial 

Statements.  Additionally, you may specify whether the Financial Statement is to be 

printed for all sub-accounts, a single sub-account, or for a set of sub-accounts as defined 

by a sub-account group. 

 

16. If you are using multiple companies and need to print consolidated Financial Statements, 

set-up your Consolidation Company as described in Chapter Company Consolidation.  

 

 

NOTE: Additional G/L exercise data is provided with this Package.  Refer to the appendix 

titled Additional G/L Exercise Data for further instructions.  
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Regular Use 

When you have finished building your Data Files as above, you will be ready to use G/L on a 

regular basis.  The remaining Chapters in this Manual show you how to: 

 

• View G/L account activity  

• Print the G/L Trial Balance and worksheet Reports 

• Print the Financial Statements 

• Summarize the G/L File (to make the file smaller) 

• Perform the year end procedures 

• Get distributions from other Samco Packages 

• Consolidate multiple companies for summarized Reports 

• Calculate loan payments  

• Perform a data integrity check 

 

 

Samco Support 
 

The user manuals are designed to allow you to use Samco's Power Accounting application 

software without any additional help. However, if you encounter problems you cannot resolve by 

referring to these manuals, you may want to get additional assistance.  Your supplier should be 

able to provide such assistance, or he may be able to recommend an independent source. 

 

Samco Help Desk 

8661 – 201st Street, 2nd Floor 

Langley, BC  V2Y 0G9 

Canada 

Phone:(604) 597 4211 

E-mail: support@samco.com 

Web: http://www.samco.com 

 

Samco provides support on a fee-for-service basis.  Please ensure that you have the software 

release, serial number(s), media type, payment information (Visa or MasterCard) and other 

related information available when you call. 

 

For a detailed description of Samco's support and Customer services, please check out our web 

site at http://www.samco.com. 

 

You may go to your own dealer for training; however, if your dealer does not offer training, call 

Samco at (800) 663-2080, for information and cost.  

 

 

 

http://www.samco.com/
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Chapter 3 - Starting Up 
 

Starting Samco General Ledger 

Your computer has an operating system (which is the basic software of the computer) such as 

Windows, Linux, or UNIX. If you are uncertain which operating system your computer has, 

contact your supplier. 

 

For Windows: 

 

From a DOS prompt, type CD \SSI (or whatever top-level directory you installed your Samco 

software in).  

 

Then type MENU 

 

For Linux and Unix based systems 

 

Ensure you are logged in as a User authorized to use Samco software.  (See the Installation 

Guide for details.) 

 

Type cd /usr/ssi (or whatever the name of your top-level directory is). 

 

Then type ./MENU 

 

You may be prompted for a Company number (if multi-companies turned on), followed by your 

User initials. You may then select General Ledger from the master Menu which appears.  
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Multiple Companies 

If you have set up your software to process information for more than one Company enter an ID 

code for the Company you wish to use. (See the Multiple Companies Chapter in the System 

Functions Manual for additional information)  

 

 

Your Initials 

You are asked to enter your initials if you do not have passwords turned on.  Initials are required 

for certain types of audit trails.  In addition, the User initials can control which Menu style the 

User prefers. 

 

 

Password 

You may be asked to enter your password.  If so, enter your password. The characters you type 

will be invisible on your computer screen. Remember to press [Enter] after typing your 

password. 

 

 

Multi-level (Numbered) Menus 

The General Ledger Menu then appears: 

 

 
 

 

The selections that you will be using most often (such as General Journal) are on the first screen 

of the main Menu. 

 

To choose one of the selections shown above, type the number of the selection and press 
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[Enter]. For example, to select General Journal trx, type 2. 

 

To get to page 2 of the Menu, press [F2] from page 1. If you are using multiple companies and 

this is a Consolidation Company, an additional selection appears: Company Consolidation. Make 

selections from page 2 the same way as from page 1. 

 

You may also make selections on page 2 from page 1 by typing the selection number. For 

example, to select Accounting Periods while page 1 is displaying, type 13. 

 

To return to page 1 of the Menu, press [F2] or [Tab]. 

 

 

Help 

While using your Samco Power Accounting software, press the [F11] key at any timed for help 

about what you’re currently doing. 

 

 

To Exit the G/L Module 

To exit the G/L module, press [TAB] from page 1 of the G/L Menu or use the “Jump” function 

by pressing [F3] followed by EX for exit. Depending on your computer setup; the Samco Master 

Menu appears, listing modules, or your operating system prompt appears, or your calling Menu 

appears. 

 

 

 

____________________ 
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Chapter 4 - Guide to Daily Operations 
 

 

The following checklists are provided as examples of how you might use General Ledger to 

perform various daily and periodic tasks. 

 

While we attempt to present the tasks in a logical order, you should adjust the checklist as 

necessary to meet your own needs.  You may wish to consult with your accountant for advice on 

organizing your own checklists to ensure the efficiency and security of your business operations. 

 

 

Daily Operations Checklist 
 

EACH DAY      EACH DAY, AS NEEDED 

 

____Enter debits and credits using  

General Journal Trx > Enter.  Print an edit  

list to verify your entries and  

then post these entries to the  

General Ledger Transaction File. 

• ____Enter new G/L accounts using Chart of 

Accounts > Enter. 

 

• ____Inquire into accounts, using View 

general ledger accounts. 

 

• ____Enter new recurring Journal 

transactions using Recurring Journal Trx > 

Enter. 

 

• ____Select recurring Journal transactions for 

use, using Recurring Journal Trx > Select 

for use.  
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• ____Copy selected recurring Journal 

transactions to the General Journal 

Transaction File using Recurring Journal 

Trx > Use selected. 

 

• ____Post the recurring Journal transactions 

using General Journal Trx > Post. 

 

____Mark entries in the General 

Ledger Transaction File as  

"correcting entries" using 

Set correcting entries. 

 

 

 

Periodic/Monthly Operations Checklist 
 

 

EACH PERIOD      EACH PERIOD, AS NEEDED 

 

____If you are using Samco  

A/R, A/P, I/C, P/C, or J/C, then 

follow the procedure described  

in the Chapter titled Get  

Distributions to pull debits and  

credits from these Packages into  

General Ledger. 

 

____Print a Trial Balance Report  

using Trial balance. 

 

• ____Print the Source Cross Reference 

Report (as needed) to print a list of entries in 

the General Journal Transaction File by 

source code or Journal number. 

 

____Print a General Ledger Worksheet.  

Use this worksheet to make 

adjustments for the period. 

 

____If you have set up the Standard  

Journal, edit the transactions in the  

standard Journal as needed.  The  

standard Journal would normally  

contain debits and credits for  

adjustments to be made for the  

accounting period.    
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Print an edit list  

to verify your entries and then post  

the standard Journal to the General  

Ledger Transaction File. 

 

(If you have not set up the Standard  

Journal, use General Journal to enter  

and post your adjustments.) 

 

____ Print another Trial Balance as a  

permanent record of the debits and  

credits for the current period. 

 

____ Print Financial Statements using  

Print Financial Statements. 

 

____ If you are using multiple companies  

and need to consolidate entries, then do  

so, using Consolidate entries.  This function 

is run in the Consolidation Company.  Then  

print consolidated Financial Statements using  

Print Financial Statements in the 

Consolidation Company. 

 

• ____Use Compress G/L transactions (if 

needed) to reduce the size of the General 

Ledger Transaction File.  Be sure to read the 

Chapter titled Compress G/L Transactions 

before running this function, as this function 

compresses information in the General 

Ledger Transaction File.  (You may also 

want to consult with your accountant before 

using this function.) 
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End of Fiscal Year Checklist 
 

 

EACH FISCAL YEAR 

 

____Perform all the periodic/monthly  

actions described above for your  

final accounting period of the fiscal  

year.  If you must start your new  

fiscal year prior to entering your  

final adjustments for the fiscal year  

just ended, then see the Chapter  

titled Close A Year, which describes  

how to start the new fiscal year  

without closing the previous year. 

 

____Once you have entered and posted  

your final adjustments for the fiscal  

year, print your final financial  

statements for the fiscal year. 

 

____Print a detailed trial balance for the  

entire fiscal year, which will serve as  

a permanent record of the fiscal year. 

 

____Follow the procedures described in  

the Chapter titled Close a Year to  

close the fiscal year. 

 

 

 

__________________________
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Chapter 5 - Company Data 
 

 

This selection is used to record information about your Company, such as your Company name, 

address, size / layout of General Ledger Account Numbers, and many other Company specific 

parameters. 

 

For a full explanation, please refer to the System Functions Manual, for the Chapter titled 

Company Data.



General Ledger  Accounting Periods 

Samco Power Accounting     6.27 

 
 

 

 

Chapter 6 - Setting Accounting Periods 
 

 

This selection is used to enter the accounting periods in your fiscal year.  You may define up to 

13 accounting periods.  (Most companies use only 12 periods - one for each month.)   

 

NOTE:  When setting accounting periods, the General Ledge has no periods to close.  You can 

set the Control File to not allow posting into different periods. 

 

To Begin  

Select Set up, Accounting Periods from page 2 of the G/L Menu. 

 

 
 

If you are starting a new year and are not ready to close your previous year out but would like to 

set the Accounting periods.  
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If you are NOT READY to close your General Ledger at Fiscal Year End, you can take the 

following steps so that you can process information for the New Year: 

 

1. Change the accounting periods to reflect the New Year.  (check that the Flag in Control 

Information is set to ‘Y’ to allow posting outside of the current year.)  We recommend 

setting this to Y if you are leaving your prior year open for adjusting entries. 

2. Make entries as usual.  The Trial Balance will include a beginning balance for your P&L 

accounts from last year until you close. 

3. When you are ready to close, change the accounting periods back to last year.  Make sure 

that the last day defined here is the last day of the year you intend to close. 

4. Perform the End of Fiscal Year checklist in the Chapter 4> Titled ‘Guide to Daily 

Operations’. 

 

Do not make a Journal entry for "retained earnings".  The software will do this 

automatically. 

5. Run Print Pre-Closing Report (if needed) followed by Post Closing Entries. (same report) 

 

 

Default Accounting Periods 
 

The first time you run this function, or the first time you run it after initializing the Accounting 

Period File (see appendix), this file is empty. When an empty file is detected, all accounting 

period dates are set based on the calendar year taken from the system date (the day your 

computer shows as today). 

 

This screen shows twelve periods, one for each month, starting with January 1st and ending 

December 31st, with both the current period and the reporting period defaulting to the month in 

the system date. 

 

You can either accept what is displayed or re-enter the periods or change fields by following the 

instructions below. 

 

Once you enter the starting date, you are asked for ending dates until you have finished. If your 

starting date is Day 1 of any month, the end of the month (including leap years) is automatically 

calculated and you may default to the calculated end date. 

 

The next period starting date is automatically calculated as one day later than the previous period 

ending date. 

 

If your starting date is not Day 1 of a month, you must enter the ending date. 

 

In any case, you can override the default and enter whatever ending date is correct for your 

period. 

 

You can enter accounting periods totalling less than or greater than one year, but you will 

receive a warning if you do so. 
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1-13. Start 

Enter the starting date for Period 1. 

 

 

1-13. End 

Enter the ending date for Period 1. Continue to enter ending dates or press [Enter] to use the 

displayed date.  

 

NOTE: The start dates automatically appear. 

 

 

14. Current Period # 

This field is below your accounting periods and is set based on the period you are working 

in.  

 

The software refers to this current period in many places, generally in selections which process 

entries like General Journal, Standard Journal, Get distributions (the interface to other 

modules), and Compress G/L Transactions (the file compression feature). 

 

Enter a number (1-13) corresponding to one of your accounting periods. 

 

NOTE: The Current Accounting Period is one that is from the accounting table  

 

The number must correspond to a defined period. Once you have entered the period number, the 

dates for the period are displayed. 

 

At the end of each fiscal year, when ‘Close a Year’ is run, the accounting period dates will 

be updated automatically.  

 

However, the “Current period #” must be changed manually each time you begin a new 

accounting period. 

 

NOTE: When closing the year end, you will want to make sure that your accounting 

periods reflect the year that you are closing.  

 

15. Reporting Period 

The reporting period is manually entered and usually reflects one of the current periods from the 

accounting periods table that the User has created 

 

In network environments or other multi-User situations, you can continue normal entry 

processing associated with the current period while special reports are prepared for a different 

period (the reporting period). 

 

Selections such as View accounts or Print source cross reference let you specify whatever dates 

you wish. Other functions concerned with producing Reports such as the Trial Balance, the 

General Ledger Worksheet, and all other Financial Statements, use the reporting period. 

 

The reporting period defaults to the current period when the accounting periods are created, but 
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you can change this. The reporting period can be any range of dates and does not have to be the 

same as any other period in the accounting period’s table.  

 

For example, if your year runs from 01/01/99 through 12/31/99, you might want the reporting 

period to cover 12/31/98 through 12/31/99, in order to include Balance Brought Forward (BBF) 

entries. 

 

When done with the reporting period, you can make any changes. If you change period 1, you 

will need to enter new start and end dates for the period. If you change 2-13, you enter the end 

date of the period. If the start date of the next period is not one day later than the newly entered 

end date, the function recalculates the start date and prompts you for a new end date. 

 

NOTE: When the reporting period spans multiple standard account periods, the detailed version 

of the Trial Balance will offer an option to Print prd totals?. When set to Y, each period is 

reported with a separate subtotal.   

 

15. Current Fiscal Year Period 

The reporting period is manually entered and usually reflects one of the current periods from the 

accounting periods table that the User has created 

 

 

 

Changing Accounting Periods 

 

If the accounting periods have been entered previously, the existing periods will be displayed 

after you have selected Accounting periods, and you will be asked if you wish to re-enter 

periods. 

 

If you answer Y to “Do you wish to re-enter periods?” all dates are cleared, allowing you to enter 

all new accounting periods as described earlier. 

 

However, you do not have to re-enter all dates to redefine your periods. If you answer N, you can 

change the ending dates for individual periods. If you change field 1, you can define a new 

starting date, just like re-entering periods. 

 

To use fewer accounting periods, select the first period to delete and press [F1]. The subsequent 

periods will be cleared. 

 

 

 

____________________
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Chapter 7 - Control Information 
 

 

This selection contains basic information about the accounting set-up of your Company.  The 

information contained in the G/L Control File "controls" various functions in the General Ledger 

and other Packages.   

 

To Begin  

Select Setup > G/L Control Data Screen from page 2 of the G/L Menu. Enter the following 

control information. 

 
 

 

1. Allow Correcting Transactions? 

This software includes provisions for creating the Expanded Cash Flow Statement (FASB 95 

Cash Flow Statement).  FASB 95 means the 95th official statement of the Financial Accounting 

Standards Board.  
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In order to handle the requirements for this statement, correcting ledger entries must be labelled 

as such.  A correcting entry is a ledger entry which has been made to correct an earlier ledger 

entry which is in error. 

 

For example, let us assume that the following debit and credit have been entered and posted: 

 

DR Accounts Receivable $100 

CR Sales    $100 

 

After posting, you discover that the amount should have been $50. 

In this case, you would enter and post the following: 

 

DR Sales $50 

CR Accounts Receivable  $50 

 

However, the above two ledger entries must be marked as correcting entries to indicate that they 

are not the result of a business transaction.  If they are not so marked, then your books can give 

the appearance that the volume of business being done (as reflected in the gross debits to your 

A/R account) is larger than that which has actually occurred. 

 

There are two methods by which entries can be labelled as correcting entries: 

 

(1) When entering either a General Journal Transaction, a transaction in another Package 

(A/R, A/P, PR, I/C), an order in O/E, or an Invoice in P/I, you may specify that the 

transaction, Order, or Invoice is a correcting entry.  If you wish to do this, then answer Y 

to "Allow Correcting Transactions ?"  In this case, when correcting entry transactions are 

posted, the debits and credits generated by the transactions will be marked as "correcting 

entries" and will appear as such in the General Ledger Transaction File (which is the file 

within G/L that contains all of the debits and credits for your Company.) 

 

If you answer Y, you may also use the Correcting Entries selection within G/L to mark entries as 

correcting entries, as described below. 

 

(2) After debits and credits have been posted to the General Ledger Transaction File within 

G/L, you may mark individual debits and credits as correcting entries, using the selection 

Correcting Entries.  This selection is discussed in the Chapter titled Correcting Entries.   

 

If you wish to allow correcting entries to be made only through the Correcting entries  

selection, then answer N to "Allow Correcting Transactions ?"  When selected you will not 

be able to specify that individual transactions within G/L or other Samco Packages are able 

to generate correcting entries.  
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NOTE: Debits and credits generated by other Samco Packages must be transferred to G/L using 

the selection Get Distributions before they can be marked as correcting entries using the 

Correcting Entries selection.  See the Chapter titled Get Distributions in this Manual.)  Consult 

with your accountant to determine which of the above methods is most appropriate for your 

business. 

 

 

[?] 2. Retained Earnings Account 

Enter the account number for the retained earnings account or press [F1] to specify that each 

sub-account section has a separate retained earnings account. 

 

When net profit calculations are done in Close a year, the net profit for each sub-account will be 

calculated separately. 

 

When you enter a new account (that has not yet been entered in Chart of Accounts), you see a 

message reminding you to enter this account into the Chart of Accounts. 

 

 

NOTE:  All but one of the account sections can be wild-carded by pressing [F1]. For 

example, if your G/L account number is 5 sections, when entering the retained earnings 

account, you must give at least one of the sections a specific value.  The rest of the sections 

can be wild-carded. 

 

 

Re-displaying Information in the General Journal and Standard Journal 

Your answers in the next four fields determine how default sources, references, and document 

numbers are presented to you for each debit/credit entry in the general Journal, recurring Journal, 

and standard Journal.  They also determine whether transactions are to be tracked by the User 

who enters them. 

 

The first three fields allow you to specify whether to use the source, reference, and/or document 

number from the previous entry when making general Journal, recurring Journal, and standard 

Journal entries. 

 

The fourth field allows you to specify whether or not you track your Journal entries by User.  

This is most effective in multi-User environments, giving individual Users the ability to track 

their own Journal entries, without worrying about other Users on the system. 

 

3. Re-display Jrnl Source? 

Press [Enter] for Y to re-display the source from the previous entry.  Answer N to not have the 

source re-display. 

 

 

4. Re-display Jrnl Reference ? 

Press [Enter] to answer Y to re-display the Journal reference from the previous entry. Answer N 

to not have the Journal reference re-display.  
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5. Re-display Jrnl Document #? 

Press [Enter] to answer N to not re-display the Journal document number from the previous 

entry. Answer Y to have the Journal document number re-display. 

 

 

 6. Track Jrnl Trx by User ID? 

Press [Enter] to answer Y to track Journal transactions by the User ID they were entered under.  

Answer N to not have Journal entries by User ID. 

 

 

NOTE:  If you answer N for any of the above four fields, you will still be able to access the 

previously entered value using the F1 key.   

 

 

7. Allow Posting Outside Period? 

Answer Y to allow transactions entered to be dated outside of the current period as defined in the 

accounting periods.  When you print the General Journal Entry Edit List, the software will notify 

you that “Posting is allowed, but one or more trx are dated outside the current period/year”. 

When you post, the software displays the message “Note: One or more trx were dated outside the 

current period/year”.  

 

Answer N to disallow out-of-period transactions. 

 

 

8. Allow Posting Outside Year? 

Answer Y to allow transactions entered to be dated outside of the current fiscal year as defined in 

the accounting periods.  When you print the General Journal Entry Edit List, the software will 

notify you that “Posting is allowed, but one or more trx are dated outside the current 

period/year”. When you post, the software displays the message “Note: One or more trx were 

dated outside the current period/year”. 

Answer N to disallow out-of-year transactions. 

 

 

NOTE: We recommend setting this to Y if you are leaving your prior year open for 

adjusting entries.  Otherwise it should be set to N to avoid transactions being entered with 

the incorrect year. 

 

 

9. Include Prior Year Trx on Statements for P&L accounts? 

Answer Y if you want the transactions from the prior fiscal year calculated in the YTD for P&L 

statements, and current earnings on balance sheet statements.   

 

Answering N will ignore prior year transactions in P&L statements and accumulate the BSNI for 

transactions outside of the fiscal year in a special retained earnings account. 

 

This is most useful when you have not yet closed your prior year transactions, however, 

you need the ability to Report on this year’s figures.  
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Reduced Paper Format Report 

Answer Y or N. The trial balance, general, and standard Journal registers can be optionally 

printed in a condensed format which reduces the amount of paper used. The Journal registers use 

approximately 33% less space, while a summary trial balance can be reduced to approximately ¼ 

of its original size. 

 

 

Running Balance on Account View 

Answer Y if you wish to allow a running balance of a GL account to be displayed when viewing 

an account. 

 

 

 

____________________
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Chapter 8 - Chart of Accounts 
 

 

This selection is used to enter accounts in the Chart of Accounts File.   

 

Besides entering accounts, you can: 

 

• Print a list of the accounts. 

• Print a Chart of Accounts Change Log (if you chose in Company information to use 

change logs).   

• Enter an unlimited number of notes about each account. 

 

If you have previously set up the Valid G/L Account File for Accounts Receivable, Accounts 

Payable, Payroll, Inventory Control, and/or Job Cost, you can do a partial set-up of the Chart of 

Accounts File by using the procedure described in the Chapter titled Set-up Procedures. 

 

If you do this partial set-up, the Chart of Accounts File will include the account numbers and 

descriptions of all accounts listed in the Valid G/L Account File.  You must enter the remaining 

information for the Chart of Accounts. 

 

 

Chart of Accounts Organization 
 

We recommend that you organize your accounts by main account number.  Here's an example of 

one possible method of numbering accounts:  

 

· Asset Accounts 1000 to 1999 

· Current Assets: usually 1000 to 1499 

Fixes Assets: usually 1500 to 1999  

· Liability Accounts 2000 to 2999 

·  Current Liabilities: usually 2000 to 2499 

· Long Term Liabilities: usually 2500 to 2999  

· Owner's Equity Accounts 3000 to 3999   
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· Revenue Accounts 4000 to 4999  

· Cost of Goods Sold Accounts 5000 to 5999  

· Cost of Goods Subtypes 6000 to 6999 

· Expenses   7000 to 7999  

· Other Revenue 8000 to 8999 

· Other Expenses 9000 to 9999  

 

Keep in mind that the Trial Balance is printed in account number order for different groups of 

accounts (including subtotals). 

 

For the subtotalling feature to be of value, group the accounts so that subtotals will be 

meaningful.  For example, you could group Current Assets and Fixed Assets separately.  Then, 

within Current Assets, you could show Cash, Prepaid Expenses, and Inventory, each with its own 

subtotals.   

 

 

Subtotal Levels 

To plan the position of subtotals, it helps to lay out your entire Chart of Accounts in numerical 

order on a sheet of paper.  The example below is a simplified Chart of Accounts which 

demonstrates how the first three subtotalling levels work.   (Subtotalling is described in detail in 

the Chapter titled Financial Statement Layouts.) 

 

1010-000 CASH, FIRST NATIONAL BANK 

1020-000 CASH, FIRST PROVINCIAL BANK 1 

1040-000 PETTY CASH  2 

1100-000 ACCOUNTS RECEIVABLE 

1200-000 MERCHANDISE INVENTORY 3 

 

The Trial Balance would print as follows: 

 

 

Account Description    Balance 

 
1010-000  CASH, FIRST NATIONAL BANK   10,000.00 

 

1020-000   CASH, FIRST PROVINCIAL BANK  10,000.00 

 Subtotal Level 1:  20,000.00 

 

1040-000  PETTY CASH             100.00 

 Subtotal Level 2:  20,100.00 

 

1100-000  ACCOUNTS RECEIVABLE   25,000.00 

 

1200-000      MERCHANDISE INVENTORY   15,000.00 

Subtotal Level 3:    60,100.00  
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In this example, the subtotal levels are used to show the relationship between various asset 

accounts. The first subtotal level shows total cash in banks, the second shows total cash assets, 

and the third shows total current assets.    

 

The rules for inserting subtotal levels are highly flexible.  The main rules to remember are:   

 

a. Have your accounts numbered in a logical order.   

b. After a subtotal is printed, its stored total and the stored totals of all "lower" subtotals are 

set to zero. In the example above, the first subtotal is set to zero after it is printed.   
 

If Petty Cash had been given a subtotal level of 1 instead of 2, the amount of that subtotal would 

be 100.00, instead of 20,100.00.  (Subtotals do not get added together; only the accounts will 

show a subtotal.)   

 

If subtotals had been used later for level 4 and higher levels, they would include the subtotals for 

level 1, level 2, and level 3. 

 

A subtotal level the same as or less than the last one used does not include the earlier subtotal 

amounts in its subtotal.   

 

 

Defining Sub-Account Numbers 
 

A main account number of all zeros is reserved for defining a sub-account number.  If 

sub-account numbers are not used, entering all zeros for the main account number is not allowed.   

 

For example, account number 0000-200 would be used to define sub-account number 200.  Each 

sub-account number that you use must be defined in this way.    

 

In later selections where entering a sub-account is required, the software will check to see that 

the sub-account entered has been defined in the Chart of Accounts.  This eliminates the 

possibility of doing processing for a non-existent sub-account.   
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Entering Accounts  
 

Select Chart of Accounts >Enter from the G/L Menu. 

 

 
 

New and Existing Accounts 

From this screen you can work with both new and existing accounts. If an account has already 

been entered for the number you specify, that account will appear and be available for changes or 

deletion. 

 

 

[?] 1. Account Number 

Enter the main account number, then enter the sub-account number (if you are using them), OR: 

 

  [F1] -To scan through existing accounts 

                   [F2] -To set the section value to use some or all of the values 

   from the Valid Sections File in System Functions. 

 

 

Entering Accounts with Sub-Accounts 

If you are using sub-accounts, you must enter a separate account for each sub-account which use 

that main account. 

 

For example, if you have your Sales Account numbered 5000, and you have sub-account 

numbers 100 and 200, you must enter accounts 5000-100 and 5000-200. 

 

A quick and easy way of setting up section sub-accounts is to set up the section values in the 

Valid Sections (System Functions) first. Next, when creating a new account through this 
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function, press [F2] at each section which will have multiple sub-accounts – the field(s) will 

display “*” symbols. 

 

NOTE: All but one section can be wild-carded. 

 

Once you have finished entering budgets and comparatives you will be prompted for a starting 

and ending section value for each section you wild-carded with [F2]. The system will then 

automatically create new accounts for you. 

 

For example, if you have your Telephone expense account numbered 6100, and you have sub-

account sections of 100-SALES, 200-SALES, 100-SERVICE AND 200-SERVICE, you could 

set up the valid sections 2 and 3 with 100 and 200 and SALES and SERVICE respectfully. Next, 

when setting up the Telephone expense account, simply enter in 6100 in section 1 and press [F2] 

for sections 2 and 3. The system would automatically set up accounts 6100-100-SALES, 6100-

100-SERVICE, 6100-200-SALES AND 6100-200-SERVICE. 

 

NOTE: There are two other alternative methods to entering sub-accounts into the Chart of 

Accounts. These are described in detail in 4. Create Account Section (later on in this Chapter) 

and in the Set-up Procedures Chapter. 

 

The Set-up procedures selection allows you to copy a sub-account. In that way you can create 

the first sub-account (for each main account), and then copy it to create other sub-accounts. 

While the Create account section function does basically the same thing with a few slight 

variations. 

 

2. Description 

Enter the account description to appear on all reporting. 

 

 

3. T/B Subtotal Level 

This is the Trial Balance (T/B) subtotal level. You can enter a number from 1 to 9, or press 

[Enter] to specify that a subtotal will not be printed under this account. (see the earlier section 

titled “Subtotal Levels”). 

 

 

4. Fin Statement Type 

This is the Financial Statement type, which defines the account as either a balance sheet account 

or a profit and loss (P&L) account. Asset, liability, and equity accounts are balance sheet 

accounts. Revenue and expense accounts are P&L accounts. 

Enter either:  

 

 B -Balance sheet account 

 P -Profit and loss account 

 

The correct identification of the account is VITAL, since other selections depend on this 

information. 
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5. SAF Type 

This is the Source and Application of Funds (SAF) type. The SAF type is required for each 

balance sheet account if you intend to automatically generate the Sources and Application of 

Funds Statements. 

 

This field is skipped for a P&L type account. 

 

For a balance sheet type account, enter a SAF type: 

 

 C -Cash 

 A -Current Asset (except cash) 

 L  -Current Liability 

 N -Non-cash charge against income for non-current accounts  

  (Example: Accumulated Depreciation) 

 F -Funds flow account (such as, equity accounts, non-current assets, non-current 

liabilities) 

 

If you do not require SAF statements, you may skip this field. 

 

If you have any uncertainty about the meaning of these codes, consult your accountant. 

 

NOTE: The Source and Application of Funds Statements include the Statement of Cash Flow, 

the Statement of Changes in Financial Position, and the Analysis of Changes in Working Capital. 

SAF statements supplement the Balance Sheet and P&L Statement by showing all sources from 

which funds were obtained and how these funds were used. 

 

 

6. Parentheses Control Code 

Enter the parentheses control code, which is used to highlight atypical (not typical) account 

balances on Financial Statements by enclosing them in parentheses. 

 

Asset and expense accounts are typically debit balance accounts, so you should parenthesize 

them when they have a credit balance. 

 

Liability, equity and revenue accounts are typically credit balance accounts, so you should 

parenthesize them when they have a debit balance. 

Enter either: 

 D -Parenthesize when debit (liabilities, equities and revenues) 

 C -Parenthesize when credit (assets and expenses) 

 

For certain accounts, you must use a parentheses control code which is the same as the account’s 

typical balance. This occurs when an account’s balance appears in parentheses under normal 

circumstances. For example, contra-asset accounts such as accumulated depreciation appear in 

the assets section of the Balance Sheet, highlighted by parentheses.  

 

See your accountant if you have any questions about this. 
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7. Compression Code 

When you run Compress G/L Transactions, individual entries will be compressed (summarized) 

either, for a single day; for a particular accounting period, or not at all.  (See the definition of 

“Compress” in the Glossary.) The code you enter determines which compression method is to be 

used for this account. 

 

Enter either: 

 

 D -Date (consolidate all entries for a single day) 

 P -Period (consolidate all entries for a single accounting period) 

 N -No compression (retain all entry detail) 

 

 

8. Cash flow type 

This information is needed for the Expanded Cash Flow Statement. According to the standards, 

all changes in cash accounts are to be accounted for in one of three categories. 

 

Enter a category as follows: 

 

 O  -Operations (such as revenue and expense accounts) 

 I  -Investment (such as non-current asset accounts) 

 F  -Financing (such as notes payable account) 

       BLANK -Leave this field blank to show this account is not involved in cash flow 

(for example, an account for depreciation) 

 

 

NOTE: Later, when you are entering a C/L account on an Expanded Cash Flow Statement 

layout, you are given a warning message if you have not defined a “cash flow type” for that 

account. Enter cash flow types here for each account to be used on the layout to avoid this 

error message. 

 

NOTE: If you have any uncertainty about the meaning of these types, consult your 

accountant. 

 

 

9. Update Valid Accounts 

This feature allows the User to indicate whether the account is to be added to the valid accounts 

file for use with the sub-ledger modules eliminating the double entry of account numbers in 

System Functions > Valid Accounts. In addition, a GL account can no longer be deleted if there 

are comparative values. However, the F2 override can be used if there are no general Journal 

transactions on file for that account. 

 

 

10. Control Account 

Certain accounts (bank, A/R, and A/P for example) are usually managed by the sub-ledger and 

should always be in balance. For this reason, you probably don’t want to be able to enter manual 

G/L journal entries that could cause these accounts to go out of balance with the subledger.  
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Valid options include: 

 

 Y Manual general, recurring or standard journal entries cannot be made to this 

 account 

 N The account is not a control account and journal entries are allowed 

 O A warning will be displayed when attempting to manually enter a journal entry to 

 this account. 

 

 
 

Comparatives 
 

The second Chart of Accounts Screen is used to enter or change comparatives. A “comparative” 

is the previous years’ balance for a given account at the end of a particular accounting period: 
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For example, suppose sales for a particular product were $5,000 during each period of the 

previous fiscal year. Further, because P&L accounts are closed out at the end of each fiscal year, 

suppose the beginning balance was zero. 

 

The comparative amounts for this account would appear as follows: 

 

 Prior Year Beginning Balance   0.00 

 Ending Bal Last Year Period 1       5,000.00- 

 Ending Bal Last Year Period 2    10,000.00- 

 Ending Bal Last Year Period 3    15,000.00- 

 Ending Bal Last Year Period 4    20,000.00- 

 

Balance sheet account comparatives are entered in much the same way, although the prior year 

beginning balance would not necessarily be zero. For instance, suppose a cash account that had a 

beginning balance of $15,000 last year and increased by $1,000 during each period of the year. 

The comparative amounts for this account would appear as follows: 

 

 Prior Year Beginning Balance    15,000.00 

 Ending Bal Last Year Period 1    16,000.00  

 Ending Bal Last Year Period 2    17,000.00 

 Ending Bal Last Year Period 3    18,000.00 

 Ending Bal Last Year Period 4    19,000.00 

 

Entering New Comparatives 
 

1. Prior Yr. Begin Bal 

Enter the prior year beginning balance (the balance for this account at the beginning of the prior 

fiscal year). Credit balances must have a minus sign. 
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2.-14. End Bal 1syr prd-1 through prd-13 

Enter the ending balance for each period of last year. Credit balances must have a minus sign. 

 

You cannot enter comparative amounts for periods that are not defined in Accounting periods. 

These periods will be skipped automatically. 

 

Once you enter an amount for the first comparative, OR: 

 

  [F1] -To repeat the comparative amount for the next period 

  [F2] -To duplicate the comparative amount for all remain valid periods 

 

At the end of the fiscal year, when ‘Close a Year’ is run, the account balances (for each period) 

will automatically be transferred to the corresponding comparative periods. 

 

Comparatives are entered only when the system is first set up. 

If you press [Esc] while entering comparatives, the screen is cleared and you are prompted to re-

enter the information starting with field number 1. 

 

Changing Existing Comparatives 

It is not likely that you will want to change the comparative amounts, particularly after the first 

year of operation. For this reason, the message “Change not allowed” will display if you try to 

get access to one of these fields. 

 

It is possible to override the restriction. See the System Functions Guide for information on how 

to do protected changes.  

  

 

Entering Budgets 
 

Ledger Connection 

This feature allows the User to import budgets into the GL Chart of Accounts from a 

spreadsheet. To access this feature, go to GL > Ledger Connection. 

 

In Samco’s General Ledger system, a budget is defined as the targeted or anticipated net change 

to an account during a given period. 

 

-Example, -If sales of a specific product line were targeted for $10,000 for each period of the 

fiscal year, the correct budget information for the account for this product’s sales would be 

$10,000 credit (with a minus sign) for each period’s budget amount as follows: 

 

 Period-1  10,000 –  

 Period-2  10,000 –  

 Period-3  10,000 – 

 Period-4  10,000 – 

  Etc. 
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Similarly, the projected telephone expense for a particular phone line might be set at $5,000 per 

period. The correct budget information to record this expense would be a $5,000 debit (no minus 

sign) for each period for the account. 

 

Budgets can also be used for balance sheet items. If Accounts Receivable is targeted for a $5,000 

decrease (credit) during each period of the fiscal year, the budget amount for each period would 

be a $5,000 credit as follows: 

 

 Period-1  5,000- 

 Period-2  5,000- 

 Period-3 5,000- 

 Period-4 5,000- 

The third screen (for entering budgets) looks like this: 

 

 
 

Bal-fwd. 

The Chart budget shows a balance forward from the previous year. 

 

 

1– 13. Period -1 through Period -13 

You may enter your budget amounts one period at a time, or you may enter one yearly amount 

which the software will divide equally among your budget periods. 

 

Enter either: 

 

1 -To enter individual period budgets 

2 -To enter one yearly budget 
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Budgets will not be updated automatically during Close a year, they must be updated annually. 

 

 

For Individual Period Budgets 

Budgets for periods that are not defined in Accounting periods will automatically be set to zero. 

If you do enter information for invalid periods, this information will be ignored. 

Enter the amount for Period-1, or press [Enter] for zero. Credit amounts must have a minus sign. 

 

For each following period, enter an amount, OR: 

 

  [F1] -To use the previously entered amount 

  [F2] -To use the previously entered amount for all valid periods 

 

For One Yearly Budget 

The amount you enter is automatically divided by the number of valid accounting periods, and 

the individual period budgets. Make Any Changes Required. 

 

For a new account, or for an existing account, you may press [F6] to use notes. If you select to 

use notes, the screen will now look like: 

 

 

 

Using Notes 
 

You can enter an unlimited number of notes about this account. Each note is given a date/time 

stamp so that you can scan through the notes in time sequence later. 

 

To scan through existing notes, use the keys as shown at the bottom of the screen ([PgUp], 

[PgDn], [Home], [Esc], and [F1]). 
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A Menu at the bottom of the “Notes” area shows three selections: 

 

 

Date and Time 

Use this selection to change the date and/or time of a note. 

 

 

Text Entry 

When you select Text Entry, the cursor is positioned for you to enter the first line of the text of 

the note. 

 

This selection uses Samco’s text editing function. You can enter text in much the same way as 

most word-processing programs, using the [Enter] key, arrow keys, [Esc] [Tab] when done, 

etc. When you are finished entering text, press [Tab] and follow the screen instructions. 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

 

File Options 

 

File  -Save what I have just entered/changed, clear the screen, and get ready for 

another note. (Like pressing [Enter] at “Field number to change?” in other 

selections.) 

 

 

Save & Continue -Save what I have just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

 

 

Abandon Changes -Throw away what I have just entered/changed and get ready for a new 

note. (Like pressing [Esc] at “Field number to change?” in other 

selections.) 

 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

for another note. (Similar Delete in other selections.) The software will 

ask you to confirm the deletion with an “OK to delete?” message. 

 

 

When you are through using notes, press [Tab]. 

 

If you press [F2] for any account sections you will be asked for a range of valid section values 

(Starting and Ending). Enter in a starting and ending value or press [F1] at either field for the 

“First” and “Last” respectively. The screen will display the number of accounts created. 
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Changing Existing Budgets 
 

To change the budget for an existing account, press [Enter] at “Field number to change?” on the 

screen showing comparatives. Then answer Y to “Do you wish to change budgets?” 

 

When you change an existing budget, you can either change individual fields as usual, OR: 

 

  [F1] -To adjust budgets 

  [F6] -To view or enter notes about this account 

 

If you press  [F1] -Enter the type of adjustment you want: 

 

1 -To re-enter period budgets 

2 -To enter a yearly budget 

3 -To change the existing budget by a certain percent 

 

 

Re-enter Period Budgets 

Current amounts are shown, and you can skip any amount (that is, leave it unchanged) by 

pressing [Enter]. 

 

This means that if you intend to change a budget to zero, you must type zeros over the current 

values. So, if you only want to change a few fields, use [Enter] to position the cursor to these. 

You will find this faster than updating by field number. 

 

 

Enter Yearly Budget 

Your existing period budgets will be replaced by the amount you enter, divided by the number of 

valid accounting periods. 

 

 

Percent Change 

Enter a percentage by which to change all period budgets. A negative percentage will decrease 

budgets. A positive one will increase them. 

 

If you select “Pct. change” by mistake, press [Enter], which will apply a 0% increase to each 

budget (i.e., no change). 

 

 

Deleting G/L Accounts 

The [F3] key is used to delete a G/L account. A G/L account cannot be deleted if G/L 

transactions are on file in the G/L Transaction File for that account. There are also other checks 

made. If you cannot delete a G/L account for some reason, the software will inform you through 

a message as to why. 
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Printing a Chart of Accounts (Standard) 
 

The Samco General Ledger generates two types of chart of accounts listings; a standard and a 

brief. This section describes the steps necessary to generate a standard list.  

Select Chart of accounts >Print out accounts. From the Report criteria screen displayed, enter 

the following: 

 

 

[?] 1. Starting Account 

[?] 2. Ending Account 

Enter the range of accounts to be included. The account numbers entered do not need to be valid 

account numbers in the file. Follow the screen instructions. 

 

 

3. Show Budgets and Comparatives? 

Answer Y to show budgets and comparatives on the Chart of Accounts List 

 

4. Show Notes? 

Answer Y if you want notes included. 

 

[?] Selection/Group Selection 

The number of times you are prompted in the next set of fields depends on how your G/L 

accounts are structured. For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 

 

From the section prompt: 

  [F1]   -To select “All” values for this account section, or use one of the options 

 

 [F2]  -To select a specific section value. This is most useful when selecting a 

   section which may have multiple accounts with the same section. 

 

 [F3]  - To select a section group. For more information on sub-account  

   groups, see The Chapter titled Sub-Account Groups. 

 

Make any necessary changes, and press [Enter]. 

 

Printing Chart of Accounts (Brief) 
 

Select Chart of accounts >Print brief accounts list. From the Report criteria screen displayed, 

enter the following information: 

 

 

[?] 1. Starting Account 

[?] 2. Ending Account 

Enter the range of accounts to be included. The account numbers entered do not need to be valid 

account numbers in the file. Follow the screen instructions. 
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3. Show Notes? 

Answer Y if you want notes included. 

[?] Section/Group Selection 

The number of times you are prompted in the next set of fields depends on how your G/L 

accounts are structured. For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 

 

 [F1]   To select “All” values for this Account ;OR: 

 [F2]  To select a specific section value. This is most useful when selecting a section 

    which may have multiple accounts with the same section. 

 [F3]  To select a section group. For more information on sub-account groups, see the  

   Chapter titled Sub-Account Groups 

 

Make any necessary changes, and press [Enter]. 

 

Creating Account Sections 
 

This function allows you to automatically add new sub-account sections to your existing Chart of 

Accounts. Doing this will add an account in the Chart of Accounts for each main account. 

 

For example, if accounts 1000-000 and 2000-000 exist, creating account section 100 will create 

accounts 1000-100 and 2000-100 

 

NOTE: This Manual assumes that this option is not to be run at this point, but the 

following explanation is given. 

 

Select Chart of Accounts >Create Account Sections. 
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Section Number  

Enter the section of the G/L account number (from 1 to 5 depending on the structure of your G/L 

account number) that you will be creating new accounts for. 

 

 

NOTE: If this is a validated section you do not have to set up the new section value in the 

Set up valid sections. The Create account sections will do this for you. 

 

Section Value 

Enter in the new section value, OR: 

 

[F1] To use all of the valid values for this section. This is drawn from the Set up  

 valid section functions in System Functions. 

 

For example, if you have five profit centres that you want to set up profit and loss accounts for, 

you could set up all your main accounts through the Enter accounts function, set up the valid 

sections for the five profit centres, and then create “All” the account sections. This would save 

the tedious task of manually entering in individual P & L accounts for each profit centre. 

 

 

Section Name 

Enter in a 30-character name for this new account section. If you selected “All” or entered in an 

existing valid section, this field is skipped. 
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[?] 4. Starting Account Number 

[?] 5. Ending Account Number  

Enter the range of accounts to be included. The account numbers entered need to be valid 

account numbers in the file. Follow the screen instructions. 

 

 

Deleting Account Section 
 

 

Use this function to remove an account section from your Chart of Accounts. 

 

NOTE: Only accounts that DO NOT HAVE transactions within the G/L transaction file can be 

deleted. 

 

 

Select Chart of Accounts >Delete Account Section. On the screen displayed, enter the account 

section number, and the section value to be deleted. All G/L Accounts with this value in the 

selected section will be deleted. The valid section, however, will not be deleted. 

 

Printing a Change Log 

If use of change logs has been specified in Company information, you can print the Chart of 

Accounts Change Log. 

 

Select Chart of Accounts >Print Accounts Change Log. Before the Report is printed, you are 

asked whether the change log should be purged (cleared of information) in addition to being 

printed. If you do purge the change log, you will not be allowed to display it on screen.  

 

Answer Y to purge the change log, or N to only print it. 

 

 

 

____________________



General Ledger  Set-Up Procedures 

Samco Power Accounting     9.54 

 
 

 
 

Chapter 9 - Set-up Procedures 
 

 

Use this selection to do the following:  

 

1. Set fiscal year beginning balances by entering these balances into the General Journal 

File.  

 

2. Set up accounts.  In Samco Power Accounting, there is the Chart of Accounts File which 

exists in the G/L Package.  There is also a file which exists in other Samco Packages (like 

Accounts Payable or Accounts Receivable) called the Valid G/L Account File.  This file 

is shared by those other Packages and should contain all account numbers and 

descriptions from the Chart of Accounts File.   

 

Using this procedure, you can: 

 

a. Create the Valid G/L Account File for another Samco Package (such as Accounts 

Receivable) from the Chart of Accounts File.  

 

b. Load the account number and descriptions from the Valid G/L Account File into the 

Chart of Accounts File. 

 

c. Add a new sub-account to the Chart of Accounts by copying from an existing 

sub-account (if you use sub-accounts). 

 

d. Remove a sub-account from the Chart of Accounts (if you use sub-accounts). 

 

e. Copy a Chart of Accounts from another Company, if you use multiple companies. 

 

(Each Company using G/L must have its own Chart of Accounts.)  
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Set Up Valid G/L Account File  
 

Select Set-up Procedures > Setup Accounts > Set up Valid G/L Accounts from the second page 

of the G/L Menu. 

 

This selection may be used only if you have installed another Samco Package in addition to 

General Ledger.  This sets up the Valid G/L Account File in another Samco Package (A/R, A/P, 

etc.), from the General Ledger Chart of Accounts File. 

 

 

NOTE:  This Manual assumes that this selection is not to be run at this point, but the following 

explanation is given. The Valid G/L Account File is the account file shared by all of the Samco 

Power Accounting Packages. 

 

 

When one or more of A/P, A/R, I/C, J/C, or P/C are used with General Ledger, the Get 

distributions selection in G/L is used to transfer distributions for the accounts found in the Valid 

G/L Account File to the accounts listed in the G/L Chart of Accounts.   

 

 

NOTE:  The account numbers in the Valid G/L Account File and the G/L Chart of Accounts File 

must match exactly, so that the information will be transferred to the correct accounts.    

 

 

Using Set up valid G/L Accounts provides a convenient method of loading the correct accounts 

into the Valid G/L Account File from the Chart of Accounts File.   

 

Since all of the information necessary to create the Valid G/L Account File (account number and 

description) exists in the Chart of Accounts File, the valid G/L Accounts can be fully loaded 

using this procedure. 

 

Select C to create a new Valid G/L Account File or A to add records to the existing Valid G/L 

Account File. 

 

 

 

CAUTION 

Do Not select "C" to create a new valid G/L Account unless you want to initialize the 

existing one, which will completely Erase the Existing Information 
 

 

 

Once selected, processing occurs automatically and, as each account is entered into the Valid 

G/L Account File, a record counter on the screen increases by 1. 

 

NOTE:  The Valid G/L Account File is not one of the General Ledger data files.   
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Set Up Chart of Accounts File 
 

Select Set up chart of accounts from the Set-up Accounts Menu of the Set-up procedures Menu. 

 

This selection can be used only when another Samco Package is being used and already has the 

Valid G/L Account File set up.  It loads the account number and description for each account 

from the Valid G/L Account File into the Chart of Accounts File. Be sure to verify that the 

accounts are also in your System Function verify accounts. 

 

Select C to create a new Chart of Accounts File or A to add records to the existing Chart of 

Accounts File. 

 

CAUTION 

 

Initializing or using ‘C’ to Create will ERASE any existing information 

 

 

If you select "A" to add records, existing accounts in the Chart of Accounts File are not deleted.  

If "C", they are deleted. 

 

 

NOTE:  This Manual assumes that this option is not to be run at this point, but the following 

explanation is given.    

 

 

As processing occurs, and accounts and descriptions are loaded into the Chart of Accounts File, 

set up chart of accounts automatically sets up accounts as follows: 

 

· The Financial Statement type is set to "P" (profit and loss). 

· The parentheses control code is set to "C" (enclose when credit). 

· The Compression Code to "N" (no compression).   

 

Existing accounts retain their original settings (if you are adding records).   

As processing occurs, a record counter on the screen displays each account added.    

 

You may then use Chart of Accounts to make any changes to the accounts that were loaded 

automatically by Set up chart of accounts.  

 

For example, you must manually enter SAF type and (if used) cash flow type, budgets, and 

comparatives.    
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Add a Sub-Account 
 

Select Set-up procedures >Set up accounts > Add a sub-account from the 2nd page of the G/L 

main Menu. 

 

 
 

 

Use this selection to add a new sub-account to your existing Chart of Accounts by copying 

- from an existing sub-account. - 

 

Doing this will add an account in the Chart of Accounts for each main account that already uses 

the existing sub-account. 

 

For example, if accounts 1000-300 and 2000-300 exist, copying sub-account 300 to new sub-

account 400 will create accounts 1000-400 and 2000-400 and also 000-400 (a special account 

used to set up the sub-account). 

 

 

NOTE: This Manual assumes that this option is not to be run at this point, but the following 

explanation is given. 

 

 

[?] 1. Sub-Account to Copy From 

Enter an existing sub-account to copy from. 

 

 

2. Sub-Account to Copy To  

Enter the new sub-account you are adding. 

 

 

3. Description 

Enter a description to identify the new sub-account.  
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4. Copy Budget Amounts? 

Answer Y to copy the budget amounts from the existing sub-account into the new one. 

 

 

Removing a Sub-Account 

Use this selection to remove a sub-account from your existing Chart of Accounts. 

 

Select Set-up procedures> Set up accounts > Remove a sub-account from the 2nd page of the G/L 

main Menu. 

 

Enter the number of the sub-account to remove. 

 

 

Copying a Chart of Accounts 
 

This selection displays only if you use multiple companies. 

 

Use this selection to create a Chart of Accounts File for the current Company (the one with 

which you are working) by copying the file already set up for another Company. 

 

Select Set-up procedures >Set-up accounts >Copy Chart of accounts from the 2nd page of the 

G/L main Menu. 

 

 
  



General Ledger  Set-Up Procedures 

Samco Power Accounting     9.59 

If the Chart of Accounts File of the current Company already contains some accounts, you see a 

message informing you of this and asking if you are sure you want to continue. If you do, 

accounts already on file in the current Company will not be changed by the accounts copied from 

the other Company. 

 

Budgets and comparatives for copied accounts are automatically se to zero for the current 

Company. 

 

 

[?] Company to Copy From: 

Enter the Company-ID of the Company to copy from (the “other Company, above). Follow the 

screen instructions. 

 

 

5. Main Acct 

Enter the main account of the Company to copy from. 

 

 

6. Profit Ctr 

Enter the profit centre of the Company to copy from. 

 

 

Set Beginning Balances 

Select Set-up procedures >Set fiscal year beginning bal. from the 2nd page of the G/L main 

Menu. 

 

Use this selection to set beginning balances for the balance sheet accounts. 

 

When you enter comparative amounts (in Chart of Accounts) and then run this selection, a 

General Journal entry is created for each balance sheet account in the amount of the final 

period’s comparative figure. 

 

This selection is run only once, when you first set up the General Ledger Package. Running it 

more than once will generate duplicate beginning balance entries in error. 

 

 

NOTE: To use this selection, it is vital that the final period comparative amounts be correct, and 

that you enter all accounts in the Chart of Accounts. 

 

 

Do not use this selection under these conditions: 

 

• If you don’t want to use the comparative amounts in the Chart of Accounts, or 

• If you don’t need opening balances automatically set for the current fiscal year.  
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NOTE: You can set balances manually by making one entry for each account balance in 

General Journal, with a reference of “BBF” (balance brought forward). 

 

 

Each entry generated by Set fiscal year beginning balances is dated the last day of the previous 

fiscal year. (This date is calculated from the start date of the first period in the Accounting Period 

File). 

 

In order for the selection to be run, the General Journal File must be empty. 

 

You will be asked if you are sure you want to do this, and then the program will run 

automatically. 

 

If the program encounters an unusual number of large comparative balances, all with the same 

sign, you will see a message and must enter the beginning balances manually. This is unlikely, 

but if it occurs, the entries already created in the general Journal are erased, and you will need to 

enter BBF (Balance Brought Forward) entries for each account through General Journal. 

 

 

After Processing  

When processing is complete, print the edit list in General Journal to verify that the entries 

created are correct, before you post them to the General Ledger File.  

 

You can make any changes desired through General Journal. 

 

If a change to the entry amount is necessary, you should correct the comparative amount in the 

Chart of Accounts File as well. 

 

 

Transferring Net Profit (Loss) 
 

Since entries are created for balance sheet accounts only, you will need to create one additional 

entry to transfer last year’s net profit (or loss) to the retained earnings account (or to the equity 

account). 

To do this, select the Enter option of the General Journal Menu, and make an entry dated with 

the last day of the previous fiscal year, for the amount of last year’s net profit (loss). The General 

Journal Chapter tell you how to do this. 

 

If all other entries are correct, this entry will bring the General Ledger into balance (debits equal 

credits). 

 

 

 

____________________
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Chapter 10 - Sub-account Groups 
 

 

A "sub-account group" is a set of sub-accounts which you group together for reporting purposes. 

If you are using a single section G/L account number, or are not validating your sub-account 

sections, skip this Chapter. 

 

When you print a Trial Balance, G/L Worksheet, or Financial Statement, you will be able to 

restrict these Reports to only those sub-accounts contained in a specific sub-account group. 

 

For example, suppose you are using eight sub-accounts to represent eight branches of your 

business as profit centres:  100, 200, 300, 400, 500, 600, 700, 800.   

 

If you want a Financial Statement showing figures for only profit centres 100, 300, 500, and 700, 

you could set up a sub-account group here including just these four sub-accounts.   

 

You could also set up another group including 200, 400, 600, and 800 to show only these 

sub-accounts.  

 

In this way, you can have statements including only those sub-accounts which you want to see. 

 

To Begin 

Select Set up > Sub-account groups > Enter from the second page of the G/L Menu. A screen 

appears for you to enter a sub-account group number and a name for it.  
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[?] 1. Group-# 

Enter a sub-account group number, OR: 

 

 [F1] -To scan through the sub-account groups on file 

 

 

2. Name 

Enter a name for this sub-account group. 

A window then opens to allow you to enter the sub-accounts which are to be included in the 

group: 
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3. Sub-Accounts 

You may enter up to 32 sub-accounts to be included in this group. 

 

Each sub-account must be in the Chart of Accounts File. 

 

Enter a sub-account, OR: 

 

 [F1]    -To scan through the sub-accounts on file 

 

 [Enter]  -To complete entering a sub-account, the cursor moves to the next location 

to enter the next one. 

 

 [F3]       -To delete a highlighted sub-account. 

 

 [Tab]   -To Exit 

 

 

 

Printing a List of Sub-Account Groups 
 

Select Set up > Sub-account groups > Print. The printer selection window appears for you to 

choose which printer to send the document to. 

 

 

 

 

____________________ 



General Ledger                            General Journal 

Samco Power Accounting 11A.64 

 
 

 
 

Chapter 11 - General Journal  

 
 

IMPORTANT NOTE: If you have the Job Cost module, go to Chapter titled General 

Journal (with Job Cost).   

 

This selection is used to handle general Journal entries. Once general Journal entries have been 

entered and verified as correct (with the help of the edit list), you can post them to the General 

Ledger Transaction File, the permanent G/L file. 

 

Select General Journal Trx > Enter from the G/L Menu. 

 

 
 

The dates displayed in the upper right-hand corner show your current accounting period. 

 

Note that an “Entry count” and “Running balance” are kept as you make general Journal entries. 

When the running balance is zero, all entries which have been made are in balance (debits equal 

credits). You can still exit if the “Running balance” is not zero.  
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New and Existing Entries 
 

You can work with both new and existing entries at this screen. If you an entry has already been 

made for the information you specify, that entry will appear and be available for changes or 

deletion. 

 

 

[?] *1. Account # 

For a New Entry 

Enter the number of the G/L account to which this entry will be posted. 

 

 

For an Existing Entry 

You can change or delete existing entries that are not yet posted to the General Ledger. Entries 

that have already been posted are not accessible through this selection. 

 

Enter an account number, OR:  

 

  [F1]  -To scan through entries in order by account number 

  [F2]  -To scan through the G/L accounts on file 

  [F3]  -To scan through entries in order by the sequence of entry 

 [F5] -Display a list of transactions sorted by account number from 

   which you can choose a transaction to edit  

 [Tab]   -To return to the entry screen. 

 [F6]  -To bring up the last G/L account a transaction was entered for. 

 [Enter] -Leave the field blank to look up the G/L account by description 

 

To find a specific entry, enter the account number and entry date. Then press [F1] at the 

“Amount” field to scan through the entries which match the account number and entry date. 

 

 

*2. Date 

This is the date that will be used for distribution to the General Ledger Transaction File. 

 

You may enter a date outside the current period, but you will receive a warning message and a 

warning will print on the General Journal Entry Edit List and General Journal Entry Register. 

Enter the date,   OR: 

 

  [Enter] -To use the system (today’s) date for the first entry 

  [F1]  -To use the date of the previous entry (if any) 

 

 

3. Amount 

The cursor is initially positioned for entering a debit or a credit, depending on the parentheses 

control you defined for this account (in Chart of Accounts). In this case, a credit is the expected 

entry type.  
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You may either enter the amount, or press [Enter] to move to the opposite column and then enter 

the amount there. 

 

If you enter zeros for both debit and credit amounts, you are asked if this is OK. If you answer Y, 

you may proceed with this entry. 

 

Enter an amount,   OR: 

 

  [F1]  -To scan through the entries which match the account number and 

     entry date 

 [F2] -To enter an amount to off-set (counter-balance) the running      

balance (if non-zero) 

 

For example, if the running balance is a debit of $700.00 and [F2] is pressed, a credit of $700.00 

will be entered as the amount. 

 

 

4. Source 

The source is a code used to sort entries when the Source Cross Reference Report is prepared 

(see the Source Cross Reference Chapter). 

 

Enter a source OR: 

 

  [Enter] -To accept the previous source entered (if you chose in                          

    Control information to re-display sources) 

   

  [F1]  -To use the previous source entered (if you chose in 

      Control Information not to re-display sources) 

 

NOTE: A source code is automatically assigned if G/L is interfaced with one or more 

Samco Packages and Get distributions is run to transfer entries into the General Journal 

Transaction File. 

 

 

Accrual Reversal 
 

If the SOURCE is ‘ACCRUE’, accrual reversal is allowed (see the explanation below). 

 

ACCRUE is used to record and adjust expenses, liabilities, revenues, etc., that must be partially 

accounted for during the current period but cannot be fully accounted for until the next 

accounting period. 

 

If you enter ACCRUE as source here and then answer Y to “Reverse next period?” (Field 6), a 

reversing entry dated with the starting date of the next period, but opposite in sign, will be 

automatically created when this entry is posted. 
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This lets you enter an accrual entry which is automatically reversed as of the beginning of 

the next accounting period.  

Double check the Edit List to make sure that this is what you want PRIOR to posting.  

 

For example, if a weekly pay period crossed over between monthly accounting periods, you 

could make entries for the part of the week’s payroll that is to accrue to the current period, and 

the software will automatically create reversing entries at the start of the new period. (Then in 

the next period, you would make entries for the full week’s payroll when the payroll week was 

over.) 

 

NOTE: If ACCRUE is entered as the source, you must also make the counter-balancing entry 

with ACCRUE as the source, so that the accounts remain in balance in this accounting period. 

(debit & credit required) 

 

 

5. Reference 

Enter a reference or description for the entry, or press [F1] to use the previous reference entered 

(if you chose in Control information not to re-display references). 

 

 

Doc # 

The document number is an additional reference. Entering a document number is optional. Enter 

a document number, OR: 

 

  [Enter] -To accept the previous document number entered (if you                              

     chose in Control information to re-display document numbers)                                

     

  [F1]  -To use the previous document number entered (if you chose in   

   Control information not to re-display document numbers) 

 

NOTE: When entries originating in other Samco Packages are interfaced to G/L, a document 

number is automatically assigned. For example, a sales entry from Accounts Receivable has the 

Invoice number as the document number. 

 

 

Duplicate Entries 

NOTE: When making a new Journal entry, if an entry already exists for the same account 

number, date, debit or credit amount, source and reference, you will be given a warning to this 

effect. You are not prohibited from making this new entry, but you should verify that entering 

this duplicate is correct. 

 

 

6. Reverse Next Period 

If ACCRUE was entered in field 4 (“Source”), you can allow automatic reversal of an accrual 

entry upon posting. 

 

If ACCRUE was not entered, the message “(Not Allowed)” is displayed and this field is skipped.  
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If you select to reverse the entry in the next period, the “Running balance” will be the same as it 

was before the entry. This is because the accrual reversal also reverses the entry you made. 

However, you are still required to make the counter-balancing entry in order for entries to 

balance within the period. 

 

 

7. Correcting Entry? 

If this entry corrects some other previous entry that was incorrect, you can mark this as a 

correcting entry. This information is used in preparing the Expanded Cash Flow Statement (in 

Financial Statement layouts). 

 

Answer Y to mark this as a correcting entry. 

 

This question displays only if the G/L Control File specifies that correcting transactions are 

allowed. (See the Control Information Chapter.) 

 

 

Entering Notes 
 

Press [F6] to enter notes about this entry (or view or change existing notes). The following 

screen appears: 

 

 
 

 

 

Using Notes 

The purpose of notes for Journal entry is to allow you to annotate the entry with descriptive 

information. It is an assist to the audit trail so that the full and exact purpose of a particular debit 

or credit can be understood when someone reviews the Register at a later time. 

 

The notes will always appear on the General Journal Entry Register and you may choose to have 

them appear on the Edit List as well.  
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The notes are not saved after posting. 

 

This section uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

File -Save what I have just entered/changed, clear the screen, and get                     

 ready for another note. (Like pressing [Enter] at “Field number to                     

 change?” in other selections.) 

 

Save & continue -Saves what has just been entered/changed but leave the information                     

 on the screen to continue to work with it. 

 

Abandon changes -Throw away what I have just entered/changed and get ready for a                     

 new note. (Like pressing [Esc] a ‘Field number to change?” in                         

 other selections.) 

 

Delete -Delete this entire note from the data file and clear the screen to                      

 get ready for another note. (Like Delete in other selections.) The                      

 software will ask you to confirm the deletion with an “OK to                           

 delete? (message). 

 

[Esc] -To exit notes 

 

 

 

Printing an Edit list 
 

This selection prints the General Journal Entry Edit List. 

 

Select Edit list from the General Journal Menu. 

 

If you selected to track Journal transactions by User, you are prompted to Print Trx entered by 

all Users? Answering Y will print all transactions for all Users, while answering N will print 

only those transactions which you entered. 

 

You have the option of printing out the entries either in account number order (A) or in the order 

they were entered (E). 

 

You also have the option to print notes for the entries. 

 

If in GL Control information you have the following set to yes; 

 Allow posting outside Period ? Y 

 Allow posting outside Year ? Y 
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When you print the General Journal Entry Edit List, the software will notify you that “Posting is 

allowed, but one or more Trx are dated outside the current period/year”. When you post, the 

software displays the message:   “One or more Trx were dated outside the current period/year”. 

 

 

NOTE: If set to ‘N’ (no) then you will get a message displaying you cannot post 

 

 

This Report is available to be printed to the “X” Export printer.  For full details on setting this up 

please review appendix D for full instructions. 

 

 

Posting General Journal Entries 
 

Select Post from the General Journal Menu. 

 

If you selected to track Journal transactions by User, you are prompted to Print Trx entered by 

all Users?. Answering Y will print all transactions for all Users, while answering N will print 

only those transactions which you entered. 

 

You have the option of printing out the entries either in account number order (A) or in the order 

they were entered (E). 

 

This selection will post general Journal entries to the General Ledger Transaction File and will 

print the General Journal Entry Register. The General Journal Entry Register shows every entry 

that is to be posted, exactly as it will appear in the General Ledger Transaction File. 

 

The Report number and Journal name are used to form a unique “Journal number”. Later, when 

you wish to refer to a General Journal Entry Register, you can do so by using “GJ” (General 

Journal) plus this Report number. For example, General Journal Entry Register number 0005 

could be referred to as GJ0005. 

 

While the register is being printed, the entries are checked to see if there are any invalid accounts 

or if any periods are out of balance. If invalid accounts are referenced, you will not be allowed to 

post. To continue, either delete the entries with invalid accounts and then re-enter them with 

valid accounts or enter the accounts into the Chart of Accounts. 

 

If any periods are out of balance (total of debits does not equal total of credits), you are also not 

allowed to post. To continue, make another entry to bring the periods into balance. 

 

If in GL Control information you have the following set to [Y] yes; 

 

 Allow posting outside period ? Y 

 Allow posting outside year ? Y 

 

 

When you post the General Journal Entry, the software will notify you that “Posting is allowed, 

but one or more Trx are dated outside the current period/year”.   
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When you post, the software displays the message “Note: One or more Trx were dated outside 

the current period/year”. 

 

 

When there is a posting error 

 

--Review the Edit List 

--Take note of the message at the bottom of the report  

--Make sure that all the entries are correct and balanced. 

--Post 

 

Usually if the system does not allow positing it is an Entry Error not a Software Issue. 

 

NOTE:  

- Assuming no invalid accounts and no periods are out of balance, the software posts the 

general Journal entries to the General Ledger Transaction File.  

-  

- The system will advise the User if there are invalid accounts referenced in a general 

Journal entry before printing the Report.  

-  

- It will also display a ‘unable to post’ message if you are trying to post outside of current 

year or period – IF you have set the control information to ‘N’ (NO)  

-  

This function sets the “Running balance” and “Entry count” to zero and clears the General 

Journal Transaction File so that new entries can be made. 

 

NOTE: You can display the entries from any Journal by running Source cross reference in 

Journal order, using the Journal number as both the starting and ending Journal number. 

 

 

Importing Transactions / Importing from CSV 
 

The Import transaction function allows you to use the G/L transactions created by another 

system, thus eliminating the need to rekey transactions. 

 

Found in GL > General Journal Trx > Import 

 

The imported transactions may be created on any system but must be in ASCII text file format 

with a variable record length of 114 characters. For records under 114 characters in length, 

padding with spaces is allowed but not necessary. The files must be accessible from a common 

area that Samco can access, such as your home folder or under ssi doc to be able to import.  
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Signed numeric must have the sign separate and leading. For example, that transaction amount 

has a length of 15 characters with a maximum value of + or – 999,999,999,999.99. A value of 

12,345,678.90 would appear ‘+1234567890’ or ‘1234567890’. The sign is assumed positive if 

blank. A value of negative $100.00 would appear ‘-00000000010000’. 

 

The import transactions must have the following format: 

 

aaaaaaaaaaaaaaaa  = 16-character valid GL account number 

 

YYMMDD = Transaction date in year, month, day numeric format 

 

-99999999999999  = Transaction amount with a maximum value of  

   + or – 999,999,999,999.99 (the sign must be leading) 

 

SOURCE  = 10-character source description (converts to upper case) 

 

REFERENCE  = 25-character reference description 

F  = Accrual reversal flag, for transactions where                                           

   SOURCE=ACCRUE, defaults to “N” if blank. A                                           

   “Y” creates a reversing sentry the following                                           

   month. 

DOC #  = 15-character document number  

 

JOURNAL #  = 6-digit number identifying the Journal to                                               

   which this transaction was posted to  

   (Do not enter anything into this field as it is filled at 

   time of posting) 

 

JOB #  = 7-digit job number, which must correspond to 

   either an Active or Closed job (IF using Job Cost Module) 

 

SUB JOB #  = 3-digit valid sub job number 

 

CHANGE ORDER #  =3-digit valid change Order number 

 

CATEGORY #  = 7-digit cost category 

 

The program edits the transactions during import to verify the file format. 

 

NOTE: If the system from which the file is being transported has a G/L distribution Report, it 

should be printed prior to beginning the import procedure. 
 

 

Once the import file is ready, select GL > General Journal Trx > Import to access the file   
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On the screen displayed, answer N to accept the default file name. Enter in the file name 

you require 

 

If the import file exists and has the correct format, then the editing process will begin and a 

message will display, monitoring the number of transactions which have been processed. 

If the import file cannot be found, the message “IMPORT FILE NOT FOUND PRESS ENTER 

TO CONTINUE” will be displayed. 

 

If the import file has an incorrect format, the message “IMPORT FILE HAS INCORRECT 

FORMAT PRESS ENTER TO CONTINUE” will be displayed. 

 

If the system detects un-posted transactions in the General Journal Trx file, a message will 

appear stating that all transactions must first be posted before proceeding. 

 

If there were any errors or warnings in the import file, a window will appear asking you for a 

printer destination for the G/L Transaction Import Error Report.  

 

Some cases where an Error Report will be produced are: 

• An invalid G/L account number has been entered 

• The transaction date is out of the current period 

• The entries are out of balance 

• Record format or field positioning is incorrect 

• The accrual reversal flag is not entered a Y, N or blank 

 

 

NOTE: Errors can be viewed on the second screen of the GL (F 2) ‘Reports to Disk’. It is also a 

good practise to view the Edit List PRIOR to Posting.    

 

 

If an error occurs during the import process, the procedure aborts and no transactions are 

imported. The entry of an incorrect date which falls outside of the current period is not 

considered an error and does not cause the import to fail. 

 

Errors on the first transaction will prompt you to abort or continue. If you wish to edit the 

remainder of the transactions, press [Enter] and the procedure will continue to edit the 

remaining transactions for errors, otherwise press [Tab] and you will return to the Process 

General Journal Transactions Menu. 

 

 

Once the import has been successfully completed, print a transaction edit list to ensure that the 

imported information is correct before posting. To print an edit list showing only the import 

transactions, restart the Samco accounting system and login with the initials IMP. Any changes 

made should also be made to the system the transactions originated from. 

 

 

GL Module > General Journal> Select to Import from CSV 

 

Be sure when selecting the csv file that you use the .csv   
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General Journal Import Transactions. This feature imports General Journal Transaction records.  

It is used to import data from other software. This import uses a csv file that can be developed 

from an Excel spreadsheet.  

 

 

 
 

 
_________________  
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One-Sided Entries 
 

When needing to correct your GL with a one-sided entry:  

 

Normally, you would restore your most recent backup in this situation. See the appendix titled 

Backing Up Your Data Files in the Installation Guide.  

 

If no backup is available you will need to make a “one-sided entry” in order to balance the G/L 

Transaction File. A ‘one-sided entry” is one in which you are entering, for example, a debit with 

no balancing credit. 

 

• Define a temporary G/L Account which is numbered higher than any other G/L 

account you are using currently in your Chart of Accounts. For purposes of this 

example, we will number this account 9999-901.  

• Enter this Account into your Chart of Accounts as a P&L Account. 

• Enter the one-sided entry, using General Journal, to an actual G/L account, not the 

temporary account mentioned above. (Entry would be dated in the period that is 

out of balance in the G/L Transaction File.) This will balance the entry from for 

the same amount to the temporary account (i.e. 9999-901) on the same date. (a 

debit to offset a credit, or vice versa)  

 

-Using File Utilities on second page (F2) of the G/L Menu; select ‘Export’ Select 

the G/L Transaction File to create a new export (ASCII text) file. 

  

Steps:  

 

1. Use F1 for ‘None for the device’ and ‘Unlimited for the size.’  

2. Hit > Enter at the ‘any change question’.  

3. On next screen use> F1 for First in > “Starting file key”, and a value of “9999900” (the 

nine spaces are required) as the “Ending file key”. (The “Ending file key” is account 

number 9999-900, which is the account just before the ‘Temporary account 9999-901’.) 

4. -Hit >Enter at field number to change.  A message will come up > Create or Add  

5. Use ‘C’ to Create (message will say, conversion complete) -Tab Out. --Choose printer, 

example; Garbage Can (Trx file is not needed) -The file utility will export all entries into 

the G/L Transaction File for all accounts up to but not including 9000-901. 

 

NOTE: The account must be entered based on valid account number structure. This process will 

only work if your main account number is the first section of the G/L account number structure. 

For further clarification, refer to the System Functions Guide on use of account number sections. 

 

Using File Utilities again; select > ‘Restore from an Export File’ Preform the same steps to 

create (restore) a new G/L Transaction File. This new G/L Transaction File will contain all debits 

and credits from the original file except for the credit to account 9999-901. Once posted your 

G/L Transaction File will now be in balance. 

 

 

____________________
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Chapter 11 - G/L with Job Cost Module 
 

 

This Chapter is for Users that have bought: The Additional Module/Package:  JOB COST.   

 

 If you have not purchased or have the Job Cost Package/Module, then you can disregard 

this Chapter   

 

 

Introduction 

This selection is used to handle general Journal entries.  Once general Journal entries have been 

entered and verified as correct (with the help of the edit list), you can post them to the General 

Ledger Transaction File.   

 

To Begin 

Select General Journal Trx from the General Ledger Menu, then select Enter. 
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Making General Journal Entries 
 

 
 

 

The dates displayed in the upper right-hand corner are your current accounting period.  

 

Note that an "ENTRY COUNT" and "RUNNING BALANCE" are kept as you enter general 

Journal entries.  When the running balance is zero, all entries which have been entered are in 

balance (debits equal credits). You can still exit if the "RUNNING BALANCE" is not zero. 

 

 

New and Existing Entries 

You can work with both new and existing entries at this screen. If an entry has already been 

made for the information you specify, that entry will appear and be available for changes or 

deletion. 

 

 

[?]* 1. Job #  

 

For a New Entry 

This is the number of the job for this entry. If this is not an entry for a job, press [Enter] and the 

cursor will move to field 5 below. Otherwise, enter a job number, OR: 

 [F2]  -To scan through the jobs on file  

 

The job must exist in the Job Cost system and can be an active or closed job (job status = A or 

C).  The job description will be displayed automatically.    

 

There are two types of entries for a job:  a cost or a profit recognized entry.  

 

-For a cost, you must enter fields 1, 2, 3, and 4. 

-For profit recognized entry, enter fields 1 and 2 for a job that has sub-jobs and bills for the 

sub-jobs (or only field 1 if the job doesn't bill for sub-jobs). Fields 3 and 4 are not entered for this 

type of entry.  
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For an Existing Entry 

Enter all the key fields: "JOB #", "SUB-JOB #", "Change #", "CATEGORY #", "ACCOUNT #", 

and "DATE",  OR: 

 [F1]  -To scan through the entries on file by account number 

 

[F3] -To scan through the entries on file in order by the sequence in which they 

were entered  

 

You can change any field except the key fields that have an asterisk (*) next to them.  (Also, you 

cannot change the source if it is PFTREC.)  If you want to change any of these key fields, it will 

be necessary to delete the entry, then re-enter it. 

 

 

* 2. Sub-job # 

Enter the number of the sub-job for this entry. If the job entered above does not have sub-jobs, 

this field will be skipped automatically. The sub-job number entered must exist for the job.   

 

 

* 3. Change # 

Enter the change Order number for this entry. If you do not use change Orders at all in your Job 

Cost system, this field is skipped automatically. If this entry is not for a change Order, leave the 

field blank to skip it.  

 

 

[?] * 4. Category # 

Enter the number of the cost category for this entry.  If this is a profit recognized entry, leave this 

field blank to skip it. 

 

The category number, along with the sub-job and change Order numbers entered above, must 

correspond to a cost item for the job.  This cost item must be a direct cost for the job. 

 

 

[?]* 5. G/L Acct #  

Enter the number of the account where this entry will be posted, OR: 

 

 [F1]  -To scan through the accounts on file 

 

 [F2]     - If this is a cost for a job, this uses the cost account, for the cost of 

   item. Otherwise, it uses the previous account number entered.   

 

 [F3] - To scan through entries in order of the sequence entered. 

 

 [F5]  - To display a list of transactions sorted by account number 

    

 [Tab]    -To return to the entry screen. 

 

 [F6]  - To bring up the last G/L account transaction entered  

 

 [Enter] - Leave the field blank to look up by name  



General Ledger                            General Journal 

Samco Power Accounting 11B.79 

* 6. Date 

Enter the date that will be used for distribution to the General Ledger Transaction File.  You can 

enter a date outside the current period, but you will receive a warning message and a warning 

will print on the General Journal Entry Edit List and General Journal Entry Register.  Enter a 

date,   OR: 

     [Enter]  -For current date for the first entry. For later entries, it is the date of the 

previous entry. 

 

 

7. Amount 

The cursor is initially positioned for entering either a debit or a credit, depending on the 

parentheses control you defined for this account (in Chart of accounts).   

 

You may either enter the amount, or press [Enter] to move to the opposite column and then enter 

the amount there. 

 

If you enter zeros for both debit and credit amounts, you are asked if this is OK.  If you answer 

Y, you may proceed with the entry.  

 

Enter an amount,  OR: 

 

 [F2]  -To enter an amount to off-set (counter-balance) the "RUNNING 

BALANCE". For example, if the "RUNNING BALANCE" is a debit of 

$700.00 and [F2] is pressed, a credit of $700.00 will be entered as the 

amount.   

 

 

8. Source 

The source is used to sort entries when the Source Cross Reference Report is prepared (see the 

Source Cross Reference Chapter).   

 

Enter a Source, OR: 

 

 [Enter] -To accept the previous source entered (if you chose in Control information 

to re-display sources) 

 

[F1]  -To use the previous source entered (if you chose in Control information not 

to re-display sources) 

 

For a profit recognized entry (the entry is for a job and the category number is zero), the source 

defaults to PFTREC, and you cannot change it.  

 

NOTE: A source code is automatically assigned if G/L is interfaced with one or more Samco 

Packages and Get distributions is run to transfer entries into the General Journal Transaction 

File.  
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Accrual Reversal 
 

If the source entered is ACCRUE, accrual reversal is allowed (see explanation below). 

 

ACCRUE is used to record and adjust expenses, liabilities, revenues, etc., that must be partially 

accounted for during the current period but cannot be fully accounted for until the next 

accounting period.   

 

If you enter ACCRUE here and then answer Y to "REVERSE NEXT PERIOD?" (field 10), a 

reversing entry dated with the starting date of the next period, but opposite in sign, will be 

automatically created when this entry is posted.   

 

This lets you enter an accrual entry which is automatically reversed as of the beginning of the 

next accounting period.   

 

For example, if a weekly pay period crossed over between monthly accounting periods, you 

could make entries for the part of the week's payroll that is to accrue to the current period, and 

the software will automatically create reversing entries at the start of the new period.  (Then in 

the next period, you would make entries for the full week's payroll when the payroll week was 

over.) 

 

If ACCRUE is entered as the source, you must also make the counter-balancing entry with 

ACCRUE as the source, so that the accounts remain in balance in this accounting period.   

 

 

9. Reference 

Enter a reference or description for the entry, OR: 

 

 [Enter]  -To accept the previous reference entered (if you chose in Control 

information to re-display references) 

 

[F1]  -To use the previous reference entered (if you chose in Control information 

not to re-display references) 

 

 

Doc # 

The document number is an additional reference.  Entering a document number is optional. 

 

Enter a document number, OR: 

 

 [Enter]  -To accept the previous document number entered (if you chose in Control 

information to re-display document numbers) 

 

[F1] -To use the previous document number entered (if you chose in Control 

information not to re-display document numbers)  
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Duplicate Entries 

When making a new Journal entry, if an entry already exists for the same job, sub-job, change 

Order, category number, account number, date, debit or credit amount, source, and reference, 

you will be given a warning to this effect.  You are not prohibited from making this new entry, 

but you should verify that entering this duplicate is correct.  

 

 

10. Reverse next period?  

If ACCRUE was entered in field 8 ("SOURCE"), you can allow automatic reversal of an accrual 

entry upon posting.   

 

If ACCRUE was not entered, the message "(NOT ALLOWED)" is displayed, and this field is 

skipped.   

 

NOTE: If you select to reverse the entry in the next period, the "RUNNING BALANCE" will be 

the same as it was before the entry.  This is because the accrual reversal also reverses the entry 

you made.  However, you are still required to make the counter-balancing entry in order for 

entries to balance within the period. 

 

 

Entering Notes 
 

Press [F6] to enter notes about this entry (or view or change existing notes).  

 

 
 

 

 

Using Notes 

The purpose of notes for Journal entry is to allow you to annotate the entry with descriptive 

information. It is an assist to the audit trail so that the full and exact purpose of a particular debit 

or credit can be understood when someone reviews the Register at a later time.  
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The notes will always appear on the General Journal Entry Register and you may choose to have 

them appear on the Edit List as well. 

 

The notes are not saved after posting. 

 

This section uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

 

File Options: 

 

File -Save what I have just entered/changed, clear the screen, and get ready for 

another note. (Like pressing [Enter] at “Field number to change?” in other 

selections.) 

Save & continue -To save what was just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

 

Abandon changes -Throw away what I have just entered/changed and get ready for new note. 

(Like pressing [Esc] a ‘Field number to change?” in other selections.) 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

or another note. (Like Delete in other selections.) The software will ask 

you to confirm the deletion with an “OK to delete? message. 

 

[Esc]  -To Exit when done. 

 

 

Printing an Edit list 
 

This selection prints the General Journal Entry Edit List. 

 

Select Edit list from the General Journal Menu. 

 

If in Control Information you selected to track Journal transactions by User, you are prompted to 

Print trx entered by all Users?.  

 

Answering Y  -Prints ALL transactions for ALL Users 

Answering N  -Prints ONLY those transactions which you entered. 

 

You have the option of printing out the entries either in account number Order (A) or in the order 

they were entered (E). 

You also have the option to print notes for the entries.  
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If in GL Control information you have the following set to yes; 

 Allow posting outside Period ? Y 

 Allow posting outside Year ? Y 

 

When you print the General Journal Entry Edit List, the software will notify you that “Posting is 

allowed, but one or more Trx are dated outside the current period/year”. When you post, the 

software displays the message “Note: One or more Trx were dated outside the current 

period/year”. 

 

This Report is available to be printed to the “X” Export printer.  For full details on setting this up 

please review appendix D for full instructions. 

 

 

Posting General Journal Entries 
 

Select Post from the General Journal Menu. 

 

If you selected to track Journal transactions by User, you are prompted to Print Trx entered by 

all Users?.  

Answering Y  -Prints ALL transactions for ALL Users 

Answering N  -Prints ONLY those transactions which you entered. 

 

You have the option of printing out the entries either in account number order (A) or in the order 

they were entered (E). 

 

This selection will post general Journal entries to the General Ledger Transaction File and will 

print the General Journal Entry Register. The General Journal Entry Register shows every entry 

that is to be posted, exactly as it will appear in the General Ledger Transaction File. 

 

The Report number and Journal name are used to form a unique “Journal number”. Later, when 

you wish to refer to a General Journal Entry Register, you can do so by using “GJ” (General 

Journal) plus this Report number. For example, General Journal Entry Register number 0005 

could be referred to as GJ0005. 

 

While the register is being printed, the entries are checked to see if there are any invalid accounts 

or if any periods are out of balance. If invalid accounts are referenced, you will not be allowed to 

post. To continue, either delete the entries with invalid accounts and then re-enter them with 

valid accounts or enter the accounts into the Chart of Accounts. 

 

If any periods are out of balance (total of debits does not equal total of credits), you are also not 

allowed to post. To continue, make another entry to bring the periods into balance. 

 

If in GL Control information you have the following set to yes;  

-Allow posting outside Period ? Y  

-Allow posting outside Year ? Y 
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When there is a posting error 

 

--Review the Edit List 

--Make sure that all the entries are correct and balanced. 

 --Take note of the message at the bottom of the Edit List, it will provide information in 

regards to error.  

--If balanced - Post 

 

Usually if the system does not allow positing it is an Entry Error not a Software Issue. 

 

NOTE: When you post the General Journal Entries, the software will notify you that “Posting is 

allowed, but one or more Trx are dated outside the current period/year”. When you post, the 

software displays the message “Note: One or more Trx were dated outside the current 

period/year”.  

 

Assuming no invalid accounts and no periods are out of balance, the software posts the general 

Journal entries to the General Ledger Transaction File. 
 

NOTE: If the Control Information is set to ‘N’ then it will NOT allow you to Post. 

 

This function sets the “Running balance” and “Entry count” to zero and clears the General 

Journal Transaction File so that new entries can be made. 

 

NOTE: You can display the entries from any Journal by running Source Cross Reference in 

Journal order, using the Journal number as both the starting and ending Journal number. 

 

 

Importing Transactions 
 

The Import transaction function allows you to use the G/L transactions created by another 

system, thus eliminating the need to rekey transactions. 

 

The imported transactions may be created on any system but must be in ASCII text file format 

with a variable record length of 114 characters. For records under 114 characters in length, 

padding with spaces is allowed but not necessary. 

 

Signed numeric must have the sign separate and leading. For example, that transaction amount 

has a length of 15 characters with a maximum value of + or – 999,999,999,999.99. A value of 

12,345,678.90 would appear ‘+1234567890’ or ‘1234567890’. The sign is assumed positive if 

blank. A value of negative $100.00 would appear ‘-00000000010000’. 

  



General Ledger                            General Journal 

Samco Power Accounting 11B.85 

The import transactions must have the following format: 

 

aaaaaaaaaaaaaaaa  = 16-character valid GL account number 

 

YYMMDD = transaction date in year, month, day numeric format 

 

 

-99999999999999  = transaction amount with a maximum value of  

                                    + OR –  999,999,999,999.99 (the sign must be leading) 

 

SOURCE  = 10-character source description (converts to                                            

upper case) 

 

REFERENCE  = 25-character reference description 

 

F  = Accrual reversal flag, for transactions where  

                                   SOURCE=ACCRUE, defaults to “N” if blank. A  

   Y” creates a reversing sentry the following  

                                   month. 

 

DOC #  = 15-character document number  

 

JOURNAL #  = 6-digit number identifying the Journal to 

                                   which this transaction was posted to (do not 

                                  enter anything into this field as it is filled at 

                                 time of posting) 

 

JOB #  = 7-digit job number, which must correspond to 

                                   either an Active or Closed job (IF Using Job Cost Module) 

 

SUB JOB #  = 3-digit valid sub job number 

 

CHANGE ORDER #  = 3-digit valid change Order number 

CATEGORY #  = 7-digit cost category 

 

The program edits the transactions during import to verify the file format. 

 

NOTE: If the system from which the file is being transported has a G/L distribution Report, it 

should be printed prior to beginning the import procedure. 

 

The file being imported can reside on the fixed disk or on diskette – under DOS only. Xenix and 

Unix systems require the file to be located on the fixed disk. 

 

Once the import file is ready, select General Journal Trx > Import. 

 

On the screen displayed, answer N to accept the default file name. If the import file exists and 

has the correct format, then the editing process will begin and a message will display, monitoring 

the number of transactions which have been processed.  
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NOTE: If the import file cannot be found, the message “IMPORT FILE NOT FOUND PRESS 

ENTER TO CONTINUE” will be displayed. 

 

If the import file has an incorrect format, the message “IMPORT FILE HAS INCORRECT 

FORMAT PRESS ENTER TO CONTINUE” will be displayed. 

 

If the system detects un-posted transactions in the General Journal Trx file, a message will 

appear stating that all transactions must first be posted before proceeding. 

 

If there were any errors or warnings in the import file 

A window will appear asking you for a printer destination for the G/L transaction import error 

Report. 

 

Some cases where an Error Report will be produced are: 

 

• An invalid G/L account number has been entered 

• The transaction date is out of the current period 

• The entries are out of balance 

• Record format or field positioning is incorrect 

• The accrual reversal flag is not entered a Y, N or blank 

 

 

If an error occurs during the import process, the procedure aborts and no transactions are 

imported. The entry of an incorrect date which falls outside of the current period is not 

considered an error and does not cause the import to fail. 

 

Errors on the first transaction will prompt you to abort or continue. If you wish to edit the 

remainder of the transactions, press [Enter] and the procedure will continue to edit the 

remaining transactions for errors, otherwise press [Tab] and you will return to the Process 

General Journal Transactions Menu. 

 

Once the import has been successfully completed, print a transaction edit list to ensure that the 

imported information is correct before posting. To print an edit list showing only the import 

transactions, restart the Samco accounting system and login with the initials IMP. Any changes 

made should also be made to the system the transactions originated from. 
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One-Sided Entries 
 
When needing to correct your GL with a one-sided entry:  

 

Normally, you would restore your most recent backup in this situation. See the appendix titled 

Backing Up Your Data Files in the Installation Guide.  

 

If no backup is available you will need to make a “one-sided entry” in order to balance the G/L 

Transaction File. A ‘one-sided entry” is one in which you are entering, for example, a debit with 

no balancing credit. 

 

• Define a temporary G/L Account which is numbered higher than any other G/L 

account you are using currently in your Chart of Accounts. For purposes of this 

example, we will number this account 9999-901.  

• Enter this Account into your Chart of Accounts as a P&L Account. 

• Enter the one-sided entry, using General Journal, to an actual G/L account, not the 

temporary account mentioned above. (Entry would be dated in the period that is 

out of balance in the G/L Transaction File.)-This will balance the entry from the 

same amount to the temporary account (i.e. 9999-901) on the same date. (a debit 

to offset a credit, or vice versa)  

 

-Using File Utilities on second page (F2) of the G/L Menu; select >‘Export’ 

Select the G/L Transaction File to create a new export (ASCII text) file. 

 -Use F1 for ‘None for the device’ and ‘Unlimited for the size.’  

 -Hit > Enter at the ‘any change question’.  

-On next screen use> F1 for First in > “Starting file key”, and a value of 

“9999900” (the nine spaces are required) as the “Ending file key”. (The “Ending 

file key” is account number 9999-900, which is the account just before the 

‘Temporary account 9999-901’.) 

 -Hit >Enter at field number to change.  A message will come up > Create or Add  

-Use ‘C’ to Create (message will say, conversion complete) -Tab Out. --Choose 

printer, example; Garbage Can (Trx file is not needed) -The file utility will export 

all entries into the G/L Transaction File for all accounts up to but not including 

9000-901. 

 

NOTE: The account must be entered based on valid account number structure. 

This process will only work if your main account number is the first section of 

the G/L account number structure. For further clarification, refer to the System 

Functions Guide on use of account number sections. 

 

• Using File Utilities again; select > ‘Restore from an Export File’ Preform the 

same steps to create (restore) a new G/L Transaction File. This new G/L 

Transaction File will contain all debits and credits from the original file except for 

the credit to account 9999-901. Once posted your G/L Transaction File will now 

be in balance.
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Chapter 12 - Recurring Journal 
 

 

The purpose of the recurring Journal is different from the standard Journal. Here is how each 

works: 

 

 

Standard Journal 

The standard Journal contains debits and credits which are to be posted to the G/L Transaction 

File (the permanent G/L file). The entries are posted once per accounting period. 

 

All of the debits and credits in the standard Journal are posted. You cannot individually select 

entries to post. 

 

Standard Journal entries are left on file in the Standard Journal Transaction File for use in the 

next accounting period. 

 

 

Recurring Journal 

The recurring Journal contains entries which work in a fashion similar to Recurring sales (A/R) 

and Recurring payables (A/P).  If you are just using G/L, you may use this selection for 

recurring receivables and payables, then copy them (on a recurring basis) to the general Journal. 

 

Recurring Journal entries are entered, selected for use, and then the selected entries are copied to 

the General Journal Transaction File.  From there, they are posted to the G/L Transaction File. 

 

Recurring Journal entries may recur at any interval which you wish, such as daily, weekly, 

bi-weekly, quarterly, etc.  These intervals do not have to align to your accounting periods.   
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This is useful for such items as payroll.   

 

Recurring Journal entries may be either individually selected or selected in batches.  

 

Recurring Journal entries can include: 

 

• A date range over which the recurring entry is to be used 

• A maximum number of times it can be used 

 

You may automatically distribute recurring Journal entries by percentage.  In other words, you 

may debit an account and then balance the entry by allocating a percentage of the entry to a set 

of accounts.  For example, one account is debited, and then 10 other accounts are credited, each 

for 10% of the overall debit. 

 

 

To Begin 

Select Recurring Journal Trx > Enter from the G/L Menu 

 

1. Making Recurring Journal Entries 

 

 
 

From this screen, you can work both new and existing recurring Journal entries. 

Enter the following information: 
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[?] *1. Account # 

 

For a new recurring entry: 

Enter the number of the account to which this recurring entry applies, OR: 

 

  [F2]  -To scan through the accounts on file 

 

[Enter] -Leave the account number blank to either enter a full or partial 

description of the account, or to use [F2] to scan through the 

accounts in alphabetical order 

 

For an existing recurring entry: 

Enter the number of the account,  OR: 

 

  [F1]  -To scan through the recurring entries on file 

 

  [F2]  -To scan through the accounts on file 

 

 [Enter] -Leave the account number blank to either enter a full or partial 

 description of the account, or to use [F2] to scan through the 

accounts in alphabetical order 

 

  [F6]  -Use the account for the previous entry (if any) 

 

Once you have selected an existing entry, you may press [F6] to enter notes about it (or view or 

change existing notes). 

 

 

*2. Sequence # 

Enter the sequence number which identifies this recurring entry or press [F1] to scan through the 

recurring entries for this account. 

 

 

*3. Type 

This designates the type of recurring entry, which can be either fixed or variable. 

 

A fixed recurring entry has the same debit or credit amount each period. An example is rent. 

 

A variable recurring entry has a variable amount from period to period. An example is a 

telephone bill. Enter either: 

 

F -Fixed amount 

V -Variable amount 

 

For either type, you can still change the amount when you select the recurring entry for use, 

using manual selection. (See the section titled “Selecting Recurring Entries for Use”.) 
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Automatic and Manual Selection 
 

When you select recurring entries for use, you will be able to choose between automatic and 

manual selection. 

 

In manual selection, you may enter changes to the amount due, as above. This is most suitable 

for variable recurring entries, since you would usually want to make such changes. 

 

In automatic selection, the recurring entry (fixed or variable) is selected “as is”. This is most 

suitable for fixed recurring entries, which usually require no changes. 

 

In the next field (“Group”), you could set up separate groups for fixed and variable recurring 

entries. Then you could choose the “fixed” group in Select for use and use automatic selection on 

them. Similarly, you could choose the “variable” group and use manual selection for them so that 

you could enter the varying information. 

 

 

4. Group 

You may set up groups of any kind here, so that you may later select a group of recurring entries 

from which to create general Journal entries. 

 

Enter the group to which this recurring entry is to be assigned or press [Enter] to not assign this 

recurring entry to any group. 

 

 

5. Amount 

The cursor is initially positioned for entering either a debit or a credit depending on the 

parenthesis control you defined for this account (in Chart of accounts). 

 

Enter the amount or use press [Enter] to move to the opposite type (debit or credit). 

 

If you enter zeros for both debit and credit amounts, you are asked if this is OK. If you answer Y, 

you may proceed with the entry. 

 

 

6. Source 

Enter the source of this entry. 

 

You may not enter ACCRUE as a source. Accrual reversal is not allowed. (Accrual is described 

in the Chapter titled General Journal.) 

 

The source is a code used to sort entries when the Source Cross Reference Report is prepared 

(see the Source Cross Reference Chapter). Enter a source, OR:  
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  [Enter] -To accept the previous source entered (if you chose in Control  

    Information to re-display sources) 

 

  [F1]  -To use the previous source entered (if you chose in 

     Control Information not to re-display sources) 

 

 

7. Reference 

Enter a reference or description for the entry, OR: 

 

  [Enter] -To accept the previous reference entered (if you chose in  

 Control Information to re-display references) 

 

  [F1]  -To use the previous reference entered (if you chose in Control  

  Information not to re-display references) 

 

Doc # 

The document number is an additional reference. Entering a document number is optional. 

 

Enter a document number, OR: 

 

  [Enter] -To accept the previous document number entered (if you chose in  

    Control Information to re-display document  

 

 [F1]  -To use the previous document number entered (if in Control  

   Information the flag is set to not display numbers.)  

 

 

8. Correcting Entry? 

If this entry will be used to correct a previous entry, you can mark this as a correcting entry. This 

information is used in preparing the Expanded Cash Flow Statement (in Financial Statement 

Layouts). Answer Y or press [Enter] for N. 

 

 

NOTE: Only the debit or credit shown on this screen will be marked as a correcting entry. The 

distributions entered on the next screen are never marked as correcting entries. If you are using 

the recurring Journal entry to allocate to a set of accounts, then you would normally mark the 

debit or credit on this screen as a correcting entry. Consult with you accountant, as needed, 

regarding this. 
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For Notes: 

In addition to the usual options, you may press [F6] to enter or review notes about this recurring 

entry. Refer to the section titled “Using Notes” later in this Chapter. 

 

When you are through using notes, press [Tab], then press [Enter] at “Field number to change?” 

to get to the second screen: 

 

 
 

 
Expense Distributions  

(Fields 9 through 18) 

 

 
[?] Acct-# 

Enter the account number to which all or a portion of the entry will be distributed. The account 

number entered must exist in the Chart of Accounts File. 

 

Reference 

Enter a reference for this distribution. 
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Fixed and Variable Amounts 
 

For a Fixed Amount Entry: 

Enter the amount of the distribution to this account, OR: 

 

[F1] -To enter an amount to off-set (counter-balance) the “Running balance” (if 

non-zero) 

 

 [F2] -To change from entering a debit (or credit) to entering a credit (or debit) 

 

 

For a Variable Amount Entry: 

Enter the percent of the amount to be distributed to this account, or press [F1] to use the percent 

remaining to distribute, as displayed on the screen (“Percent remaining”). 

Both the percent remaining and the amount remaining display. 

 

The percent entered cannot by zero or negative. 

 

When the total percent remaining is zero, the cursor moves to the “Start date” field. 

 

 

19. Start Date 

Enter the date on which this recurring entry will start being used, or press [F1] for no specified 

starting date. 

 

 

20. Final Date 

Enter the final date to use this recurring entry, or press [F1] for indefinite. 

 

 

21. Interval   Every 

This specifies the time interval between usages of this recurring entry. Enter a number and then a 

time period. For instance, the interval could be every 2 weeks. Enter a 1- or 2-digit number, then 

select one of these time periods: 

 

 D Days 

 W Weeks 

 M Months 

 

For example, type 1, then type M, meaning that the entry recurs every one month. 
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22. Next Date 

Enter the next date the recurring entry should be activated. If this is not known exactly, enter the 

approximate date, or press [Enter] to use the start date. 

 

The “next date” is automatically advanced by the time interval entered above each time a general 

Journal entry is created from this recurring Journal entry (by running Use selected). 

 

 

23. Max # Uses 

Enter the maximum number of times this recurring entry can occur (later, you will be warned if 

this recurring entry is selected more than this many times), or press [F1] for indefinite (no 

maximum number of uses). 

 

 

24. Times Used 

When first setting up a recurring entry, enter the number of times this entry has already been 

used. If you had been making this entry before you began using Samco G/L, you would enter the 

number of times here. In this case, you would set the “maximum number of uses” above to 

include these times. 

For instance, if you were paying off a loan in 30 instalments and had already made 5 payments, 

you would enter “30” in field 23 above and “5” here. 

 

The last document number, last date, and times used information is automatically updated by the 

software. 

 

In addition to the usual “Field number to change?” option, OR: 

 

  [F1] -To display descriptions of the accounts to which amounts are being  

   distributed. (You may press [Enter] to return to displaying  references) 

 

  [F6] -To enter or review notes about this recurring entry 
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Using Notes 
 

The purpose of notes for a Journal entry is to allow you to annotate the entry with descriptive 

information. It is an assist to the audit trail so that the full and exact purpose of a particular debit 

or credit can be understood when someone reviews the Register at a later time. 

 

The notes will always appear on the General Journal Entry Register and you may choose to have 

them appear on the Edit List as well. 

 

The notes are not saved after posting. 

 

This selection uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

 

File Options 

When you select File options: 

 

File -Save what I have just entered/changed, clear the screen, and get ready for 

next, (another) note. (Like pressing [Enter] at “Field number to change?” 

in other selections.)  

 

Save & continue -Save what I have just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

Abandon changes -Throw away what I have just entered/changed and get ready for a new 

note. (Like pressing [Esc] a ‘Field number to change?” in other selections 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

for another note. (Like Delete in other selections.) The software will ask 

you to confirm the deletion with an “OK to delete? message. 

 

[Esc].   -To Exit when done 
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Printing an Edit List 
 

 

The Recurring Journal Edit List shows all recurring Journal entries that are on file. Select 

Recurring Journal Trx > Edit list and enter the following information: 

 

 

1. Print Report By  

Select whether to print the Report in order by A (account number), or G (Group). Follow the 

screen instructions. 

 

 

[?] Starting Account or Group 

[?] Ending Account or Group 

Enter the range of accounts or groups to be included in the list. Follow the screen instructions. 

 

 

2. Type 

Type F to print fixed recurring entries only, V for variable recurring entries only, or press [F1] 

for all recurring entries. 

 

 

3. Next Date Cut-off 

This selection allows you to show only recurring entries from which a general Journal entry is to 

be produced by a certain date. Only recurring entries with a “next date” on or before this date 

will be shown. 

 

You may enter a date, OR: 

 

 [F1] -For the “Latest date” on file. This means that all recurring entries 

which meet the other criteria will be included on the list. 

 

[Enter] -For the system (today’s) date 

 

 

4. Show Which Entries 

Select which entries are to appear on the edit list: 

 A -All entries 

 E -Only expired entries 

 

Expired entries are those recurring entries which either: 

-Have been selected more than the maximum number of uses, or 

-Have a “final date” before the current date.  
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Selecting Recurring Entries for Use 
 

Here you select which recurring entries are to become general Journal entries. 

 

To create a general Journal entry from a recurring Journal entry, you must select it for use here 

first, then, run the Use selected function below to transfer it to the General Ledger File, where it 

becomes just like any other general Journal entry. 

 

You may choose either automatic or manual selection. 

 

Choose Recurring Journal Trx > Select for use. On the screen displayed enter the following 

selection criteria: 

 

 

1. Select By 

Specify whether to select entries by A (account number) or G (group). 

 

 

[?] Starting Account Number or Group 

[?] Ending Account Number or Group 

Enter the range of accounts or groups to be selected. Follow the screen instructions. 

 

 

2. Next Date Cut-off 

If you want to select only recurring entries with a “next due date” on or before a specific date, 

enter that date here or press [F1] for no specific date. 

 

 

3. Selection Method 

Choose  

 A  - Automatic  

 M  - Manual selection of recurring entries. 

 

 

Automatic Selection 

If you choose automatic selection, recurring entries will be selected based on the criteria entered 

above. 

 

Manual Selection 

If you choose manual selection, then after you have completed entries on this screen, the 

recurring entries meeting the criteria above will be displayed, one by one, for you to select 

manually which ones to turn into general Journal entries.  
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Automatic Selection 

When you press [Enter] at “Field number to change?” a period of processing occurs while the 

recurring entries that you have specified are selected automatically by the computer. The 

Recurring Selection List will be printed to show you which recurring entries have been selected. 

The recurring entries that are selected will become general Journal entries in the General Journal 

Transaction File when you run Use selected (described later in this Chapter). 

 

Manual Selection 

When you press [Enter] at “Field number to change?” a screen then appears for you to select 

recurring entries manually. Entries which are selected here will be used to create general Journal 

entries when you run Use selected. 

 

 

 
 

[?] *1. Account # 

To find the recurring entry you want, enter the account number or press [F1] to scan through the 

recurring entries matching the criteria from the previous screen. 

 

 

*2. Sequence # 

Enter the sequence number of the desired recurring entry or press [F1] for the next entry. 

 

(If this recurring entry has already been selected, you are informed that it has been and asked if 

you now want to unselect it. Answer Y or N as appropriate.) 

 

If you answer N to “Select this entry?” the screen clears for you to enter another recurring entry 

to select. 

 

If you answer Y to “Select this entry?”, recurring entry is selected. Processing occurs as follows:  
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Fixed Recurring Entry: 

 

(1) The ‘next date’ stored in the recurring entry is displayed for the date. 

 

(2) You are allowed to change fields as usual. 

 

 

Variable Recurring Entry: 

 

The ‘Next date” stored in the recurring entry is displayed for the date. 

 

 

3. Date: 

 

 

4. Amount 

Enter the amount or press [Enter] to use the amount originally entered for this recurring entry  

 

Once the entry amount is entered, the function automatically calculates and displays the 

distribution amounts, based on the percent entered in the Enter function. 

 

Make any desired changes from “Field number to change?” or press [F6] to view or change the 

notes for this recurring entry. 

 

The distribution screen appears for you to make any changes necessary. 

 

Make any desired changes from “Field number to change?”   OR: 

 

  [F1] -To display account descriptions 

 

  [F6] -To view or change notes for this recurring entry 

 

 

Reselection 
 

If you select a variable recurring Journal entry that is already selected, and you change the 

amount of the entry, you will be given the option to recalculate the distributions. If you wish to 

use the distributions that you entered when the entry was originally selected, answer N. If you 

want the software to recalculate the distributions based on the percentages associated with the 

distributions, then answer Y. 
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Printing a Selection List 
 

This list shows every recurring entry that has been selected. It shows exactly what entries will be 

created when Use selected is run next. Use this list to verify and edit your selections. 

 

Choose Recurring Journal Trx > Selection List 

 

 

Using Selected Recurring Entries 
 

When you have verified that your selection of recurring entries is correct and complete, you are 

ready to create general Journal entries for those recurring entries selected. 

 

Select Recurring Journal Trx > Use selected. You are asked if it is OK to create the entries. 

 

The document number for the general Journal entry, if left blank, is filled in by the software 

using the sequence number and date of the recurring entry. 
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Chapter 13 - Standard Journal 
 

 

This function provides you with the ability to generate Journal entries which occur every 

accounting period but which may have values that vary from period to period; depreciation of 

fixed assets is an example of a use for standard Journal entries. 

 

The Samco General Ledger system provides you with two methods for creating standard Journal 

entries -- Standard Journals, and Automatic Journals. 

 

Recurring Journal 

The G/L Package also has a recurring Journal which handles recurring entries, although similar 

to standard Journal entries its purpose is different. Refer to the Chapter titled Recurring Journal 

for a comparison of the recurring and standard Journals. 

 

Standard Journals 

Standard Journals are identical to regular general Journal entries in structure, except they can be 

either "fixed" or "variable". A fixed standard Journal entry rarely changes value from period to 

period, while a variable standard Journal entry can fluctuate in value each period. 

 

Here are some examples of fixed and variable standard Journals: 

 

 Fixed     Variable 

 

Rent Coffee Services 

Car Lease Long Distance 

Disposal Service Advertising  
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Automatic Journals 
 

Automatic Journals differ from Standard Journals in three ways: 

 

1. Transactions can be generated for two or more accounts based on a ratio or percentage of the 

account balances for other G/L accounts 

 

2. Since automatic Journal entries are based on the account balances of other accounts, the 

transactions do not have a fixed dollar value.  Rather, they must be calculated at the end of each 

period. 

 

3. Standard Journal entries are actual entries; automatic Journal entries must be calculated first 

before they are generated. 

 

Automatic Journals are ideal for distributing common operating expenses amongst various 

departments.  Allowing you to accumulate these expenses over the course of the accounting 

period, and then disbursing them out to departments based on either a fixed percentage (i.e. 10% 

to sales, 22% to service etc.), or on a ratio of G/L account balances (explained in detail later on 

in this Chapter). 

  

One other area where the two types of entries differ are standard Journals are left on file in the 

Standard Journal Transaction File for use in the next accounting period after they have been 

posted. Automatic Journal entries, on the other hand, are removed from the Standard Journal 

Transaction File once posted.  Automatic entries must be recreated each accounting period from 

the predefined criteria. 

 

To Begin 

Select Standard Journal Trx > Standard Journals from the G/L Menu. 

 

 
 

The dates displayed in the upper right-hand corner show your current accounting period.  
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Note also that an “ENTRY COUNT” (number of entries made) and a “RUNNING BALANCE” 

are kept as you make standard Journal entries. When the running balance is equal to zero, all 

entries which have been made are in balance (debits equal credits). 

 

 

*1. Type 

The type determines whether the recurring amount is permanent (fixed) or variable. 

 

A permanent Journal entry is any entry that is made to account for the same amount each period. 

These entries are kept on file and posted each period for the same amount. 

 

A variable Journal entry is any entry that is made to the same account each period, but for 

different amounts. Before posting, you can quickly locate and change the variable amounts to be 

posted by using [F2] as described below. 

 

Enter the type: 

 

P  -For Permanent  

V  -For Variable  

OR: 

[F1] -To scan through all entries on file 

 

 [F2] -To change to scanning through only variable entries on file 

 

Because the entries are in order by type (and then by account number), you can quickly locate 

the variable entries by pressing [F2] and then using [F1] to scan through them. 

 

 

[?] *2. Account # 

This is the G/L account for this entry. It must be in the Chart of Accounts File. Enter the account 

number,  OR 

 [F2] -To scan through the G/L accounts on file 

 

 [F1] -To use the same G/L account as the previous entry (if any) 

 

[Enter] -To leave the number blank to find the G/L account by description 

 

 

3. Amount 

This is the amount of the entry, which is always positive (no minus sign allowed) and is entered 

as either a debit or a credit, depending on the parenthesis control which you defined in Chart of 

accounts. 

 

If you enter zeros for both debit and credit amounts, you are asked if this is OK. If you answer Y, 

you may proceed with the entry.  
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Enter the amount, or press [Enter] to move to the opposite column and enter the amount there, 

OR: 

 [F1]  -To scan through the entries matching the type and account               

  number 

 

 [F2]  -To enter an amount that will off-set (counter-balance) the 

  running balance (if non-zero) 

 

For example, if the “RUNNING BALANCE” is a debit of $700.00 and [F2] is pressed, a credit 

of $700.00 is entered as the counter-balancing amount. 

 

 

4. Source 

The source is a code used to sort entries when the Source Cross Reference Report is prepared 

(see the Source Cross Reference Chapter). Enter a source, OR: 

 

 [Enter] -To accept the previous source entered (if you chose in   

  Control Information to re-display sources) 

 

 [F1]  -To use the previous source entered (if you chose in Control  

   Information not to re-display sources) 

 

If the source entered is ACCRUE, accrual reversal is allowed. (See the explanation in the 

General Journal Chapter.) 

 

(If ACCRUE is entered as the source, you must also enter the counter-balancing entry with 

ACCRUE as the source, so that the accounts remain in balance.) 

 

 

5. Reference 

Enter a reference or description of the entry, OR: 

 

 [Enter] -To accept the previous reference entered (if you chose in   

  Control Information to re-display references) 

 

 [F1]  -To use the previous reference entered (if you chose in   

  Control Information not to re-display references) 

 

 

Doc # 

Entering a document number is optional. This is an additional reference.  
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 [Enter] -To accept the previous document number entered (if you   

  chose in Control Information to re-display document 

    numbers) 

 

 [F1]  -To use the previous document number entered (if you 

 chose in Control Information not to re-display document numbers) 

 

 

6. Reverse Next Period? 

If ACCRUE was entered in field 4 (“SOURCE”) you can allow automatic reversal of an accrual 

upon posting. If ACCRUE was not entered, the message “(NOT ALLOWED)” is displayed and 

this field is skipped. 

 

The running BALANCE is automatically updated to include the amount of the entry just made, 

the entry COUNT is incremented by one, and the screen is cleared for the next entry. 

 

 

Automatic Journal Entries 
 

Select Automatic Journals > Enter criteria from the Standard Journal trx Menu. 

 

 
 

Use this function to set up the criteria by which automatic Journal entries will be calculated. A 

“criteria” is basically a set of instructions which tells the computer how to generate the Journal 

entries. When the Calculate automatic trx function is run, the criteria set up in this function will 

be used to create the standard Journal entries.  
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There are two screens of data to be entered. The first screen, shown above, is the criteria header. 

The second screen, shown later on, is used to enter the actual G/L account distributions – 

referred to in this section as distributions or account allocations. 

 

NOTE: The current accounting period is displayed in the upper right-hand corner of the screen. 

When the Calculate automatic trx function is run, the account balance(s) will be calculated using 

this period. 

 

Percentage vs Ratio 

Automatic Journal entries can be created using either the percentage or ration method. 

 

Percentage 

A percentage Journal entry will allocate the sum balance of a range of accounts (the base) to one 

or more accounts based on User defined percentages. 

 

For example, over the course of a month a Company accumulates a number of general operating 

expenses. These expenses are accumulated in G/L accounts 6000-000 through 6999-000. In order 

to show a true reflection of each department’s profitability, the Company can use an automatic 

Journal to disburse percentages of the total accounts 6000-000 through 6999-000 to departmental 

expense accounts. 

 

Ratio 

There are three parts to a ratio type automatic Journal: 

 

 

Base Range: -The total balance of an account range. This is the dollar figure 

divided up and allocated to the “post to accounts”. 

 

Ratio Accounts: -The ratio percent for each account range is expressed as a 

percentage of the balance of the base range. 

 

Post to Accounts: -The actual accounts to be debited and credited. The amount 

posted to each account is the ratio percent of its respective ratio 

account. 

 

 

Using the table below as an example, the base range amount is $200. The sum of the ratio 

account ranges (A, B, and C) is $100. At this point it should be made clear that the entire base 

range amount must be distributed.  
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Base Range 

 

Ratio Ranges 

 

Range Value 

 

Ratio 

 

Distribution 

$200.00 Account Range “A” $ 50.00 50:100 $100.00 

 Account Range “B” $ 40.00 40:100 $ 80.00 

 Account Range “C” $ 10.00 10:100 $ 20.00 

 Total $100.00 100:100 $200.00 

    

Since the total balance of account range “A” is $50, “A” will receive 50% if the base range 

(50:100) or $100.00. “B”, which accounts for $40, will receive 40% of the base range (40:100) 

or $80. And finally, “C” will receive 10% of the base range (10:100) or $20. 

 

 

1. Trx Type 

 

C   -For percentage type criteria  

R   -For a ratio. 

 

 

2. Source 

Enter a unique source code to distinguish transactions generated by these criteria. All automatic 

entries will have a source code prefixed with AUT. This code is used for sorting in preparing the 

G/L source cross reference Report. 

 

 

3. Base Range 

Enter an account range to be used as the “base” value allocated or distributed. To use one 

account as the “base”, enter the same account number in from account no. and to account no. 

fields. 

 

Inclusive? 

Answer Y to calculate the values for this transaction using the current period’s transactions for 

the base plus any standard Journal or automatic Journal transactions which will affect the 

accounts in the base. Enter N if you wish to calculate the values for this transaction using only 

the current account balance. 

 

 

4. Description  

Enter a reference or description for the transaction. 

 

 

5. Total Percent = 100.00% 

This field only displays for percentage (type C) transactions. 

 

Press [Enter] if the total percentage of your entries on the second screen must equal 100% 

before you will be allowed to complete entry. Otherwise, answer N. 
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The next screen displayed is dependent on whether this is a percentage or ratio type transaction  

 

 

(1. Trx Type). 

For instructions on Ratio Type Transactions see the section following Percentage Type 

Transactions. 

 

Percentage Type Transactions 

 

For percentage (type C) transactions, the following screen appears next: 

 

 
 

Enter up to 50 allocations to create transactions for: 

 

 

Percent 

Enter the percentage of the “base” that is to be allocated. 

 

Post to (same sign) Account No. 

Enter the account number to which the calculated value (percent of base) is to be posted. The 

account entered will have to it a value which is of the same sign (DR/CR) as the base. For 

example, if the net value the account entered here will have a debit amount posted to it. 

 

Post to (opposite sign) Account No. 

Enter the offsetting account number to which the calculated value (percent of base) is to be 

posted. The account entered will have posted to it a value which is of the opposite sign (DR/CR) 

as the base. For example, if the net value of the base is a credit value the account entered here 

will have a debit amount posted to it. 

 

NOTE: “Total percent” field in bottom left corner of the screen maintains a running total of the 

percentage fields. A maximum of 50 percentage allocations are allowed.  
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Enter all required percentage allocations and corresponding account numbers. When this is 

completed press END at Percent to complete entry and go to “Field number to change?” 

 

To add another detail line, press the number of the next available field and enter in the necessary 

information. 

 

To delete another detail line, press the number of the field line followed by [Enter] and then 

press [F2] when the cursor is in the “Percent” field. 

 

If you select the total percent must equal 100.000, and [Enter] is pressed at “Field number to 

change?” before the total percent has reached 100.000, the message “Percentage detail must total 

100.00 press [Enter] to continue”. Press [Enter] and continue editing the allocations until the 

total percent equals 100.000 (bottom left hand corner of screen). 

 

Pressing [Tab] at “Percent” before any allocations have been entered will result in the message 

“Exit not allowed – cancel criteria or add detail. Select 1) Cancel criteria, or 2) Add detail”. Press 

1 to cancel the automatic Journal criteria, or 2 to return to adding allocations. 

 

 

Ratio Type Transactions 
 

For ratio (type R) transactions, the following screen appears next: 

 

 

 
 

 

[?] From Acct No. 

[?] To Acct No. 

Enter the ratio range of accounts. 
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When the Calculate automatic trx function is run these ranges are added up. A ratio is then 

calculated for each range based on its proportion to the sum of all ranges. This ratio is 

represented as a percentage, which is then multiplied against the “base” to generate a calculated 

value. This calculated value is used by the next two fields. 

 

Post to (same sign) Account No. 

Enter the account number to which the calculated value is to be posted. The account entered will 

have to it a value which is of the same sign (DR/CR) as the base. For example, if the net value of 

the base is a credit value the account entered here will have a credit amount posted to it. 

 

Post to (opposite sign) Account No. 

Enter the offsetting account number to which the calculated value is to be posted. The accounts 

entered will have a posted to it a value which is of the opposite sign (DR/CR) as the base. For 

example, if the net value of the base is a credit value the account entered here will have a debit 

amount posted to it. 

 

When all required ratio ranges and corresponding account numbers have been entered, press 

[Tab] at: “From acct no.” 

 

To add another detail line: 

Press the number of the next available field and enter in the necessary information. 

 

To delete another detail line: 

Press the number of the field line followed by > [Enter] > then press [F2] when the cursor is in 

the “From acct no.” field. 
 

 

NOTE: Pressing [Tab] at “From acct no.” before any allocations have been entered will result in 

the message “Exit not allowed – cancel criteria or add detail. Select 1) Cancel criteria, or 2) Add 

detail”. Press 1 to cancel the automatic Journal criteria, or 2 to return to adding allocation 

criteria. 

 

 

Change Criteria 
 

Use this selection to make any changes to existing automatic Journal criteria. Select Change 

criteria from the Automatic Journal Menu. 

 

Enter the unique Journal number of the criteria to be changed, make any desired changes and 

press [Enter] at “Field number to change?” 

Depending on the transaction type of the criteria (C or R), you are prompted: 

Do you wish to change percentage detail? 

OR 

Do you wish to change ratio detail?  
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Press [Enter] to default to > N, the screen will be cleared and the cursor positioned for entry of 

the source code of the next criteria. 

If you type > Y, the second screen containing the percentage or ratio detail will be displayed. 

Locate the detail line you wish to change by paging through using the [F1] and [F2] keys. 

 

 Once you have located the page containing the detail line press [Enter] and make the necessary 

changes. When there are no more changes on this page, press [Enter] at “Field number to 

change?”. Press [F1] or [F2] to page through the detail lines to find another entry to edit. 

 

Once all changes have been made for this criterion, press [Tab] at “Press F1 for next page, F2 

for previous page”. 

 

 

Delete Criteria 
 

Select Delete criteria from the Automatic Journal Trx processing Menu. 

 

From the screen that appears, enter the source code of the criteria you wish to delete. Answer Y 

at “OK to delete criteria?” to remove the automatic Journal criteria permanently. Otherwise, 

press [Enter]. 

 

Press [Tab] at the source code field to exit this function. 

 

 

Print Criteria List 
 

Select Print criteria list from the Automatic Journal trx processing Menu and enter the following 

Report criteria: 

 

 

1. Trx Type 

Enter C for percentage type criteria, R for ratio, or press [F1] for both. 

 

 

2. Starting Source 

3. Ending Source 

Enter a range of source codes to print, or press [F1] at each field for the first and last source 

codes on file respectively. 

 

 

4. Include Detail 

Answer Y if you want the allocations included in the Report, or N to print the first screen 

information only. 

 

The printer select window appears for you to choose which printer to send the Report to.  
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Calculate Automatic Trx 

Select Calculate automatic Trx from the Automatic Journal Trx processing Menu. 

 

On the next screen displayed, answer Y to continue processing, or N to return to the previous 

Menu. 

 

NOTE: If choosing to continue, there will be a period of processing while transactions are 

calculated. During the processing the source code of each criteria will appear in the top left 

corner of the screen. 

 

If automatic transactions have already been calculated for the current period but not posted to the 

G/L transaction file, the message “Automatic Trx have already been calculated for this period. 

Do you wish to recalculate?” Answer Y to continue processing, or N to cancel this function. 

 

 

Once this function is complete, Journal entries will have been created. You can then run an edit 

list and post the transactions from the Standard Journal Menu (discussed in the next two 

sections). 

 

Press [Tab] to return to the Standard Journal Menu. 

 

 

Standard Journal Edit List 
 

Select Standard Journal Trx > Edit List from the G/L Menu. 

 

The Standard Journal Entry Edit List is used to verify the accuracy of the entries made before 

you post them to the General Ledger Transaction File. This list includes both standard and 

automatic Journal transactions. 

 

When printing, you can sort the General Journal Edit List by: 

 A -Acct-#    

 E -Entry   

 D -Doc-#    

 S -Source   

 R -Reference 
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Posting Standard Journal Entries  
 

Select Standard Journal Trx > Post from the G/L Menu. 

 

This selection will post both the standard and automatic Journal entries to the General Ledger 

Transaction File, and also perform verification checks while printing the Standard Journal Entry 

Register. All entries to be posted will appear on this register. When printing, you can sort the 

General Journal Posting Register by  

 

 A -Acct-#    

 E -Entry    

 D -Doc-#    

 S -Source  

 R -Reference. 

 

The Report number and Journal name are used to form a unique “Journal number”. Later, when 

you wish to refer to a Standard Journal Entry Register, you can do so by using “SJ” (Standard 

Journal) plus this Report number. For example, Standard Journal Register number 0007 could be 

referred to as SJ0007. 

 

The Standard Journal Entry Register will verify that the entries being posted are in balance by 

period (debits equal credits). 

 

All entries will fall in one of two periods, current period or next period (for accrual reversals). If 

either of the two possible periods does not balance, a message is given showing the balances for 

the non-zero periods and posting will not be allowed. To correct, you must either add additional 

entries or change the entries on file to balance the period. The Standard Journal Entry Register 

will also verify that all accounts used by the entries are in the Chart of Accounts File. 

 

If an entry uses an account that is not in the Chart of Accounts File, a message is given and 

posting will not be allowed. To correct, you can either delete the entry and re-enter one for the 

correct account or enter the account in you Chart of Accounts. 

 

If you attempt to post standard Journal entries which someone has already posted for the current 

period, a warning is given, but you can still continue and post the entries. 

 

Once these entries are posted, they will not be deleted from the Standard Journal Transaction 

File. They will remain on file for posting next period. 

 

The current period ending date for each posted entry is stored in the Standard Journal 

Transaction file to detect any attempt to re-post the same entry for the same period. 

 

________________________
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Chapter 14 - View Trial Balance and GL Accounts 
 

 

View Trial Balance 
 

The View Menu option provides you the ability to drill down through transaction details, 

whether compressed or not.  At the General Ledger Menu select View and the following screen 

will open: 

 

 
 

 

The View trial balance provides a simple screen to see your trial balance for the current period. 

From this screen you can “drill down” to see account detail or change the criteria for the data you 

are viewing. 
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Use the Menu across the bottom of the screen to move up and down through the accounts.   

 

  [F2]  - To change the criteria  

 

  [F4]   - To view an account 

 

[Tab]  -To exit 

 

 

[F4]   -Detail > View account you can further “drill down” 
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Follow the screen prompts: 

 

 [F1]   -To view source and document # 

 

 [F2]   -To select the next account 

 

 [F4]    -For further detail by account # 

 

[F5]  -Cross-reference by Journal # 

 

 [F6]  -To access notes 

 

 [Tab]  -To exit 

 

 

Using Notes 
 

If you press [F6], you may enter an unlimited number of notes about the account being 

displayed. Each note is given a date/time stamp so that you can scan through the notes in time 

sequence later. 

 

This selection uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

File Options 

 

File -Save what I have just entered/changed, clear the screen, and get ready for 

another note. (Like pressing [Enter] at “Field number to change?” in other 

selections.) 

 

Save & Continue -Save what I have just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

 

Abandon Changes -Throw away what I have just entered/changed and get ready for a new 

note. 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

for another note. (Like Delete in other selections.) The software will ask 

you to confirm the deletion with an “OK to delete?” message. 

 

[Esc].   -To Exit when done  
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View General Ledger Accounts 
 

Use this selection to view all activity for a specific G/L account within a specified range of dates.   

 

To Begin 

Select View> View General Ledger Accounts from the G/L Menu. On the screen that appears, 

enter the following information: 

 

 

1. Account # 

Enter the G/L account that you want to view, or press [F1] to scan through accounts with posted 

entries. 

 

 

2. Starting Date 

The starting date does not have to be the starting date of an accounting period.  Enter a date, OR: 

 

  [F1]  -For the "Earliest" date on file 

 

[Enter]   -To use the starting date of the current period 

 

If you enter the earliest date on file, the first entry shown would be the balance brought forward 

(BBF) entry, which you previously entered in either Set-up procedures or Close a year. 

 

 

3. Ending Date 

The ending date does not have to be the ending date of an accounting period. Enter a date, OR: 

 

   [F1]   -For the "Latest" date on file 

 

 [Enter]   -To use the ending date of the current period  
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Up to 14 entries can be shown on the screen at once. If there are more than 14 entries, you can 

use the PgUp and PgDn keys to move around.  

 

 [F1] -To see the source and document number instead of the 

 reference and Journal number 

 

   [F2] -To return to selecting an account 

 

   [F6] -To view or enter any notes for this G/L account 

 

There is no limit to the number of pages that may be viewed when paging forward. However, 

you are restricted to viewing just the previous 9 pages. (You cannot “backup” more than 9 

pages.) 

 

On the screen containing the last entry on file, the total debits, total credits, beginning balance, 

net change, and ending balance are shown. 

 

 

Using Notes 
 

If you press [F6], you may enter an unlimited number of notes about the account being 

displayed. Each note is given a date/time stamp so that you can scan through the notes in time 

sequence later. 

 

This selection uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing.  
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File Options: 

 

File -Save what I have just entered/changed, clear the screen, and get ready for 

another note. (Like pressing [Enter] at “Field number to change?” in other 

selections.) 

 

Save & Continue -Save what I have just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

 

Abandon Changes -Throw away what I have just entered/changed and get ready for a new 

note. 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

for another note. (Like Delete in other selections.) The software will ask 

you to confirm the deletion with an “OK to delete?” message. 

 

[Esc].   -To Exit when done 

 

 

 

View Cross-reference 
 

Allows you to quickly view (instead of having to print) all of the transactions for certain criteria 

(document #, Journal #, and source). Within all of the View functions you can drill down to 

account detail, transaction detail (even for compressed transactions), and source cross-reference. 
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Begin your search by: 

  

D  -Document 

J -Journal  

S -Source  

 

Your search by Journal # will look like: 

 

 
 

The screen prompts will continue to assist your search. 
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Chapter 15 - Reports 
 

Print Trial Balance 
 

Use this selection to print the G/L Trial Balance for a range of selected accounts.  You can print 

the trial balance in either summary or detail. The trial balance is usually run after all entries have 

been entered and posted for the specified period.  However, it can be run at any time during 

General Ledger processing. The period used is the reporting period defined in Accounting 

periods. 

 

Select Reports > Print Trial balance from the General Ledger Menu. 
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[?] 1. Starting Account 

[?] 2. Ending Account 

Enter the range of accounts to be included on the trial balance – you can also press [F1] for the 

first and last account on file. 

 

 

3. Starting Date 

4. Ending Date 

Enter the date ranges to be included on the trial balance. 

 

 

5. Cash Flow Type? 

(For an explanation of cash flow types, see the Chart of Accounts Chapter.) 

 

If one or more cash flow types are entered, this occurs: 

 

• All accounts related to each cash flow type are printed in their own section totals. 

• When accumulating total debits and total credits, credit entries marked as 

correcting entries are added to total debits, and debit entries marked as correcting 

entries are added to total credits. 

 

To use only specific cash flow types in the trial balance, enter one or more of these choices: 

 O  -Include Operations Types 

 I  -Include Investment Types 

 F  -Include Financing Types 

 [Enter] -Ignore cash flow types in printing the trial balance 

 

If a type is chosen, the trial balance will be grouped by cash flow type. If types are ignored, the 

trial balance will be grouped by account number. 

 

 

6. Show Detail? 

A detailed trial balance shows individual entries. A summary trial balance shows only account 

totals. Press [Enter] to show individual entries, or answer N to show only totals. 

 

 

Print prd summary? 

If the Reporting Period (see Accounting Periods) is set to span multiple accounting periods, and 

the Show detail is set to Y, this field appears. When set to Y, each accounting period that is 

spanned by the reporting period will be summarized. 

 

 

7. Print Each Acct on Separate Page? 

(This field appears only if you are printing a detailed trial balance.) 

 

Answer Y to start printing each account on a new page. This makes it easier to distribute 

information about different accounts to different areas of an organization. 

Section/group Selection 
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The number of times you are prompted in the next set of prompts depends on how your G/L 

accounts are structured. For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 

 

[F1]  -To select “All” values for this account section, OR 

 

[F2] -To select a specific section value. This is most useful when 

selecting a section which may have multiple accounts with  the 

same section. OR 

 

[F3] -To select a section group. For more information on sub-account 

groups, see the Chapter titled Sub-Account Groups. 

 

The trial balance shows the beginning and ending balance, total debits, total credits, and net 

change. 

 

If trial balance (T/B) subtotal levels were entered in Chart of accounts, they will be used in 

printing the trial balance. 

 

The detailed form of the Report also shows all entries for each account, unless Compress G/L 

Transactions has been run and the detail is no longer available. 
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General Ledger Worksheet 
 

Use this selection to print the G/L Worksheet, which is used in closing procedures for an 

accounting period.   

 

The worksheet contains the following columns: Opening balance, Debits, Credits, Difference, 

Ending balance, blank columns for adjustments, and blank columns for the adjusted trial balance.   

 

The period used is the reporting period in Accounting periods.   

 

To Begin  

Select Reports > Print general ledger worksheet from the G/L Menu. 

 

 
 

 

[?] 1. Starting Account 

[?] 2. Ending Account 

Enter the range of accounts to be included in the worksheet.   

 

 

3. Start Date 

4. End Date 

Enter the range of dates to be included in the worksheet. Follow the screen instructions. 

 

Section/Group Selection 

The number of times you are prompted in the next set of prompts depends on how your G/L 

accounts are structured.  For example, if you have a 3-section account number, you will be 

prompted 3 times.  
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[F1]   -To select "All" values for this account section, OR: 

 

[F2] -To select a specific section value.  This is most useful when selecting a 

section which may have multiple accounts with the  same section. 

 

[F3]   -To select a section group.  For more information on sub-account   

   groups, see the Chapter titled Sub-Account Groups.  

 

Make any necessary changes, press [Enter], and select the printer you wish to send the Report 

 

 

Source Cross Reference 
 

This selection prints the Source Cross Reference Report, which is a list of entries within the 

range of dates you specify, grouped by either their source code or Journal number. 

 

A source code is assigned automatically when you run Get Distributions to transfer entries from 

other Samco Packages into the General Journal Transaction File. For example, the source code 

for Accounts Payable entries is always “AP” (unless you manually change the general Journal 

before posting the entries). 

 

Source Codes 

The following source codes are automatically assigned to designate the source of an entry: 

 

Code      Journal         

GJ  General Journal 

SJ  Standard Journal 

AR  A/R sales 

CJ  A/R cash receipts 

FC  Finance charges 

AP  A/P vouchers 

AJ  A/P adjustments 

AK  A/P cheques 

AV  A/P voided cheques 

PO  Purchase price adjusts 

PR  Payroll Cheques 

PM  Manual Payroll 

IC  Inventory entries 

JC  Job Cost entries 

JB  Job Billing entries 

 

Journal number refers to the Report printed when you post general or standard Journal entries 

within the G/L Package, or when you post other types of entries in other Samco Packages. Each 

Journal number has a two-letter source code (GJ for general Journal, SJ for standard Journal, 

etc.), followed by a unique Report number. For example, SJ0005 is a Report number. 

Thus, you can always associate a Journal number with a specific printed Report, and (provided 

you have not run Summarize general ledger) you can reconstruct a lost Report by using this 

program.  
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To reconstruct a Report: 

 

• Specify to print in Journal number order. 

• Specify all sources. 

• Specify the particular Journal number as both the starting and ending Journal 

number. 

• Specify all dates. 

 

To Begin 

Select Reports > Print source cross reference from the G/L Menu. 

 

 
 

 

1. Print Order 

Enter either J to print in order by Journal number, [S] to print in order by source, [D] to print by 

document number or [T] to print by date. 

 

 

2. Starting Source 

3. Ending Source 

Enter the range of sources to print. Follow the screen instructions. 

 

 

NOTE: Even if you have selected to print in Journal number order, your source selection still 

affects which entries will be printed (i.e. only entries from selected sources will be printed). 

 

 

4. Starting Journal # 

5. Ending Journal # 

Select the range of Journal numbers to print. Follow the screen instructions. 

 

If you do enter a Journal number, it doesn’t have to be an actual Journal number. For example, 
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entering “GJ0000” for “Starting Journal #” and “GJ9999” for “Ending Journal #” will print all 

entries from general Journal posting. 

 

 

6. Starting Date 

7. Ending Date 

Enter the range of dates you wish to print (any date, not necessarily what is in your accounting 

period table). 

 

You can press [Enter] to default to the current period’s starting date (field 6), or the ending date 

of the current accounting period (field 7). Follow the screen instructions. 

 

In summary, when you have selected starting and ending sources, starting and ending Journal 

numbers, and starting and ending dates, any entries which are within all of these three limits will 

be included. 

 

 

8. Show Balanced Sources 

This allows a selection of a Report that only shows items if the total is non-zero. It works in 

conjunction with the print order field. If cross referencing by [J] Journal number only the non-

zero (unbalanced) Journal listings would print if the show balanced field was set to (N). The 

same would apply if the print order was [D] document. 

 

 

9. Title of Report 

Enter any title you want, or press [F1] to use the title “SOURCE CROSS REFERENCE 

REPORT”. 

 

For readability, spaces are inserted in the title automatically. For example, “MY UNIQUE 

REPORT” would appear as “M Y   U N I Q U E   R E P O R T” (1 space between characters, 3 

spaces between words). 

 

If there are no entries within all three sets of limits (sources, Journal numbers, and dates), you 

will see “No entries in range selected”. 

 

If this Report is in source order, the Report lists all entries within the Journal number and date 

limits in order by source. The Report shows subtotals for each source and grand totals for all 

sources. 

 

If the Report is in Journal number order, the Report lists all entries within the source and date 

limits in order by Journal number. The Report shows grand totals for all Journal numbers. 

 

Notes on Printing Source Cross References 

 

If there is limited disk storage, it is possible that there may not be enough room to process a 

Report for all entries. If this is the case, you will see a message and cannot continue the function. 
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To handle this, you can either: 

 

(a) Narrow your source, Journal number, or date limits, so that fewer entries are printed (and 

then print the rest separately afterward); or  

(b) Compress the General Ledger Transaction file (see the Summarize General Ledger 

Chapter), and then run the Report for all entries which you initially specified. 

___________________________ 
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Print Financial Statements 
 

This selection is used to specify customizing options and to print Financial Statements. 

 

In Statement layouts, you entered the codes and account numbers to define the layouts for 

particular statements.   

 

Using Enter specifications, you will be able to enter additional requirements for customizing 

statements so that many different statements can be generated from any one layout.  This will 

reduce the number of layouts that you must have on file to print a variety of Financial 

Statements.    

 

Print Financial Statements will calculate the net income figures and account balances for the 

reporting period, then print the Financial Statements. 

 

To Begin 

Select Reports>Print Financial Statements> Set up specifications > Enter specifications from the 

G/L Menu. 

 

 
 

  



 
General Ledger  Reports 

Samco Power Accounting 15.132 

Entering Specifications 
 

New and Existing Specifications. (From this screen you can work with both new and existing 

specifications.) 
 
 

[?] *1. Specification # 

Enter the number that identifies the specification (the number cannot be zero) or use [F1] to scan 

through the specifications on file. 

 

We recommend that you group specifications numerically so that it will be easy to select all 

specifications within a particular numeric range for printing. For example, assign specification 

numbers 1 to 100 for Financial Statements for monthly reporting, 101 to 200 for quarterly 

reporting, and 201 to 300 for year-end reporting. 

 

Additionally, you could assign specification numbers 1 to 50 to profit and loss statements and 

supporting schedules, and 51 to 100 to balance sheets and supporting schedules. 
 

 

[?] 2. Layout # 

Enter the existing layout number to which these specifications will be applied, or use [F1] to 

scan through the layouts on file. 

 

 

3. Rounding Factor 

This is used when any of the amounts are greater than 999,999,999.99 because of the space 

available on the statement. Rounding to the nearest dollar will allow up to 999,999,999,999 to 

print on the statement. Use one of the options: 

 

   D -Dollar (rounded to the nearest dollar) 

N -No rounding (exact amounts including 2 decimals are shown) 

 

 

4. Budgets/Comps? 

Budgets or comparatives can be printed on any profit and loss statement, balance sheet, or 

supporting schedule. Comparatives can be printed on any Source and Application of Funds 

(SAF) statement, but not budgets. Neither budgets nor comparatives can be printed on an 

expanded cash flow statement.  



 
General Ledger  Reports 

Samco Power Accounting 15.133 

 
 

If you wish to show variances (below), you must select either budgets or comparatives here.  

 

 

Enter: 

 

 B -Budgets 

 C -Comparatives 
 T -To print last year’s total in the YTD column 

 N -Neither (show neither budgets nor comparatives on the statement) 

 

1 -Special (show net change, balance, budget, and comparative on the   

  statement) 

 

2 -Special (show balance, budget, and comparative on the statement) 

 

3 -Special P&L Only (show actual, budget, variance, and comparative for   

  current period with ratios and percentages, and show actual, variance,   

  and comparative for year to date, also with ratios and percentages) 

 

4 -Special P&L Only (show actual, budget, and comparative for both 

current period and year to date – no ratios or percentages) 

 
 
 

NOTE: Budgets or comparatives are printed on the right-hand side of the Financial 

Statement. 
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5. Ratios/Variances? 

You may show ratios, selected ratios, or variances on the statement. Enter either: 
 

 N -Show neither ratios, selected ratios, nor variances 

 V -Show variances 

 R -Show ratios (appears only for P&L formats) 
 S -Show selected ratios (appears only for P&L formats) 

 

If you choose “selected ratios”, enter up to 9 selected ratios or use the [F1] option: to show “All” 

selected ratios. 
 

Ratios and selected ratios are shown only on profit and loss statements or profit and loss 

supporting schedules. 

 
 

NOTE: The G/L layouts have a ratio feature.  The layout has to have Start Ratio/End Ratio pair 

to add up a ratio basis.  Then the specification might have to specify yes to showing ratios, but 

the statement should then show the ratio percentage of the current balance vs the 
basis.   Normally, done on income statements, set the basis (with Start Ratio thru End Ratio) as 

being total of the sales accounts.  Then the costs are a percent of sales, and the sales are a percent 

of sales. 

 
 

Variances are shown only if either budgets or comparatives are selected in field 4 above. 

 

If field 4 is set to either 1,2,3 or 4, this field defaults to “n/a” and cannot be changed. 
 

 

NOTE: For SAF Statements and the expanded cash flow statement, neither ratios, selected 

ratios, nor variances are allowed. 
 

 

6. Print Next Run? 

This determines if the Financial Statement for this specification will be printed the next time 

statements are run. Answer Y or N. 
 

 

Section/Group Selection 

The number of times you are prompted in the next set of prompts depends on how your G/L 

accounts are structured. For example, if you have a 3-section account number, you will be 
prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 
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From the section prompt, press [F1] to select “All” values for this account section, OR: 
 

[F2] -To select a specific section value. This is most useful when selecting a 

 selection which may have multiple accounts with the same section. 

 
  [F3] -To select a section group. For more information on sub-account  

   groups, see the Chapter titled Sub-Account Groups. 

 

 

Clearing Selections 

Select Reports>Print Financial Statements> Set up specifications > Clear selections. 

 

Use this selection to set the “PRINT NEXT RUN?” field to N for all specifications on file. All 

specifications will then be set so that none will be printed on the next print run. 
 

 

Generalized Selection 

Select Reports>Print Financial Statements> Set up specifications >Generalized selection. 

 
This function allows all specifications (or any group of specifications) to be selected for printing 

without having to change each “PRINT NEXT RUN?” answer Y, one by one, in field 6 of Enter 

specifications. 

 
 

[?] 1. Starting Specification # 

[?] 2. Ending Specification # 

Enter the range of specifications to select for printing. Follow the screen instructions. 

 

Section/Group selection 
 

The number of times you are prompted in the next set of prompts depends on how your G/L 

accounts are structured. For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 
or twice respectively. 

 

From the section prompt, press [F1] to select “All” values for this account section, OR: 

 
 

[F2] -To select a specific section value. This is most useful when selecting a 

selection which may have multiple accounts with the same section. 

 
[F3] -To select a section group. For more information on sub-account groups, 

see the Chapter titled Sub-Account Groups. 
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Printing a Specifications List 
 
Select Reports>Print Financial Statements> Set up specifications > Print specifications List. 

 

Use this list to verify the specifications you have entered for the statements. A screen appears for 

you to enter the starting and ending numbers of the specifications to be printed.  
 

 

[?] 1. Starting Specification # 

[?] 2. Ending Specification # 

Enter the range of specifications to be printed. Follow the screen instructions. 

 
 

Printing Financial Statements 
 

This function prints the Financial Statements you selected. 

 

If you want to print statements for a different accounting period, you must change the 
“REPORTING PERIOD” through Accounting periods. 

 

Select Reports>Print Financial Statements. You can print the Financial Statements to paper or to 

PDF, select where to print from the printer screen selection pop up window. 
 

Next, a screen appears for you to choose whether to print the date, time, and /or page number, on 

the Financial Statements. If you are printing the statements (rather than displaying them), you 

may also choose whether to print the Report number on them and how many lines. 

 

 

 

1. Starting Date?    

F1 for Earliest, or Enter Date of your Choice 

 

2. Ending Date?   

Enter the ending dates of the Reports or press [F1] to enter default dates and set the rest of the 

fields to N. [F2] will enter the default dates and set the rest of the fields to Y. 

 

 

3. Print Date? 

Answer Y to print today’s date on the statements, OR: 

  

  [F1] -To set all fields to N 
  [F2] -To set all fields to Y 

 

 

4. Print Time? 

Answer Y to print the time of printing on the statements. 
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5. Print Page #? 

Answer Y to print the page number on each statement page. 
 

 

6. Print Report #? 

This field only appears if you selected to print to disk or on a printer, rather than display. 

 
Answer Y if you want to assign a Report number to each statement printed. 

 

 

7. Lines Per Page 

Enter the number of lines per page, press [F3] to default to 60, or press [F1] to set to   

 “Unlimited”. 

 
 

Recalculating Balances 

If the reporting period is the same now as it was the last time statements were printed, you will 

be asked if you wish to recalculate account balances. Answer Y or N, as appropriate. 
 

You will want to recalculate the balances if you are printing Financial Statements again for one 

of these reasons: 

• One or more account balances were incorrect when statements were printed, or 

• New entries have been posted,   

• Budgets or comparatives have changed  

 
If no amounts have changed, there is no need to recalculate the balances. 

There might be considerable amount of processing time required to recalculate account balances, 

so you should avoid doing it more often than necessary. 
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**IMPORTANT NOTE** 

 

There are some basic rules in Samco G/L regarding the printing of BSNI (Balance Sheet Net 

Income). BSNI is the code which you include on your Balance Sheet layout in order to print the 
net profit (or loss) for the period. The rules regarding BSNI are as follows: 

 

 

NOTE: Financial Statements for a New Year will not be able to be generated until the prior 

year-end is closed.  You will get a programming error.  
 

 

• Whenever Financial Statement printing begins (by selecting Print Financial Statements), 
BSNI is set by the software to be the total NET PROFIT (or LOSS) for all profit and loss 

entries on the file. The  

• BSNI is set to be the total NET PROFIT (or LOSS) whether or not you specified account 

balances are to be recalculated. 
• The BSNI which is set at the beginning of Financial Statement printing should be used to 

show NET PROFIT (or LOSS) on the Balance Sheet for the entire Company. 

• Whenever a P&L or a supporting schedule for a P&L statement is printed, BSNI is set to 

the last amount printed on the statement. 
 

 

Printing the Balance Sheet for the Entire Company 
 
To print the Balance Sheet for the entire Company, you would first set up a Financial Statement 

specification for a balance sheet layout. 

 

On this specification, you would enter “All” for the sub-accounts to be included when printing 
the layout. 

 

If this specification is printed first when Financial Statement printing begins, then the BSNI code 

on the balance sheet layout will be replaced by the NET PROFIT (or LOSS) for the entire 
Company. 

 

If you do not print the Balance Sheet for the entire Company as the first statement printed, then 

you must ensure that the Profit and Loss Statement for the entire Company is printed just prior to 
printing the Balance Sheet. This is because of the rule above.  

 

If you do not do this, then the NET PROFIT (or LOSS) shown on the Balance Sheet will be 

incorrect, and the Balance Sheet will not be in balance.  
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Printing the Balance Sheet for a Sub-Account (or Sub-Account Group) 
 
To print the Balance Sheet for a specific sub-account (or sub-account group), first set up a 

Financial Statement specification for a profit and loss statement layout. 

 

On this specification, you would enter the specific sub-account (or sub-account group) to be 
included when printing the layout. 

 

Then set up a financial specification for the Balance Sheet to be printed for the same sub-account 

(or sub-account group). This specification should be numbered so that it is the next specification 
after the Profit and Loss Statement described above. 

 

Select both of these specifications to be printed at the same time. 

 
By printing the Profit and Loss Statement first, followed immediately by the Balance Sheet, 

BSNI will be set to the proper value (at the time the Profit and Loss Statement is printed) for use 

on the Balance Sheet. 

 
For example, a correct sequence for printing would be: 

 

1. Profit and loss statement (for “All” sub-accounts) 

2. Balance sheet statement (for “All” sub-accounts) 
3. Profit and loss statement (for sub-account 100) 

4. Balance sheet (for sub-account 100
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Chapter 16 - Correcting Entries 
 

 

This software includes provisions for creating the Expanded Cash Flow Statement (FASB 95 

Cash Flow Statement).  FASB 95 means the 95th official statement of the Financial Accounting 

Standards Board. 

 

In order to handle the requirements for this statement, correcting ledger entries must be labelled 

as such.  A correcting entry is a ledger entry which has been made to correct an earlier ledger 

entry which is in error. 

 

For example, let us assume that the following debit and credit have been entered and posted: 

 

DR Accounts Receivable $100 

CR Sales    $100 

 

After posting, you discover that the amount should have been $50. 

In this case, you would enter and post the following: 

 

DR Sales $50 

CR Accounts Receivable  $50 

 

However, the above two ledger entries must be marked as correcting entries to indicate 

that they are not the result of a business transaction.   

 

If they are not marked as correcting entries, then your books can give the appearance that 

the volume of business being done (as reflected in the gross debits to your A/R account) is 

larger than that which has actually occurred. 
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There are two methods by which entries can be labelled as correcting entries: 

 

1) When entering either a General Journal Transaction, a transaction in another Package 

(A/R, A/P, PR, I/C), an order in O/E, or an Invoice in P/I, you may specify that the 

transaction, Order, or Invoice is a correcting entry.  If you wish to do this, then answer Y 

to "Allow Correcting Transactions ?"  In this case, when correcting entry transactions are 

posted, the debits and credits generated by the transactions will be marked as "correcting 

entries" and will appear as such in the General Ledger Transaction File (which is the file 

within G/L that contains all of the debits and credits for your Company.) 

 

If you answer Y, you may also use the Correcting Entries selection within G/L to mark entries as 

correcting entries, as described below. 

 

2) After debits and credits have been posted to the General Ledger Transaction File within 

G/L, you may mark individual debits and credits as correcting entries, using the selection 

Correcting Entries.  This selection is discussed in the Chapter titled Correcting Entries.   

 

If you wish to allow correcting entries to be made only through the Correcting entries 

selection, then answer N to "Allow Correcting Transactions ?"  When selected you will not 

be able to specify that individual transactions within G/L or other Samco Packages are able 

to generate correcting entries. 

 

NOTE: Debits and credits generated by other Samco Packages must be transferred to G/L using 

the selection Get Distributions before they can be marked as correcting entries using the 

Correcting Entries selection.   

- See the Chapter titled Get Distributions in this Manual.)  

-  

- Consult with your accountant to determine which of the above methods is most 

appropriate for your business. 

 

Use this selection to view all activity for a specific G/L account within a specified range of dates 

and label selected entries as "correcting entries".  

 

The software contains provisions for creating the Expanded Cash Flow Statement.  In order to 

handle the requirements for this statement, correcting entries must be labelled as such. 

 

This selection is similar to View Accounts but has been separated out so that it can be 

password-protected. You may wish to assign a password to this selection so that correcting 

entries may only be made by authorized personnel. 

 

NOTE: Amounts of entries marked as "correcting entries" are subtracted from the appropriate 

debit or credit amount before the summary debit or credit amount is calculated.   

 

For example, if an asset account has a debit entry for $100 and also has a credit entry (marked as  

a "correcting entry") for $10, the summary entry is a debit for $90.  
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To Begin > -Select Set correcting entries from the G/L Menu. On the screen displayed enter the 

following: (flag has to be set to allow correcting entries)  

 

[?] 1. Account # 

Enter the G/L account that you want to correct, or use press [F1] to scan through accounts with 

posted entries  

 

If [F1] does not bring up an account you expected to see, you can confirm that there are no 

entries by entering the account number directly. If there are no entries, you are informed of this. 

 

 

2. Starting Date 

The starting date does not have to be the starting date of an accounting period. Enter a date, OR: 

 

  [F1]  -For the "Earliest" date on file 

 

[Enter] -To use the starting date of the current period 

 

If you enter the earliest date on file, the first entry shown would be the balance brought forward 

(BBF) entry, which you previously entered in either Set-up procedures or Close a year. 

 

 

3. Ending Date 

The ending date does not have to be the ending date of an accounting period. Enter a date, OR: 

 

  [F1]  -For the "Latest" date on file 

 

[Enter] -To use the ending date of the current period 

 

Up to 14 entries can be shown on the screen at once. If there are more than 14 entries, you can 

use the PgUp, PgDn and Arrow keys to move around,  OR: 

 

  [F1]  -To see the source and document number instead of  

  the reference and Journal number 

 

  [F2]  -To return to selecting an account 

 

Y or N  -To change the “correcting entry” status for the 

 highlighted line. (See Control Information Chapter.) 

 

 [F6]  -To view or enter any notes for this G/L account 

 

There is no limit to the number of pages that may be viewed when paging forward. However, 

you are restricted to viewing just the previous 9 pages. (You cannot “backup” more than 9 

pages.) On the screen containing the last entry on file, the beginning balance, total debits, total 

credits, net change and ending balance are shown.  
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Using Notes 

If you press [F6], you may enter an unlimited number of notes about the account being 

displayed. Each note is given a date/time stamp so that you can scan through the notes in time 

sequence later. 

 

This selection uses Samco’s text editing function. You enter text in much the same way as most 

word processing programs. When you are finished entering text, press [Esc] and follow the 

screen instructions. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

 

File Options: 

 

File -Save what I have just entered/changed, clear the screen, and get ready for 

another note. (Like pressing [Enter] at “Field number to change?” in other 

selections.) 

 

Save & Continue -Save what I have just entered/changed but leave the information on the 

screen because I want to continue to work with it. 

 

Abandon Changes -Throw away what I have just entered/changed and get ready for a new 

note. 

 

Delete -Delete this entire note from the data file and clear the screen to get ready 

for another note. (Like Delete in other selections.) The software will ask 

you to confirm the deletion with an “OK to delete?” message. 

 

[Esc]   -To Exit when done 
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Chapter 17 - Texts 
 

 

Use this selection to enter texts.  Texts are instructions or explanatory information which you 

want to appear on your Financial Statements.  Texts are used for footnotes, accountants' 

opinions, cover sheets, headers, and the like.    

 

The texts entered here are later selected by "text number" to appear on specific Financial 

Statements, supporting schedules, and source and application of funds (SAF) statements.  This 

selection process is described in Financial Statement layouts.   

 

 

To Begin 

Select Texts > Enter from the second page of the G/L Menu. 

 

A screen appears for you to enter a text number and a description of the text. 

 

You can work with both new and existing texts.  If a text has already been entered for the text 

number you specify, it will appear and be available for changes or deletion. 

 

 

[?] * Text # 

Enter the number which identifies this text, OR: 

 

 [F1]  -To scan through the texts on file. 

 

Description 

Enter the description of the text (this is not the actual text, just something to identify it for you).   

 

Make any changes as usual.  
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A screen appears for you to enter the text: 

 

This selection uses Samco's text editing function.  You enter text in much the same way as most 

word processing programs.  When you are finished entering text, press [Tab] and follow the 

screen instructions. 

 

To centre a line, move to that line then press [F6]. Note that the text is centred with respect to the 

Financial Statement on which it will be printed, not with respect to the screen on which it now 

appears. 

 

If you wish to use the more powerful text editing commands which are included in this editor, 

see the appendix titled Text Editing. 

 

When you are finished editing text, press [Tab] to display the File Options Menu: 

 

File   -Save what I have just entered/changed, clear the screen, and get ready for 

another note.  (Like pressing [Enter] at "Field number to change?" in other 

selections.) 

 

Save & continue -It will save what has just been entered/changed but will leave the 

information on the screen because I want to continue to work with it. 

 

Abandon changes -Throw away what I have just entered/ changed and get ready for a new 

note.  (Like pressing [Esc] at "Field number to change?" in other selections.) 

 

Delete   -Delete this entire note from the data file and clear the screen to get ready 

for another note. The software will ask you to confirm the deletion with an 

"OK to delete?" message. 

 

[Tab] -To Exit. 

 

 

Printing Texts 

 

Select Print text list from the Texts Menu of the G/L Menu. 

 

 

[?] 1. Starting text # 

[?] 2. Ending text # 

Enter the range of text numbers you wish to print. Follow the screen instructions
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Chapter 18 Financial Statement Layout 
 

 

This Chapter, and the next three, describe how to produce Financial Statements.  

 

This Chapter describes the first step in producing Financial Statements:  entering a layout, or 

format, to control the content and appearance of each Financial Statement. GL > Reports >  #2 -

Print Financial Statements  ( or if setting up specifications) #1 – Set-up Specifications.  

 

Topics covered include: 

• How to lay out a Financial Statement line by line;  

• How to print an edit list showing your layout;  

• How to print a sample Financial Statement to see the result; 

• How to verify a layout; and 

• How to re-sequence a layout 

 

The next Chapter, Building Financial Statement Layouts, is a step-by-step procedure to use in 

building a layout. 

 

The Chapter, Copy Layouts/Make SAF Layouts, describes: 

 

• How to create an additional layout by copying an existing one; 

• How to add a sub-account to an existing layout;  

• How to create an additional layout with a new sub - account; and 

• How to automatically create Source and Application of Funds (SAF) layouts 

 

The final Chapter on this subject, Financial Statements, describes: 

 

• How to enter specifications for customizing statements so that many different Financial 

Statements can be generated from any one layout; 

• How to print a list of specifications; 

• How to select statements to print and 

• How to print Financial Statements.  
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Financial Statement Layouts 

Financial Statement "layouts" are sets of parameters which you enter to specify the exact format 

in which statements are printed.  For each type of Financial Statement, you enter two kinds of 

parameters: 

 

• Account numbers, to specify which accounts should print where. 

 

• Functions which "put a blank line here" or "print a total here", to control all aspects of the 

statement's appearance. 

 

The Financial Statement layouts selection is for Users who understand P&L statements and 

balance sheets well.  As needed, we suggest you consult someone who is very familiar with such 

Financial Statements. 

 

Of the various "special" G/L statement formats you can specify in the budget/comparative flag of 

the specification record, only the P&L special formats use the wide format - but all of them do, 1 

thru 4.   

 

Extra information – Specification reports 1 through 4: 

1 = 180 columns (out of 220) 

2 = 180 columns (out of 220) 

3 = 220 columns (out of 220) 

4 = 138 columns (out of 220) 

 

Some other Reports that do 220 columns: 

 

Real profitability report":  

Inventory and Sale Synopsis 

Production report".  

Processed Tire Report". 

Employee Production Worksheet" 

Job status summary report    ".: " 

Production Report 

"Project progress":  

Stock supply analysis report":  

Open orders report". – 

User defined report".: 

Monthly activity analysis". 

Payroll report".: "Herring report".  
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How This Chapter is Organized 

 

1. The statements you can produce are listed. 

 

2. The types of layouts to produce these statements are shown. 

 

3. The screen and fields you use to enter the layouts are described. 

 

4. Printing accounts, using account numbers, sub-account numbers, and features such as 

"wild-cards" and account ranges are described. 

 

5. The functions which are common to all kinds of layouts are described.   

 

6. The features of "profit and loss format" layouts are described, along with functions used only 

with them. 

 

7. The features of "balance sheet format" layouts are described, along with the function used 

only with them. 

 

8. How to print an edit list of the layout is described. 

 

9. How to print a sample Financial Statement based on the layout is described. 

 

10. An index to the functions used in layouts is at the end of the Chapter. 

 

 

Financial Statements 
 

You can produce the following types of Financial Statements: 

 

• Profit and Loss Statement 

• Balance Sheet 

• Profit and Loss Supporting Schedule 

• Balance Sheet Supporting Schedule 

• Cash Flow Statement 

• Expanded Cash Flow Statement 

• Analysis of Changes in Working Capital 

• Statement of Changes in Financial Position 
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Types of Layouts 
 

You use a different layout to produce each statement.  The layouts are set up in two formats, 

corresponding to the two major types of Financial Statements:    

 

When setting up a layout, once completed, it is best to verify it. This will make sure that there 

are no errors on it.   

Errors, will prevent the statement from being generated. See ‘Verifying Layouts” for more 

information.  

 

Profit and Loss (P&L) Format   

Balance Sheet Format 

 

Each layout is assigned a code to identify the type of layout as follows: 

 

Code  Layout Type 

 

Profit and Loss Format Layouts 

 

P  -Profit and Loss (P&L) Statement 

S  -Supporting Schedule (P&L format) 

C*  -Cash Flow Statement 

E  -Expanded Cash Flow Statement 

W*  -Analysis of Changes in Working Capital  

 

Balance Sheet Format Layouts 

 

B  -Balance Sheet 

X  -Supporting Schedule (balance sheet format) 

F*  -Statement of Changes in Financial Position 

 

 

* Codes: 
 C, 

 F, 

-W  -Represent the three standard SAF (Source and Application of Funds) layouts.  You can 

also automatically create them from the other layouts.  Refer to Make SAF layouts in the Chapter 

titled Copy Layouts/Make SAF Layouts. 

 
***IMPORTANT NOTE*** 

 

There are some basic rules in Samco G/L regarding the printing of BSNI (Balance Sheet Net 

Income). BSNI is the code which you include on your Balance Sheet layout in order to print the 
net profit (or loss) for the period. The rules regarding BSNI are as follows: 

 

 

NOTE: Financial Statements for a New Year will not be able to be generated until the prior 

year-end is closed.  You will get a programming error.   
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• Whenever Financial Statement printing begins (by selecting Print Financial Statements), 
BSNI is set by the software to be the total NET PROFIT (or LOSS) for all profit and loss 

entries on the file.  BSNI is set to be the total NET PROFIT (or LOSS) whether or not 

you specified that account balances are to be recalculated. 

 
• The BSNI which is set at the beginning of Financial Statement printing should be used to 

show NET PROFIT (or LOSS) on the Balance Sheet for the entire Company. 

 

• Whenever a P&L or a supporting schedule for a P&L statement is printed, BSNI is set to 
the last amount printed on the statement. 

 
 

 

Legend of Codes for Financial Layout  
 

LF -Line feed (skip a line) 

 FF -Form feed (start a new page) 

 UL -Print an underline 

 DL -Print a double underline 

 LEG -Print a predefined legend (heading) 

 TXT -Print text from the Text File 

 LIT -Print a “literal” (a “literal” is a line of text) 

 

Functions used to calculate, print, and clear subtotals 

 

SUB1-SUB9 Print the subtotal for the level specified by the number (1 is the lowest level, 9 the 

highest), then clear the subtotals at the level specified and all preceding lower 

levels 

 

CLS1-CLS9 Clear the subtotal at the level specified and all preceding lower levels, without 

printing a subtotal  

 

Common references: 

 

N -Net change for the reporting period (this is the sum of types D and C 

below). This is the usual balance type for P&L format. This type is 

automatically set for Cash Flow Statement and Analysis of Changes in 

Working Capital. 

  B -Balance as of the beginning of the reporting period. 

E -Balance as of the end of the reporting period (this is the sum of types B 

above and C and D below). 
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Changing the Layout 
 

You can change the order in which they appear or modify the content of each line by using these 

keys shown on the screen: 

 or  Keys  -Will move to the next line 

 

[PgUp] [PgDn]  -Will move you between screens 

 

[Home]   -Moves to the first line of the layout 

[End]  -Moves to the last line of the layout 

 

[F1]   -Will insert a line between two existing lines 

 

[F2]  -Moves or copies a line. Go to the line you want to move or copy 

and press [F2]. Then go to the line below the location where you 

want the line and press [Enter] to move the line, [F1] to insert the 

copy, or to cancel the move/copy. 

 

[F3]   -Will delete the current line. 

 

[F5]  -Displays the next valid account number for the layout. From the 

current position, the previous account line in the layout is found, 

and then the next account after that one in the Chart of Accounts is 

displayed. This allows for rapid creation of new layouts. 

 

[F4]  -Is used to “jump” directly to an account number. Then enter the 

account number. 

 

[Enter]   -Is used to change the current line (except when used in the [F2] + 

[Enter] -Move sequence above). 

 

[F7]   -Gets a Menu of the functions. You can then use the  or  keys to 

highlight the desired function, and then press [Enter] to use it. 

 

[Esc]   -To exit the function when you are done entering the layout, or to 

cancel a change or a move/copy function. 
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General Ledger Headers in Specifications for Financial Statement Layouts  
 

All Financial Statement Layouts have a Header. Which consist of Acct # or Function ; Bal Type ; 

PRT/Accum ; Prt/Col / and Parenthathis control  

-You can follow the prompts at the bottom of the screen when adding accounts etc.  

 

 
 

Layout Screen 
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This screen is used to enter accounts and function codes which control the content and 

appearance of the Financial Statement. 

 

You enter one line for each account or function in the order in which you want to have them 

appear to be performed. 

 

 

Layout Screen Fields 

Each line contains five fields across the screen: 

 

Acct-# or  

Function 

 

The first field is used to enter either a G/L account number or a code standing for a function. 

Account numbers may be entered with a sub-account number, if you use sub-account numbers. 

As described later in the section titled “Printing Accounts”, you may use “wild carding” in the 

sub-account field. 

 

The function codes are described later in this Chapter. 

 

The next four fields on the right are used only when entering an account number or when a 

balance is to be printed. 

 

Bal 

Typ  (Balance type) 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

function                                           Typ   Accum    Col    Cntrl 

This is the type of balance you want to print on this line. The types are: 

For P&L format: 

N -Net change for the reporting period (this is the sum of types D and C 

below). This is the usual balance type for P&L format. This type is 

automatically set for Cash Flow Statement and Analysis of Changes in 

Working Capital. 

  B -Balance as of the beginning of the reporting period. 

E -Balance as of the end of the reporting period (this is the sum of types B 

above and C and D below). 

 

For P&L format (Expanded Cash Flow Statement only): N, B, and E above, and: 

  D -Gross debits for the reporting period. 

  C -Gross credits for the reporting period. 

You may also enter a minus sign to reverse the sign of the printed balance.  
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For Balance Sheet Format: 

 

E -Balance as of the end of the reporting period. This type is 

automatically set for balance sheets and supporting schedules (balance 

sheet format). 

 

N -Net change for the reporting period. This type is automatically set for 

Statement of Changes in Financial Position. 

 

Prt/ 

Accum  (Print/Accumulate) 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

function                                           Typ   Accum    col    Cntrl 

This field asks whether you want an account balance to print on the statement at this point, or 

whether to accumulate (store) this balance and include it in a total to be printed on a subsequent 

line. 

 

The choices are either P (print the balance) or A (accumulate the balance). 

The use of this field is illustrated in the section titled Printing Accounts later in this Chapter. 

 

Prt 

Col     (Print Column) 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

function                                           Typ   Accum    Col    Cntrl 

This field is used only when a balance is to be printed on a balance sheet format and when 

Prt/Accum is “P”. 

 

The balance sheet format has three pre-set column positions in which a balance is printed. Enter 

the number of the column in which you want the balance printed: 1, 2, or 3. 

 

For example, you can use print columns to show totals as follows: 

 
Cash – First National Bank $ 2,000.00 

Cash – First Provincial Bank    1,000.00 

Cash – City Bank & Trust       4,000.00 

Total cash in Bank       $ 7,000.00 

Petty Cash – Dept. 100  $  500.00 

Petty Cash – Dept. 200      300.00 

Total Petty Cash    $  800.00 

Total Cash        $ 7,800.00 

 

 

NOTE: The P&L format does not use this field. 
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Paren Cntrl  (Parentheses Control) 

When printing Financial Statements, it is customary to parenthesize account balances when they 

contain atypical amounts. For example, if an accounts receivable account contained a credit 

balance, it would usually be parenthesized on a Financial Statement. 

 

A parenthesis control code is entered for each account in the Chart of Accounts. The code “D” is 

used to specify that the account is to be parenthesized if it has a debit balance. The code “C” is 

used to specify that the account is to be parenthesized if it has a credit balance. Thus, an accounts 

receivable account would have a parentheses code of “C”; an accounts payable account would 

have a parentheses code of “D”. 

 

When a single account is entered on a layout, the parenthesis control field on the layout line is 

skipped and the parenthesis control contained in the Chart of Accounts record for the account is 

used when printing the Financial Statement. However, when wild-cards are used (to print a set of 

accounts), when a subtotal is to be printed, or when a set of accounts have been accumulated 

together to print one summary balance on the Financial Statement, then you must specify the 

parenthesis control to be used. 

 

The choices for parenthesis control are: 

 

 C -Parenthesize when credit (use if the balance is typically debit) 

 

 D -Parenthesize when debit (use if the balance is typically credit) 

 

NOTE: This field is only entered for these types of Financial Statements: 

 

 

 P&L statement 

 Balance Sheet  

 Supporting Schedule (P&L format) 

 Supporting Schedule (Balance sheet format) 

 Expanded Cash Flow Statement 

 

 

NOTE: On the Expanded Cash Flow Statement, you may enter parenthesis control for a single 

account. The default provided on the screen is from the Chart of Accounts record for the account. 

You may override this as needed. 

 
 

Changing the Layout 

You can change the order in which they appear or modify the content of each line by using these 

keys shown on the screen: 

 or  Keys  -Will move to the next line 

 

[PgUp] [PgDn]  -Will move you between screens 

 

[Home]   -Moves to the first line of the layout  
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[End]  -Moves to the last line of the layout 

 

[F1]   -Will insert a line between two existing lines 

 

[F2]  -Moves or copies a line. Go to the line you want to move or copy 

and press [F2]. Then go to the line below the location where you 

want the line and press [Enter] to move the line, [F1] to insert the 

copy, or to cancel the move/copy. 

 

[F3]   -Will delete the current line. 

 

[F5]  -Displays the next valid account number for the layout. From the 

current position, the previous account line in the layout is found, 

and then the next account after that one in the Chart of Accounts is 

displayed. This allows for rapid creation of new layouts. 

 

[F4]  -Is used to “jump” directly to an account number. Then enter the 

account number. 

 

[Enter]   -Is used to change the current line (except when used in the [F2] + 

[Enter] -Move sequence above). 

 

[F7]   -Gets a Menu of the functions. You can then use the  or  keys to 

highlight the desired function, and then press [Enter] to use it. 

 

[Esc]   -To exit the function when you are done entering the layout, or to 

cancel a change or a move/copy function. 

 

 

Notes on the Examples in This Chapter 

Throughout the remainder of this Chapter, examples are used to illustrate the features of 

Financial Statement layouts. In each example, a layout is shown first, followed by the Financial 

Statement that would result from using that layout. Use these examples to compare the various 

layout function codes with the results they produce. 

 

On the example layouts shown, only fields pertinent to the feature being described are filled in. 

 

On the sample statements shown, horizontal spacing is narrower and amount fields are smaller 

than they would actually appear on a statement. 

 

Some of the main account numbers and sub-accounts used in the examples only illustrate 

features and are not in the Chart of Accounts which we recommend you set up. 

 

We suggest that you review the examples to become familiar with entering accounts and 

functions. When you are familiar with these, for practice you may want to enter the layouts 

printed on the Financial Statement Layout Edit List at the end of this Chapter.  
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Printing Accounts 
 

This section describes how to either: 

o Print accounts, or 

o Accumulate a set of accounts which are to be summarized into one line printed on 

the statement. 

 

  

Single Accounts 

An account balance may be either printed on the statement, or the balance may be accumulated 

(stored) and included in a total to be printed on a subsequent line. As noted earlier, in the 

“Prt/Accum” field, you enter either P (print the balance) or A (accumulate the balance). 

 

 

Printing a Single Account Balance (Prt/Accum = “P”) 

 

If you want an account’s own balance to print, code it with “P” at “Prt/Accum?” 

 

For example, each of the two cash accounts shown below would be printed with its own balance 

on the Financial Statement, if you coded the layout like this: 

 

 

Layout Entered (Balance Sheet Format): 
Acct-# or                                           Bal     Prt/      Prt     Paren 

Function      Typ Accum   Col     Cntrl 

 
1040-100 Petty Cash – Dept. 100       P      1 

1040-200 Petty Cash – Dept. 200       P            1 

 

 

Resulting Statement: 
Petty Cash – Dept. 100  $ 500.00 

Petty Cash – Dept. 200    300.00 

 

 

 

Accumulating Account Balances (Prt/Accum = “A”) 

 

Often you may want to accumulate the balances from several accounts and print only the total 

balance as a summary amount. To do so, code the accounts to be accumulated with an “A”. The 

balance of each account coded with an “A” is added to an “accumulator”. This accumulator is a 

storage location which contains the total of all accounts which have been coded with an “A”. To 

print (and clear) the accumulated total, use the PAT code: 
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PAT (Print Accumulated Total) 
 

This code will print the total of a set of account balances which you accumulated (“Prt/Accum = 

“A” above). Financial Statement layouts support up to 9 PATs within a single layout.  

 

In other words, “PAT” summarizes the accounts which were coded “A” (accumulate). 

 

Option to use F4 to "Auto-Accum or Auto-PAT"  

 

1. If you enter an Account, (whether you wild-card the profit center or not), the 

field for print/accum has an F4 option to "auto-accum". 

  

 This will set the print/accum flag to A, then add a PAT on the next line, using the 

text from the account's description and the "enclose when credit" option will be set 

from the account as well. 

 

2. At the main entry field, were you put in Account numbers or operators, Use the 

F4 Key Function to =Auto-PAT function.   

 

If you pick that, the system will ask for starting and ending account numbers.  Once 

you enter them, the system will look for all accounts in that range, and grab the 

"main" section value, and wild-card the rest (ie the profit center).  The account will be 

set to A for accumulate, and a PAT line will be added immediately afterward. 

 

 

 
 

 



General Ledger                                  Financial Statement Layout 

Samco Power Accounting  18.159 

 
 

 

 

Accumulated balances (Prt/Accum = “A”) that are not followed by a PAT will not be printed or 

have their balances included in subtotals on the statement.  

 

  

NOTE: You may accumulate accounts and then print them by entering the accumulated 

accounts followed by a single account with a “P” code instead of a PAT. The total of the 

accumulated amounts, plus the account marked with the “P”, will be printed as the account 

balance for the account marked with the “P”. This method of accumulating accounts is allowed, 

but not recommended. An example of the drawbacks of this method is given later in this Chapter. 

 

(After you enter the PAT code, a field appears for printing accounting ratios. If no accounting 

ratios are to be printed on the statement, leave this field blank. See the section titled “Accounting 

Ratios” later in this Chapter.) 

 

 

  



General Ledger                                  Financial Statement Layout 

Samco Power Accounting  18.160 

For a PAT code, [Printed Accumulated Total] “Parentheses control” is requested for these 

layout types: 

 

• P&L Statement 

• Balance Sheet 

• Supporting Schedule (P&L format) 

• Supporting Schedule (balance sheet format) 

• Expanded Cash Flow Statement 

 

Enter D or C, as appropriate. If the statement is a balance sheet format (Balance Sheet, 

Supporting Schedule, or Statement of Changes in Financial Position), a “Print column” is 

requested. Enter 1, 2 or 3. 

 

 

NOTE: A similar function (PATR-Print accumulated total for dollar rounding) is described in 

the section titled “Balance Sheet Format”. 

 

 

Layouts with Multiple Sub-Accounts 
 

When printing Financial Statements, it is often desirable to first print the Financial Statement for 

all sub-accounts and then print the same Financial Statement again. On the second printing, the 

accounts printed are restricted to be accounts which have all the same sub-account number. 

 

For example, if sub accounts are used to distinguish profit centres, one can print the P&L for all 

profit centres considered together, followed by a P&L for just the first profit centre. One can 

continue to print the same Financial Statement for each of the individual profit centres (or even 

for a set of profit centres considered together as a group). 

 

If you plan to print Financial Statements as described above, then when accumulating accounts 

together, you must code them using PAT, (printed accumulated total) as illustrated in the 

following example: 
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Layout Entered (P&L Format Layout) Screen Shot Example: 

 

 
 

 

Incorrect Handling of Sub-Accounts 

 

- You should avoid summarizing one sub-account into another sub-account. The 

following example is an incorrect handling of sub-accounts: 

 

Layout Entered (P&L Format Layout): 

 
Acct-# or                                            Bal    Prt/      Prt    Paren 

Function                                             Typ   Accum  Col    Cntrl 

 

 LEG 

 8300-100 Utilities       N      A 

 8300-200 Utilities       N      P 

 6050-100 Travel Expenses       N      A 

 6050-200 Travel Expenses      N      P 

 

If you select this layout for sub-account 100, totals will not be printed for the Utilities or 

Travel Expenses accounts, since the “P” (print) accounts use sub-account 200, not 100. 

 

Resulting Statement: 

 

   Reporting-Period   Year to date 

        Amount         Amount 
 

(The Statement is blank) 
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Zero-Balance Accounts and PAT Codes (printed accumulated totals) 
 

When coding a statement for multiple sub-accounts, you can take advantage of the fact that an 

account or PAT with a zero balance or net will not be printed on the Financial Statement. 

 

For instance, if you have an expense which does not occur for a particular sub-account, you can 

still accumulate all the sub-accounts into a PAT. Then for the sub-account that does not have that 

type of expense, the net of the PAT will be zero (when printing the layout for just that sub-

account) and the PAT code will not print at all on the statement. 

 

Layout Entered (P&L format Layout): 

 
Acct-# or                                             Bal    Prt/        Prt     Paren 

Function                                             Typ   Accum    Col    Cntrl 

 
 LEG 

 8300-000 Utilities        N        A 

 8300-100 Utilities        N        A 

 8300-200 Utilities        N        A 

 8300-300 Utilities        N        A 

 8300-400 Utilities            N        A 

 PAT      Utilities                                             C 

 6050-000 Travel Expenses        N        A 

 6050-100 Travel Expenses        N        A 

 6050-200 Travel Expenses                             N        A 

 6050-300 Travel Expenses                        N        A 

 6050-400 Travel Expenses                               N      A 

 PAT      Travel Expenses                            C 

 

Assume that the accounts have the following nets for the reporting period and year to date: 

 

   RPT YTD     RPT YTD 

8300-000  $200 $500  6050-000  $550 $800 

8300-100  $400 $600  6050-100  $700 $900 

8300-200  $300 $900  6050-200  $100 $200 

8300-300  $0 $0  6050-300  $450 $700 

8300-400  $150 $200  6050-400  $500 $800 

 

If you select this layout for sub-account 300, you get: 

 

 

Resulting Statement: 

   Reporting-Period   Year to Date 

         Amount        Amount 

 

Travel Expenses  450.00       700.00  



General Ledger                                  Financial Statement Layout 

Samco Power Accounting  18.163 

Wild-Carded Accounts 
 

The purpose of a wild card is to reduce the number of entries required to create a layout. 

 

“Wild Cards” are symbols which can be entered where sub-accounts appear to stand for several 

individual sub-accounts. 

 

For example, assume you use the following accounts in the Chart of Accounts: 8300-000, 8300-

100, 8300-200, 8300-300, and 8300-400. 

The symbol “*”, is used to replace a specific value. You would put the symbol “*” at any digit in 

the account number which you wanted to include all values for. 

 

 

Examples of Wild-Carded Accounts: 
 

8300-*** would include all accounts beginning with 8300, regardless of the value for the second 

account number section (usually department or profit centre.) 

 

8300-1** would include all accounts beginning with 8300, and all accounts whose second 

account section begins with a “1”. 

 

8*00-*** would include all accounts which matched the “mask”. Almost all 8000 series 

accounts would be included in such a line. 

For example, assume that these accounts have these net for the reporting period and YTD: 

 

   RPT YTD     RPT YTD 

8300-000  $200 $500  6050-000  $550 $800 

8300-100  $400 $600  6050-100  $700 $900 

8300-200  $300 $900  6050-200  $100 $200 

8300-300  $0 $0  6050-300  $450 $700 

8300-400  $150 $200  6050-400  $500 $800 

 

Layout Entered (P&L Format Layout): 

 

Acct-# or                                            Bal    Prt/       Prt     Paren 

Function                                             Typ   Accum    Col     Cntrl 
 LEG 

 8300-000 Utilities        N      A 

 8300-100 Utilities        N      A 

  

8300-200 Utilities        N      A 

 8300-300 Utilities        N      A 

  

8300-400 Utilities            N      A 

 PAT      Utilities                                               C 

 6050-000 Travel Expenses          N      A 

 6050-100 Travel Expenses          N      A 

   

6050-200 Travel Expenses                               N      A 

 6050-300 Travel Expenses                           N      A  
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 6050-400 Travel Expenses                       N      A 

  

PAT      Travel Expenses                            C 

 

 

The above layout can be replaced by this layout 

 
 LEG 

 8300-*** “Multiple accounts”        A 

 PAT Utilities             C 

 

 6050-*** “Multiple accounts”       A 

 PAT Travel Expenses            C 

 

Either layout, printed for “All” sub-accounts, results in: 

 

Resulting Statement: 

 

   Reporting-Period   Year to Date 

         Amount         Amount 

 

Utilities        $1050.00     $ 2200.00 

Travel Expenses         2300.00                 $ 3400.00 

 

 * stands for all values for the specified digit(s) of the account numbers in the chart of accounts. 

 

 

Other Wild-Card Symbols 

The other wild-card symbols and their effects are: 

 

+ stands for all sub-accounts except -000. 

 

Assuming the same sub-accounts and balances as the previous example, this layout: 

 

Layout Entered (P&L Format Layout): 

Acct-# or                                            Bal    Prt/          Prt      Paren 

Function                                              Typ    Accum    Col     Cntrl 

 
 LEG 

 8300-+ Utilities              A 

 PAT Utilities             C 

 

 6050-+ Travel Expenses                A 

 PAT Travel Expenses            C 

 

Results in this, printed for “All” sub-accounts: 
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Resulting Statement: 

   Reporting-period   Year to Date 

         Amount          Amount 

 

Utilities        $ 950.00       $1700.00 

Travel Expenses        1750.00          2600.00 

 

In other words, the balances from accounts 8300-000 and 6050-000 are not included. 

 

 

NOTE: Number(s) or character(s) followed by “?” s mean all sub-accounts beginning with the 

number(s)/character(s) entered. 

 

 

For example, if your two section G/L account number used 3-digit sub-account numbers, 

accounts 4000-500, -510, -520, -530, and -540, could be entered as 4000-5?? to stand for all 

those accounts. 

Another example would be if the third section of your 4 section G/L accounts were 4 characters, 

you could enter 6000-RET-PQ01-ADM, - PQ02-ADM, -PQ03-ADM, and PQ04-ADM as 6000-

RET-PQ?? to represent all accounts. 

 

 
Other Uses of Wild-Cards 

Wild-cards are used in other ways besides with PAT’s. For instance, if you enter PRT/Accum = 

“P” on the line that has the wild card, then the accounts matching the wild card will be printed. 

 

For example, 8300-* would print 8300-000, -100, -300, and -400. 8300-+ would print 8300-100, 

-200, -300, and -400. 

 

Or, 6000-RET-PQ01-* would print 6000-RET-PQ01-ADM, 6000-RET-PQ01-ADV, 6000-RET-

PQ01-LBR, and 6000-RET-PQ01-OPR. 

Use of + 

 

This wild-card character has been included to allow you to exclude accounts with sections (sub-

accounts) which are either all zeros or spaces or contain trailing zeros or spaces. 

 

Example #1:  

Your G/L account number consists of two sections (####-###) both numeric. You have set up 

the second section as your profit centre with section value 000 defining the master profit centre, 

and 100, 200, 300, and 400 as the remaining profit centres. By entering the account 4000-+00, all 

of the profit centres will print except for 000. 
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Example #2:  

Your G/L account number consists of two sections (XXXX-XXXX) both alpha-numeric. You 

have set up the second section as your profit centre with a blank section value defining head 

office. By entering the account 4000-++++, all of the profit centres will print except for the blank 

one. 

The “+” character is useful if you need to construct a P&L layout which excludes a zero or blank 

sub-account section. This can occur if you have a few P&L accounts which use a zero or blank 

sub-account while the remainder of the P&L accounts use sub-accounts which are non-zero 

/blank. 

 

 

Account Ranges (RNG) 
 

An “account range” refers to a set of accounts which you specify by entering the starting and 

ending account section values. 

 

The purpose of entering a section or account range is to reduce the number of entries required to 

create a layout. 

 

Account ranges may be used with or without wild-cards in any of the sections. During entry of 

the account range, you may either enter a single sub-account number or use a wild-card. 

 

For example, suppose you want the layout to include only the –HQ accounts from this set: 

 
1100-HQ Accounts Receivable – Dept. 1 

1100-AB Accounts Receivable – Dept. 2 

1100 –SK Accounts Receivable – Dept. 3 

1100-MB Accounts Receivable – Dept. 4 

1200-HQ Merchandise Inventory 

2000-HQ Accounts Payable – Dept. 1 

2000-AB Accounts Payable  – Dept. 2 

2000-SK Accounts Payable     – Dept. 3 

2000-MB Accounts Payable     – Dept. 4 

 

You could enter a range of accounts: 
 

RNG Beg 1100 Sub Acct   HQ 

 End 2000 Sub Acct   HQ 

This would stand for accounts 1100-HQ, 1200-HQ, and 2000-HQ. 

 

 

Account Ranges with Wild-Cards 

Wild cards can be used to allow sub-accounts under a main account.  

 

You can also use ranges and wild-cards together to reduce the number of entries required. The 

accounts shown above could all be included in the layout if you entered: 
RNG Beg 1100 Sub Acct * 

 End 2000   



General Ledger                                  Financial Statement Layout 

Samco Power Accounting  18.167 

Functions Common to All Statements 
 

Many functions can be used on all types of statements. They are described here, and the resulting 

appearance of the Financial Statement is shown. They are described in this order: 

 

Functions used to lay out text 

 

 LF -Line feed (skip a line) 

 FF -Form feed (start a new page) 

 UL -Print an underline 

 DL -Print a double underline 

 LEG -Print a predefined legend (heading) 

 TXT -Print text from the Text File 

 LIT -Print a “literal” (a “literal” is a line of text) 

 

Functions used to calculate, print, and clear subtotals 

 

SUB1-SUB9 Print the subtotal for the level specified by the number (1 is the lowest level, 9 the 

highest), then clear the subtotals at the level specified and all preceding lower 

levels 

 

CLS1-CLS9 Clear the subtotal at the level specified and all preceding lower levels, without 

printing a subtotal  

 
 

Entering Common Functions 

In this section, each of the common functions is described. 

 

Text Functions 
 

LF  (Line Feed) 

“LF” causes on or more lines to be skipped on the statement, depending on how many lines you 

specify. 

 

FF  (Form Feed) 

“FF” causes a new page to be started. 

 

UL  (Underline) 

“UL” causes an underline to be printed. For a balance sheet format, you specify in which column 

it is to appear: 1, 2, or 3. 

 

DL  (Double Underline) 

“DL” causes a double underline to be printed. For a balance sheet format, you specify in which 

column it is to appear: 1, 2, or 3.  
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LEG  (Legend) 

The LEG code causes a predetermined legend to be printed on the Financial Statement. One line 

is skipped after the legend, so that a LF (line feed) following is not necessary. 

 

For Balance sheet format statements, LEG prints the current period ending date. 

 

For P&L format statements, LEG prints a description of the current period, column headings, 

and (if used) a description of the sub-account or sub-account group for which this statement is 

being printed. 

 

 

Using LF, UL, DL and LEG 

 

The layout entries shown next (for a P&L format statement) and the resulting statement illustrate 

the use of LF, UL, and LEG. 

 

NOTE: This example uses subtotals in a simple fashion. Subtotals are described in detail later in 

this Chapter. If needed, you can refer to the section on subtotals in order to fully understand this 

example. 

 

Layout Entered (P&L Format Layout): 

   
Acct-# or                                           Bal      Prt/        Prt        Paren 

Function                                            Typ    Accum    Col      Cntrl 
 

 LEG 

 4010-100 Sales – Tools        N           P 

 4010-200 Sales – Tools         N          P 

 UL 

 SUB1  Total sales tools          D  When debit ( )  

 LF  01 

 4020-100 Sales – Parts         N             P 

 4020-200 Sales – Parts                 N             P 

 UL 

 SUB1  Total Sales Parts          D 

 LF  01 

 4030-100 Sales – Services           N           P 

 4030-200 Sales – Services             N           P 

 UL 

 SUB1  Total Sales Services         D 

 DL 

 SUB2  Total Sales           D 

 

The resulting statement would appear similar to this: 
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Resulting Statement: 
    For the period 04/01/20 to 04/30/20 

 

    Reporting – Period  Year-to-Date 

            Amount      Amount 

 Sales – Tools  $  4,000.00   $  15,000.00 

 Sales – Tools     3,000.00      10,000.00 

 Total Sales Tools  $  7,000.00   $  25,000.00 

 

 Sales-Parts  $  9,000.00   $  17,000.00 

 Sales-Parts      5,000.00       14,000.00 

 Total Sales Parts  $ 14,000.00    $ 31,000.00 

 

 Sales – Services  $  6,000.00   $  12,000.00 

 Sales – Services                2,000.00         4,000.00 

 Total Sales – Services $  8,000.00   $  16,000.00 

 Total Sales  $29,000.00   $  72,000.00 

 

TXT  (TEXT) 

 

 

This prints the text you specify from the Text File (see the Chapter titled Texts). On the layout 

entry screen, the text description is displayed next to the text number you enter, but what will 

print on the statement is the actual text from the Text File. 

 

Example:  Suppose that text #1, named “Disclaimer” in the Text File read: 

 
**** This Financial Statement is unaudited and without opinion expressed by 

---your accounting firm prints here---**** 

 

Layout Entered (P&L Format Layout): 

 
Acct-# or                                           Bal      Prt/        Prt       Paren 

Function                                            Typ   Accum     Col      Cntrl 

 

TXT  Text #01 Disclaimer 

LEG 

4010-100 Sales – Tools         N      P 

 

Resulting Statement: 

 
This Financial Statement is unaudited and without opinion expressed by 

---your accounting firm prints here--- 

 

For the period of 03/01/20 to 03/31/20 

 

Reporting – Period  Year-to-Date 

               Amount      Amount 

 Sales – Tools  $   4,000.00   $ 15,000.00 
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LIT  (Literal) 

This code prints exactly (“literally”) whatever you type next. You can enter up to 50 characters 

to print. The literal will begin at the first column of the statement, so if you wish it to appear 

indented, space over to the desired starting position for the first character. (If you wish it to 

appear centred on the statement, answer Y when “Centre?” appears.) 

 

 

Layout Entered (P&L Format Layout): 

 
Acct-# or                                            Bal    Prt/      Prt    Paren 

Function                                             Typ   Accum  Col    Cntrl 

 
 LIT  Centre ?  Y Schedule of Sales 

 LF  01 

 LEG 

 4010-100 Sales – Tools         N       P 

 

 

Resulting Statement: 
 

Schedule of Sales 

 

For the period of 03/01/20 to 03/31/20 

 

Reporting – Period  Year-to-Date 

            Amount      Amount 

 

 Sales – Tools  $   4,000.00   $ 15,000.00 

 

Subtotal Functions 

Two functions will create subtotalling, with the subtotal printed (SUB) or not printed (CLS). The 

examples below illustrate how each is used. 

 

 

SUB-1 SUB-9 

This code causes a subtotal to be printed on the statement. (SUB1 is the lowest level SUB9 is the 

highest level). 

 

SUB totals the balances of all accounts which have been either: 

• Printed using Prt/Accum = “P” or 

• Printed using a PAT or PATR code. (PATR is described in the “Balance Sheet Format” 

section of this Chapter.) 

 

Accumulated account totals will not add into subtotals until they are shown by using a printing 

account or PAT code. So, if a subtotal appears between an accumulated account and a printed 

account or PAT code, the amount of the accumulated account will not appear in that subtotal. 

 

Subtotals can be printed in any sequence on a Financial Statement.  
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Using the SUB1-SUB9 Code 

Enter the code. After you enter a SUB, a field appears which is used for printing accounting 

ratios. If no accounting ratios are to be printed on the statement, leave this field blank. See the 

section titled “Accounting Ratios” later in this Chapter for a discussion of how this field is used. 

 

Then enter the description of the subtotal as you want it to appear on the statement. 

 

Parentheses control will be requested for these types of layouts: 

 

• P&L Statement 

• Balance Sheet  

• Supporting Schedule (P&L format) 

• Supporting Schedule (balance sheet format)  

 

After the subtotal is printed on the Financial Statement, any preceding subtotals are cleared, 

starting at level 1, up through the level number of the subtotal code. 

 

For example, SUB1 clears any preceding level 1 subtotals only. SUB3 clears any preceding 

subtotals for levels 1, 2, and 3. SUB9 clears any preceding subtotals. 

 

If the statement is a balance sheet format (balance sheet, supporting schedule, or Statement of 

Changes in Financial Position), a “Prt col” code will be requested. Choose the column number 

where the subtotal is to be printed: 1, 2, or 3. 

 

As an example, here is a layout which includes two subtotal levels (1 and 5): 

 

 

Layout Entered (Balance Sheet Format Layout): 

 
Acct-# or                                Bal      Prt/        Prt     Paren 

Function                                         Typ     Accum   Col     Cntrl 

  

 1010-000 Cash – First National Bank   E  P 1 

 1020-000 Cash – First State Bank    E    P 1 

 1030-000 Cash – City Bank & Trust         E  P 1 

 SUB1  Total Cash in Bank     2 C 

 1040-200 Petty Cash – Dept. 100     E      p 1 

 1040-200 Petty Cash – Dept. 200     E  P 1 

 SUB1  Total Petty Cash      2 C 

 SUB5  Total Cash      3 C 
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Resulting Statement: 

 
 Cash – First National Bank  $  2,000.00 

 Cash – First State Bank   $  1,000.00 

 Cash – City Bank & Trust   $  4,000.00 

 Total Cash in Bank       $  7,000.00 

 Petty Cash – Dept. 100   $    500.00 

 Petty Cash – Dept. 200   $    300.00 

 Total Petty Cash    $    800.00 

 Total Cash        $  7,800.00 

 

The first subtotal (on the fourth line) includes accounts 1010-000, 1020-000 and 1030-000. The 

second subtotal (on the seventh line) includes accounts 1040-100 and 1040-200. The last subtotal 

(on the last line) includes all five cash accounts. 

 

Actually, the last subtotal (SUB5) is computed as the sum of the two SUB1’s, not the sum of the 

individual lines. 

 

A subtotal level 6 could be added further down in the layout to total several level 5 subtotals. 

 

 

Intervening Subtotal Levels 

Intervening subtotal levels can be skipped. In the example above, the SUB1’s could have been 

SUB3’s and the results would be exactly the same. The fact that, in the example, SUB2’s, 

SUB3’s, and SUB4’s (intervening levels between SUB1 and SUB5) were skipped makes no 

difference.   

 

 

Determining Where the SUB Codes Go 

To determine where the SUB codes go, 

 

1. List the accounts to be subtotalled, 

2. Draw brackets to show the subtotal structure you want, 

3. Number the brackets from left to right, 

4. Enter the SUB codes on the layout screen 

The next diagram shows how the first three steps could be done. 

 

 

The layout screen entries are shown on the right, along with an example of account balances and 

the resulting subtotals.  
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Acct 1        Acct 1  $   800.00 

Acct 2  SUB1      Acct 2  $   500.00 

Acct 3        Acct 3  $   200.00 

   SUB2      SUB1  $ 1,500.00 

 

Acct 4        Acct 4  $    400.00 

Acct 5  SUB1      Acct 5  $    300.00 

        SUB1  $    700.00 

        SUB2  $  2,200.00 

 

Acct 6        Acct 6  $    600.00 

Acct 7  SUB1      Acct 7  $    650.00 

Acct 8        Acct 8  $    200.00 

        SUB1  $  1,450.00 

 

Acct 9        Acct 9  $    350.00 

Acct 10        Acct10  $    450.00 

        SUB1  $    800.00 

  SUB3      SUB3  $  4,450.00 

 

Acct 11  SUB1      Acct11  $    225.00 

Acct 12        Acct12  $    750.00 

        SUB1  $    975.00 

 

Acct 13        Acct13  $    400.00 

        SUB4  $  5,825.00 

 

Step #4, entering the SUB1-SUB9 codes on the layout screen, would look like this: 

Layout Entered (Balance Sheet Format Layout): 
 

Acct-# or                                            Bal      Prt/      Prt     Paren 

Function                                             Typ     Accu    Col    Cntrl 

 
 1000-000 Acct 1            P 1 

 1010-000 Acct 2      P 1 

 1020-000 Acct 3      P 1 

 SUB1  Sum of Accts 1-3      2 C 

  

 1030-000 Acct 4      P 1 

 1040-000 Acct 5      P 1 

 SUB1  Sum of Accts 4-5      2 C 

 SUB2  Sum of Accts 1-5      3 C 

  

 1050-000 Acct 6      P 1  

 1060-000 Acct 7      P 1 

 1070-000 Acct 8      P 1  

 SUB1  Sum of Accts 6-8      2 C 

 

 1080-000 Acct 9      P 1 

 1090-000 Acct 10      P  1 

 SUB1  Sum of Accts 9-10     2 C 

 SUB3  Sum of Accts 1-10     3 C 

  

 1100-000 Acct 11      P 1  

 1110-000 Acct 12      p 1  

 SUB1  Sum of Accts 11-12     2 C 
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 1120-000 Acct 13      P 1 

 SUB4  Sum of Accts 1-13     3 C 

 

 

Resulting Statement: 
 Acct 1   $    800.00 

 Acct 2        500.00 

 Acct 3                200.00 

 Sum of Accts 1-3  $  1,500.00 

 Acct 4   $    400.00 

 Acct 5         300.00 

 Sum of Accts 4-5  $    700.00 

 Sum of Accts 1-5  $  2,200.00 

 Acct 6   $    600.00 

 Acct 7        650.00 

 Acct 8        200.00 

 Sum of Accts 6-8  $  1,450.00 

 Acct 9   $    350.00 

 Acct 10        450.00 

 Sum of Accts 9-10     $     800.00 

 Sum of Accts 1-10     $  4,450.00 

 Acct 11   $    225.00 

 Acct 12        750.00 

 Sum of Accts 11-12       $   975.00 

 Acct 13   $   400.00 

 Sum of Accts 1-13     $  5,825.00 

 

 

CLS1-CLS9 (Clear subtotal without printing) 

This causes the subtotals from level 1 through the level you specify to be cleared without 

printing. 

 

For example, CLS1 clears preceding level 1 subtotals only. CLS3 clears preceding subtotals for 

levels 1, 2 and 3. CLS9 clears all preceding subtotals. 

  

You may find this code useful in the final formatting of the Financial Statements you will present 

to your shareholders. 

 

(After you enter the CLS1-CLS9 code, the field which appears is for printing accounting ratios. 

If no accounting ratios are to be printed on the statement, leave this field blank. See the section 

titled “Accounting Ratios” later in this Chapter.) 

 

A typical use of CLS is when you are comparing one account with the total of several accounts. 

For example, suppose you want the statement to show: 

 
    Reporting – Period  Year-to-Date 

            Amount      Amount 

 Sales – Acct  $  4,000.00   $  23,700.00 

 Expense Acct #1  $  1,500.00   $   6,000.00 

 Expense Acct #2  $    500.00   $   3,000.00 

 Expense Acct #3  $  1,600.00   $  11,000.00 

 Total Expenses  $  3,600.00   $  20,000.00 

 

 Gross Profit  $    400.00   $   3,700.00  
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But if you entered your layout like this, using SUB1 on the third line, you would not get what 

you want. 
 

Acct-# or                                          Bal     Prt/       Prt     Paren 

Function                                           Typ    Accum   Col     Cntrl 

 
 LEG 

 6000-000 Sales – Acct        N       P 

 LF 

 SUB1  (blank)       D 

 5010-000 Expense Acct #1        N      P  

 5020-100 Expense Acct #2                   N       P 

 5030-200 Expense Acct #3                      N       P 

 UL 

 SUB1  Total Expenses           C 

 LF  

 SUB2  Gross Profit         D 

 

 

Instead you would get: 

 
    Reporting – Period  Year-to-Date 

            Amount      Amount 

 Sales – Acct  $  4,000.00   $  23,700.00 

    $  4,000.00   $   4,000.00 

 Expense Acct #1  $  1,500.00   $   6,000.00 

 Expense Acct #2  $    500.00   $   3,000.00 

 Expense Acct #3  $  1,600.00   $  11,000.00 

 Total Expenses  $  3,600.00   $  20,000.00 

 

 Gross Profit  $    400.00   $   3,700.00 

 

Note that the first SUB1 clears the “Sales Account” balance, but also causes this balance to print. 

Using CLS1 in place of the first SUB1 would produce the desired result. 

 

Layout Entered (P&L Format Layout): 

 
Acct-# or                                            Bal     Prt/       Prt      Paren 

Function                                            Typ    Accum   Col     Cntrl 

 
 LEG 

 6000-000 Sales – Acct         N       P 

 LF 

 CLS1  (blank)         

 5010-000 Expense Acct #1         N    P  

 5020-100 Expense Acct #2                 N       P 

 5030-200 Expense Acct #3                        N        P 

 UL 

 SUB1  Total Expenses                           C 

 LF   

 SUB2  Gross Profit                D 
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Resulting Statement: 
    Reporting – Period  Year-to-Date 

            Amount      Amount 

 Sales – Acct  $  4,000.00   $  23,700.00 

     

 Expense Acct #1  $  1,500.00   $   6,000.00 

 Expense Acct #2  $    500.00   $   3,000.00 

 Expense Acct #3  $  1,600.00   $  11,000.00 

 Total Expenses  $  3,600.00   $  20,000.00 

 

 Gross Profit  $    400.00   $   3,700.00 

 

 

Functions used to lay out text 
 

 LF -Line feed (skip a line) 

 FF -Form feed (start a new page) 

 UL -Print an underline 

 DL -Print a double underline 

 LEG -Print a predefined legend (heading) 

 TXT -Print text from the Text File 

 LIT -Print a “literal” (a “literal” is a line of text) 

 

Text Functions Meanings 
 

LF  (Line Feed) 

“LF” causes on or more lines to be skipped on the statement, depending on how many lines you 

specify. 

 

FF  (Form Feed) 

“FF” causes a new page to be started. 

 

UL  (Underline) 

“UL” causes an underline to be printed. For a balance sheet format, you specify in which column 

it is to appear: 1, 2, or 3. 

 

DL  (Double Underline) 

“DL” causes a double underline to be printed. For a balance sheet format, you specify in which 

column it is to appear: 1, 2, or 3. 

 

LEG  (Legend) 

The LEG code causes a predetermined legend to be printed on the Financial Statement. One line 

is skipped after the legend, so that a LF (line feed) following is not necessary.  
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For Balance sheet format statements, LEG prints the current period ending date. 

 

For P&L format statements, LEG prints a description of the current period, column headings, 

and (if used) a description of the sub-account or sub-account group for which this statement is 

being printed. 

 

 

Using LF, UL, DL and LEG 

The layout entries shown next (for a P&L format statement) and the resulting statement illustrate 

the use of LF, UL, and LEG. 

 

 

Accounting Ratios 
 

You may define layouts which calculate various accounting ratios. 

 

Statement Formats to Use 

 

Accounting ratios (such as the Current Ratio) which are based on balance sheet accounts should 

be calculated using type X (Supporting Schedule – Balance Sheet Format) layouts. 

 

Accounting ratios (such as Gross Profit Margin) which are based on P&L accounts should be 

calculated using type S (Supporting Schedule – P&L Format) layouts. On type S layouts, you 

may choose the beginning balance, ending balance, or net change for the reporting period. Use 

“net change” to compute the ratio for just the current reporting period. Use “ending balance” to 

compute the ratio for the entire fiscal year (up to the end of the current reporting period). 

 

Accounting ratios which are based on both balance sheet and P&L accounts should be calculated 

using type E (Expanded Cash Flow Statement) layouts. For each account entered on this layout, 

you may choose the beginning balance, ending balance or net change for the reporting period. 

Choose the correct balance for each account, depending on the ratio being calculated. 

 

 

 

NOTE: When entering a G/L account on a type E layout, you are given a warning message 

if you have not defined a “cash flow type” for the account through Chart of Accounts. 

Thus, for ease of data entry, you should enter cash flow types for each account to be used 

on the type E layout. 
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Storing Totals and Calculating Ratios 

Calculating ratios on Financial Statements is done in a fashion similar to using a hand-held 

calculator. 

 

When using a calculator, you can store calculated numbers into “memory registers”. 

 

When printing Financial Statements, you can store an account total that has been printed on the 

Financial Statement into one of 9 different memory registers. Then, calculations can be 

performed on these memory registers in order to compute the accounting ratio. The value in a 

memory register can then be printed on the Financial Statement in or to print the accounting 

ratio. 

 

When entering any of the following codes, you may specify a memory register into which the 

printed total is to be placed: 

 

 

SUB 

PAT 

PATR 

CLS 

 

- Note that for CLS, the total is not actually printed on the Financial Statement—it is 

simply cleared. It is the value that is cleared which is placed in the memory register. 

 

 

The following codes perform operations on memory registers: 

 

 

CLM  (Clear Register) 

Clear the memory register specified. Sets the amount in the register equal to zero. 

 

 

PUT  (Put Amount into Register) 

Put an amount entered on the layout into the memory register specified. Use this to enter a fixed 

amount for use in a calculation. 

 

 

POS  (Make Amount in Register Positive) 

Make the current amount in the register be positive. For instance, 23.89 remains 23.89, but -

23.89 becomes 23.89. 
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CALC  (Calculate) 

Perform the arithmetic calculation of the type specified on the registers specified. Calculations 

allowed are: 

 CALC MEMA = MEMB plus MEMC 

 CALC MEMA = MEMB minus MEMC 

 CALCMEMA = MEMB times MEMC 

 CALCMEMA = MEMB divided by MEMC 

The arithmetic operation is carried out on MEMB AND MEMC, and the result stored in MEMA. 

 

(“MEMA” stands for one register, “MEMB” for a second one, and “MEMC” for a third.) 

 

MOVE  (Move Contents of Register) 

Move the contents of MEMB into MEMA, then clear MEMB. 

The entry format is MOVE MEMA = MEMB. 

 

 

COPY   (Copy Contents of Register) 

Copy the contents of MEMB into MEMA. Leave MEMB as it is. 

The entry format is COPY MEMA = MEMB 

 

PMR1-PMR9  (Print Amount in Register) 

Print the amount stored in the memory register specified. 

This is used to print the accounting ratio on the Financial Statement. 

 

After you enter the PMR code, you may enter a description of the ratio. 

 

For balance sheet format, you then enter a print column and a parentheses control code. In 

addition to the normal “D” or “C”, you may choose to show a minus sign instead of entering “-“. 

 

For a P&L format, you enter just a parentheses control code as described above. 

 

Rules for Using Accounting Ratios 

 

Accounting ratios can be either: 

 

1. Calculated and printed along with actual statements (such as the Balance Sheet or P&L 

Statement), or 

2. Calculated and printed separately, using these Financial Statement types: 

 

P&L supporting schedule (type B) 

Balance Sheet supporting schedule (type X) 

Expanded Cash Flow Statement (type E) 

 

For instance, suppose you want to calculate, on a separate statement, the “current ratio” (the 

number of times current liabilities can be covered with current assets, calculated as current 

assets/current liabilities). 

 

Let us assume that accounts 1000 through 1500 represent current assets, and that accounts 2000 

through 2500 represent current liabilities.  
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Acct-# or                                            Bal    Prt/       Prt     Paren 

Function                                             Typ   Accum   Col    Cntrl 
 

 RNG  Beg 1000 

   End 1500 Sub-acct *  A 

 SUB6  MEM1 Current Assets   P 3 

 

 RNG  Beg 2000 

   End 2500 Sub-acct * 

 SUB6  MEM2 Current Liabilities   P 3 

 LF 

 CALC  MEM3 = MEM1 divided by MEM2 

 POS  MEM3 

 PMR3  Current Ratio 

 

 

Resulting Statement: 
 Current Assets     $  16,800.00 

 Current Liabilities    $  16,000.00 

 

 Current Ratio      1.05 

 

Calculating Various Accounting Ratios 

 

 

Quick Ratio (Acid-Test Ratio): 

(Current Assets – Inventory)/Current Liabilities 

 

With Current Assets in MEM1, Inventory in MEM2, and Current Liabilities in MEM3: 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

Function                                           Typ   Accum   Col   Cntrl 
 

 CALC  MEM4 = MEM1 minus MEM2 

 CALC   MEM5 = MEM4 divided by MEM3 

 POS  MEM3 

 PMR5   Quick Ratio 

 

Gross Profit Margin: 

Gross Profit/Net Sales 

 

With Gross Profit in MEM1 and Net Sales in MEM2: 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

Function                                           Typ   Accum   Col   Cntrl 

 
 CALC  MEM3 = MEM1 divided by MEM2 

 POS  MEM3 

 PMR3   Gross Profit Margin 
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Operating Profit Margin: 

Operating Profit/Net Sales 

 

With Operating Profit in MEM1 and Net Sales in MEM2 

 

Acct-# or                                          Bal    Prt/      Prt    Paren 

Function                                           Typ   Accum    col   Cntrl 

 
 CALC  MEM3 – MEM1 divided by MEM2 

 POS  MEM3 

 PMR3   Operating Profit Margin 

 

 

Net Profit Margin: 

Net Earnings/Net Sales 

With Net Earnings in MEM1 and Net Sales in MEM2: 

 

Acct-# or                                          Bal    Prt/        Prt    Paren 

Function                                           Typ   Accum  Col    Cntrl 
 

 CALC  MEM3 = MEM1 divided by MEM2 

 POS  MEM3 

 PMR3   Net Profit Margin 

 

 

P&L Format Statements 
 

This section describes how P&L format statements are printed and other features available only 

on P&L format statements. 

 

 

Print Format 
 

Two amounts are shown for each account or subtotal printed on a statement in P&L format: 

• The amount for the reporting period 

• The year to date amount 

 

The two amounts will appear in fixed columns on the statement: 

 

 
Reporting – Period  Year-to-Date 

            Amount      Amount 

 Sales – tools  $     999.99   $    999.99 

 Sales – tools  $     999.99   $    999.99  
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If budgets or comparatives are selected, they will print in two columns to the right of the 

above amounts. Budgets or comparatives are selected in Financial Statements (Enter 

specifications). One column shows the reporting period amount, and the other column 

shows the year-to-date amount. 

 

Ratios (described next) are allowed for the P&L Statement and the P&L Supporting Schedule. 

Ratios are not allowed on other types of statements. The percentage figures will appear just to 

the right of both the reporting period and year-to-date amounts on the statement. (Ratios are 

shown for budgets and comparatives as well, if they are printed.) 

 

For the Expanded Cash Flow Statement, ratios, budgets nor comparatives can be used. 

For the SAF statements, only comparatives can be used. 

 

A “variance” is either a difference from a budget or a difference from a comparative for last year. 

Variances are printed both as a number and as a percentage. 

 

Variances can be selected for any statement on which budgets or comparatives can be printed, 

except the Expanded Cash Flow Statement. (See the Chapter titled Financial Statements.) 

 

See the sample statements in the appendix titled Additional G/L Exercise Data for the exact 

appearance of budgets, comparatives, and variances. Accounting ratios / variances on the 

Balance sheet and P & L Financial Statements are printed in multiple columns for budget and 

comparative amounts as applicable to the Financial Statement specification. Note that memory 

registers are only included on the statements by printing a subtotal or a PAT. 

  

 

Ratios 
 

“Ratios” are percentage figures based on some larger amount such as total sales or total revenue. 

 

In order to provide ratios (percentages) on P&L type statements and schedules, you must define 

the amount against which other amounts are to be compared. 

 

You may calculate and print either “general ratios” or “selected ratios”. Each is described below. 

 

General Ratios   

 

SR-ER (Selected Ratio and End Ratio) 

This is used to compute ratios for an entire statement, based on one total amount (“basis”) which 

you specify by inserting codes for “start computing and printing ratio” (SR) and “end computing 

and printing ratio” (ER). 
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The SR code comes before the first account on the layout this is to be included in the ratio basis 

amount. The ER code follows the last amount that is to be included. 

 

For example, if the total for all accounts between the SR and the ER is $1,000.00, and a 

particular account is printed with an amount of $15.00, its ratio would be printed as 1.50%. 

 

These percentage figures will appear just to the right of each amount printed on the statement. 

 

Only one pair of SR and ER codes can be defined for a layout. 

 

Layout Entered (P&L Format Layout): 

Acct-# or                                          Bal    Prt/        Prt      Paren 

Function                                           Typ   Accum      Col     Cntrl 
 LEG 

 SR 

 5010-000 Exp Acct #1   P    

 5020-000 Exp Acct #2   p 

 5030-000 Exp Acct #3   P  

 ER 

 UL 

 SUB1  Total Exp       C 

 

Resulting Statement: 
Reporting – Period   Year-to-date 

            Amount  Ratio     Amount  Ratio 

 Exp Acct #1  $     1,500.00   41.67  $   2,400.00   26.67 

 Exp Acct #2  $        300.00   08.33  $   1,500.00   16.67 

 Exp Acct #3  $     1,800.00   50.00  $   5,100.00   56.67  

 Total Exp  $     3,600.00            100.00  $   9,000.00         100.00 

 

 

NOTE:  That the ratio also prints for “Total Expenses”, even though “SUB1 Total Expenses” 

was after the ER. In fact, the SR/ER codes will cause a ratio to print on every line containing an 

amount. 

 

If you do not wish the ratio to print on every line containing an amount on the statement, or you 

wish to show more than one ratio, use “Selected Ratios”, which are described next. 

 

 

Selected Ratios 

These codes are used when you want to print a ratio for selected (rather than all) lines on a 

statement or print more than one ratio. 

 

The set of account lines on which the ratios to be included in the calculation of the basis for the 

ratio are bounded by the SR and ER codes. 

 

The set of account lines on which the ratios are printed are bounded by the SPR and EPR codes. 

 

These sets of accounts may be different, depending on where these codes are placed on layout. 

When printing a particular statement, only those selected ratios included on the Financial 

Statement specification (entered through Specifications in Financial Statements) will be printed.  
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SR1-SR9 and ER1-ER9 (Compute Selected Ratio) 

Enter a pair of SR/ER codes to define the set of accounts which are to be included in the 

calculation of the basis for the ratio. 

 

The SR code comes before the first account on the layout that is to be included. The ER code 

follows the last account that is to be included. 

 

Up to 9 pairs of SR/ER codes (SR1/ER1 through SR9/ER9) can be entered for a statement. 

 

Note that these are not levels of selected ratios, like SUB1-Sub9 codes indicate levels of 

subtotals. The number just designates a pair of SR/ER codes. This also applies to SPR and EPR 

(next). 

 

 

SPR1-SPR9 and EPR1-EPR9  (Print Selected Ratio) 

Enter a pair of SPR/EPR codes to define the set of account lines on which the corresponding 

calculated ratios are to print. 

 

For instance, the ratios calculated from the accounts bounded by SR3/ER3 would print on the 

lines bounded by SPR3/EPR3. 

 

The SPR code comes before the first account line on which the ratio is to be printed. The EPR 

code follows the last account line on which the ratio is to be printed. 

 

Many pairs of SPR/EPR codes may be entered for each pair of SR/ER codes entered. 

 

Here is an example: 

 

Layout Entered (P&L Format Layout): 

Acct-# or                                           Bal     Prt/       Prt     Paren 

Function                                            Typ   Accum     Col   Cntrl 

 
 LEG 

 SR1 

 SPR1  

 6010-000 Sls Acct #1         N       P   

 6020-000 Sls Acct #2         N      P 

 6030-000 Sls Acct #3         N      P 

 UL 

 SUB1  Tot Sales        D 

 ER1 

 EPR1 

 LF  01 

 SR2 

 SPR2 

 5010-000 Exp Acct #1         N      P  

 5020-000 EXP Acct #2         N      P  

 5030-000 Exp Acct #3         N      P 

 UL 

 SUB1  Tot Exp        C 

 ER2 

 EPR2 
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Resulting Statement: 

 
Reporting – Period   Year-to-date 

            Amount  Ratio     Amount  Ratio 

 Sls Acct #1  $   15,000.00    30.00   $ 40,000.00  20.00 

 Sls Acct #2       10,000.00    20.00      50,000.00  25.00 

 Sls Acct #3       25,000.00    50.00    110,000.00  55.00 

 Tot Sales  $   50,000.00        100.00  $200,000.00              100.00 

   

 Exp Acct #1  $     2,000.00  25.00  $   2,400.00  26.67 

 Exp Acct #2         2,400.00  30.00       1,500.00  16.67 

 Exp Acct #3         3,600.00  45.00       5,100.00  56.67  

 Total Exp  $     3,600.00              100.00  $   9,000.00             100.00 

 

(This assumes that both SPR1 and SPR2 were selected for printing in Specifications in Financial 

Statements. If only SPR1 was selected, only the sales account ratios would be printed.) 

 

Codes Associated with Selected Ratios 

 

The texts and literals described below are printed only if the corresponding selected ratio is 

printed. 

For example, if Selected Ratio 5 (SR5) is chosen for printing (through Specifications in Financial 

Statements), any TXT5’s and LIT5’s on the layout will also be printed. 

 

 

TXT1-TXT9   (Text Associated with Selected Ratio) 

This prints the text you specify from the Text File (see the Chapter titled Texts). The text 

description is displayed next to the text number you enter, but what will print on the statement is 

the actual text in the Text File. 

 

 

LIT1-LIT9   (Literal Associated with Selected Ratio) 

This prints exactly (“literally”) whatever you type next. You can enter up to 50 characters to 

print. The literal will begin at the first column of the statement, so if you wish it to appear 

indented, space over to the desired starting position for the first character. (If you wish it to 

appear centred on the statement, answer Y when “Centre?” appears.) 

 

Example of Using Selected Ratios and Associated Codes 

 

This example illustrates how to show sales accounts as percentage of sales and expense accounts 

as percentage of expense. 
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Layout Entered (P&L Format Layout): 

Acct-# or                                            Bal    Prt/      Prt    Paren 

Function                                             Typ   Accum   Col   Cntrl 

 
 LEG 

 SR1 

 TXT1  05 Sales Pcts 

 LF  01 

 LIT1  Y  % of Sales 

 LF  01 

 SPR1 

 6010-000 Sls Acct #1        N P 

 6020-000 Sls Acct #2        N P 

 6030-000 Sls Acct #3        N P 

 UL 

 SUB1  Tot Sales      D 

 ER1 

 EPR 

 LF  01 

 SR2 

 TXT2  06 Expense Pcts 

 LF  01 

 LIT2  Y  % of Expenses 

 SPR2 

 5010-000 Exp Acct #1        N P 

 5020-000 Exp Acct #2        N P 

 5030-000 Exp Acct #3        N P 

 UL 

 SUB1  Tot Exp       C 

 ER2 

 EPR2  

 

Resulting Statement: 
Reporting – period   Year-to-date 

            Amount  Ratio     Amount  Ratio 

 Sls Acct #1  $   15,000.00  30.00  $  40,000.00  20.00 

 Sls Acct #2      10,000.00  20.00      50,000.00  25.00 

 Sls Acct #3      25,000.00  50.00    110,000.00  55.00 

 Tot Sales  $   50,000.00        100.00  $ 200,000.00              100.00  

 

This section compares the contribution of each expense account to overall expenses. 

   

 Exp Acct #1  $     2,000.00   25.00  $   2,400.00  26.67 

 Exp Acct #2         2,400.00   30.00       1,500.00  16.67 

 Exp Acct #3         3,600.00   45.00       5,100.00  56.67  

 Total Exp  $     8,000.00               100.00  $   9,000.00             100.00 
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Expanded Cash Flow Statement – Type “E” Layout 
 

 

Type “E” layouts are used for creating the Financial Statements required by “Statement of 

Financial Accounting Standards No. 95” issued by the Financial Accounting Standards Board in 

the United States, and similar requirements in Canada by the Institute of Chartered Accountants. 

 

This publication requires accounting entities to provide a detailed statement of cash flows, 

together with a statement that reconciles net income to the cash flows from operations. 

 

We recommend that preparation of these layouts be done in consultation with your accountant, 

who will have the intimate knowledge of your business activities necessary for an accurate 

representation of these detailed statements. 

This “E” type layout is not restricted to the above statements relating to cash flows but is in fact 

a very powerful and versatile tool for showing changes in any series of accounts. 

 

You can include both balance sheet and profit and loss accounts on these layouts. 

 

You can select one of the five different balance types for use: 

 

 Beginning balance 

 Gross debits 

 Gross credits 

 Net change 

 Ending balance 

 

You can reverse the balance for the current layout line by specifying that it be multiplied by 

minus one. 

You can override the parentheses control code of an account for the current layout line. 

These features provide the means to produce almost any kind of statement in the profit and loss 

format. 

 

 

Balance Sheet Format Statements 
 

Three types of Financial Statements use the balance sheet format: 

 

 B -Balance Sheet 

 X -Supporting Schedule (balance sheet format) 

 F -Statement of Changes in Financial Position 

 

Appearance 

 

The balance sheet format shows one balance for each account or subtotal. 

 

The balance sheet has three columns in which a balance can be printed. You select a print 

column (Prt col) when you enter a layout line that prints a balance. You also select a print 
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column when you enter a layout line that prints an underline or a double line. 

 

For example: 
Cash – First National Bank  $ 2,000.00 

Cash – First Provincial Bank     1,000.00 

Cash – City Bank and Trust     4,000.00 

Total Cash in Bank      $ 7,000.00 

Petty Cash – Dept. 100  $    500.00 

Petty Cash – Dept. 200        300.00 

Total Petty Cash   $    800.00 

Total Cash        $ 7,800.00 

 

Ratios or selected ratios are not allowed with the balance sheet format. 

Budgets or comparative amounts are printed on the right-hand side of the page when selected in 

Print Financial Statements. 

 

See the sample Balance Sheet Supporting Schedule at the end of this section. 

There are two function codes used only on balance sheet format statements: 

 

 

PATR (Print Accumulated Total with Rounding Error) 

This code is the same as PAT, except it is used on balance sheets to indicate that if the balance 

sheet is printed with dollar rounding (as specified in Specifications under Financial Statements), 

then any rounding error is to be ‘buried’ into this PATR. 

 

Only one such PATR should appear on a balance sheet. If more than one appears, only the first 

one is used to bury the rounding error. The other PATR’s will be ignored. 

 

When printing a rounded Balance Sheet, the PATR code will always make the Balance Sheet 

appear to be in balance, even if the corresponding unrounded Balance Sheet is out of balance.  

The Balance Sheet will appear to be in balance because the amount by which the Balance Sheet 

is out of balance is ‘buried’ along with the rounding error. 

Because of this situation, the software verifies that the unrounded amounts are in balance even 

when printing a rounded Balance Sheet. If there is an out of balance situation, an error message 

will appear at the end of the rounded Balance Sheet statement. 

 

(After you enter the PATR code, the field which appears is for printing accounting ratios. If no 

accounting ratios are to be printed on the statement, leave the field blank. See the section titled 

“Accounting Ratios” earlier in this Chapter.) 

 

NOTE: The PATR code is also allowed on SAF formats. 
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BSNI (Balance Sheet Net Income) 

This code is valid for these layout types: 

 

 Balance Sheet 

 Supporting Schedule (balance sheet format) 

 Cash Flow Statement 

 Statement of Changes in Financial Position 

 

The calculated net income from the P&L statement will appear at this line of the Financial 

Statement. 

-  

NOTE: See the IMPORTANT NOTE in the Chapter titled Financial Statements about the 

proper sequence of printing a P&L statement and balance sheet so that BSNI is computed 

correctly. If they are done out of order the statements may not calculate out properly 

 

 

All Balance Sheets must include this code in order to balance. 

You are requested to enter ‘Prt/Accum?’ (Print/Accumulate?). Enter P or A, as appropriate. If P 

is entered, ‘Prt col’ will be requested. Enter 1, 2, or 3. 

 

Except for Expanded Cash Flow Statement (type E) layouts, the parentheses control is always 

assumed to be D, since net income is typically credit. 

 

For type E layouts, you can reverse the balance of BSNI and override the parentheses control. 

This is useful when creating statements showing reconciliation of net income to cash flows from 

operations. 

 

 

Printing an Edit List 
 

Select Statement layouts > Print layout edit list from the General Ledger Main Menu. 

 

[?] 1. Starting Layout # 

Enter the starting layout to include OR: 

 

  [F1]  -For the ‘First layout on file 

  [F2]  -To scan through the layouts on file 

 

 

[?] 2. Ending Layout # 

Enter the ending layout to include OR: 

 

  [F1]  -For the ‘Last’ layout on file 

  [F2]  -To scan through the layouts on file  
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3. Expand Wild-Cards? 

Answer Y to expand the accounts containing a wild-card, so that each sub-account is shown. 

 

Answer N to show the main accounts with wild-card symbols as they were entered on the layout. 

 

 

Sample Statements 
 

 

Select Statement layouts > Print sample statements from the General Ledger Main Menu. 

 

This selection is used to print a sample Financial Statement from a layout so that you can see 

how the final statement will look. 

 

A screen appears to enter the following information: 

 

 

[F1] Layout # to Print 

Enter the number of the layout to print or press [F1] to scan through the layouts on file. 

 

 

2. Show Computed Subtotals 

Answer Y to have computed subtotals printed. 

 

 

3. Print Text and Literals for Selected Ratios? 

Answer Y to print the texts and literals associated with the selected ratios you enter next. 

If you answer Y, you may enter up to 9 selected ratios for which to print texts and literals or use 

the [F1] option to print texts and literals for “All” selected ratios. 

 

 

Re-sequencing Layouts 
 

An internal numbering system is used in the computer to keep the layout lines in sequence. If 

many changes are made to a layout, you may get a message (while editing the layout) stating that 

the layout must be re-sequenced. It is highly unlikely that this will ever occur during your use of 

Samco Software, but should it occur, then this selection to re-sequence the layout (i.e. re-number 

the lines internally in the computer). Once you have re-sequenced the layout, you may continue 

editing the layout. 

 

Select Statement layouts > Re-sequence layouts from the General Ledger Main Menu and enter 

the number of the layout to be re-sequenced. 
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When Statements won’t print 
 

When statements won’t print, it may be due to errors in the layout.  To troubleshoot this and 

confirm that the layout is correct you may want to verify the layout.  

 

 

Verifying Layouts 
 

Verify layouts checks to ensure that the following are all true about the layout. 

 

NOTE: If there are errors such as ‘Account not on File”, a message will pop up indicating there 

are errors and the layout will not generate until all errors are corrected. 

 

(1) Each account on the layout appears only once on the layout. 

 

(2) Each account has the correct type for the layout. If a P&L account appears on a balance sheet 

layout, you will be notified. If a balance sheet account appears on a P&L layout, you will be 

notified. 

 

- NOTE: There are situations in which a balance sheet account should appear on a P&L 

statement, as discussed in the appendix titled Handling Periodic Inventory. 

 

 

(3) Every balance sheet account (in the Chart of Accounts) appears on the balance sheet layout. 

 

(4) Every P&L account (in the Chart of Accounts) appears on the P&L statement. 

 

(5) BSNI (Balance Sheet Net Income) is on the balance sheet layout. 

 

NOTE: If any are missing any accounts, or there are errors, the statement may not print.  

 

 

You may choose to verify a layout with respect to a single sub-account or with respect to a sub-

account group. In this case, only accounts on the layout and accounts in the Chart of Accounts 

which match the single sub-account (or are contained in the sub-account group) are considered 

during the verification. You would verify a layout with respect to a sub-account or group if you 

plan to print the layout for just that sub-account or sub-account group. Printing layouts for a 

single sub-account or group is described in the Chapter titled Financial Statements. 

 

A Layout Verification Report is printed which includes any errors found. 

Select Statement layouts > Verify layouts from the General Ledger Main Menu.  
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[F1] 1. Layout Number 

Enter the number of the layout to be verified or use the [F1] option to scan through the layouts 

on file. 

 

 

2. Verify Using a Sub-Acct Group? 

Answer Y to verify the layout only with respect to the sub-acct group you will enter next. 

 

If you answer Y, this field appears: 

 

 

[?] Sub-Acct Group # 

Enter the sub-acct group for each account section which the layout is to be verified or press [F1] 

to scan through the sub-account groups on file. 

 

If you answer N at field 2, this field appears: 

 

 

[?] Sub-Account 

Enter the sub-account for which the layout is to be verified, OR: 

 

[F1]  -To scan through the sub-accounts on file 

 

  [F2]  -To verify the layout for “All” sub-accounts 

 

 

 

The Verify Layouts Report can be printed to screen by selecting [S] display on screen or paper. 

Choose option from print menu in pop-up window.  

 

See the Chapter titled Copy Layouts/Make SAF Layouts for information on SSRC (Start of 

Sources of Funds) and SUSE (Start of Uses of Funds) codes, which are used only in Source and 

Application Funds Statement layouts. The use of BSNI code on SAF layouts is also discussed in 

this Chapter. 
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Chapter 19 - Build Financial Statement Layouts 
 

 

We recommend that you use the following step-by-step procedure to build a Financial Statement 

layout.  You might find it helpful to study the following before building your own layouts:  

 

• Sample Reports and other information provided in the appendix titled 

 Additional G/L Exercise Data. 

• The procedure described in the appendix titled Handling Periodic  Inventory. 

 

Follow this procedure: 

 

1. -Lay out the Financial Statement as you want it to appear on multi-column (for example,  

 12-column worksheet) accounting paper.  Leave plenty of space to add accounts, 

literals,  and text, as you may think of them later.    

 

2. -List the numbers of the accounts that you want to appear on the Financial Statement.  

Mark those you want to print on the Financial Statement with a "P" and mark those you 

want to accumulate with an "A".    

 

 

3. NOTE: There is a feature where you can group a range of accounts using the F4 – Auto 

PAT Function. The system asks for the starting and ending account numbers. Once 

entered the system will look for all accounts in that range and grab the “Main” section 

Value and wild-card the rest. ( i.e. – profit -centre) The Account will be set to A for 

Accumulate and a PAT line will be added immediately afterward.  

 

4. Insert PAT (print accumulated totals) codes at the appropriate places.   

 

5. Insert SUB (subtotal) codes at the proper places.  Use CLS (clear subtotal) if needed.  
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6. Insert LIT (literals), TEXT (texts), and LEG (legends) codes. These codes control which 

descriptions will be a part of the Financial Statement and where they will print.    

 

7. Insert LF (line feed), FF (form feed), UL (underline), and DL (double underline) codes at 

the proper places to make the Financial Statement easy to read.    

 

8. On profit and loss statements (and P&L supporting schedules, as appropriate), insert the 

SR (start ratio) and ER (end ratio) codes that define the accounts which will be the basis 

for ratios.   

 

9. Also, on P&L statements and supporting schedules, insert the SR and ER (start and end 

selected ratio) codes, and the SPR and EPR ) start and end selected ratio to print) codes. 

 

10. Insert any TXT1-TXT9 (selected text) and LIT1-LIT9 (selected literals) codes which are 

to print when the corresponding SPR1-SPR9 codes are selected for printing. 

 

11. On balance sheets (and balance sheet supporting schedules, as appropriate), insert the 

BSNI (balance sheet net income) code, that will transfer the net income (loss) from the 

P&L Statement to the balance sheet.    

 

12. Next to the codes listed, write the following columns across the page for use in Financial 

Statement layouts:   

  
Acct-# or   Bal  Prt/ Prt Paren Text #  Literal Description 

Function   Typ Accum ?    Col Cntrl 

 

12. For each account number and function code, write the appropriate information for each 

column:  

 

• Bal Typ  -(N, D, C, B, or E) 

 

• Prt/Accum? - code (P or A) 

 

• Prt col code - (1, 2, or 3) 

 

• Paren Cntrl code (D or C) 

 

• The text number for TEXT codes 

 

• The literal entry for LIT codes 

 

• The descriptions of summarized (PAT) or sub-totalled (SUB) accounts 

 

13. Review the codes to verify that they will give you the Financial Statement that you have 

drawn out on paper.    

 

14. Enter the layout into the system through Financial Statement Layouts.    
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15. Print an edit list of the layout and review it.  Make changes as necessary. 

 

16. Use Sample statements to print a statement from the entered layout.  Compare the printed 

sample statement with the Financial Statement you have drawn out on paper.    

 

17. Make any necessary additions or corrections to the layout. 

 

18. Verify the layout, using Verify layouts.   

 

19. Correct any errors found during the verification. 

 

20. When the sample statement looks correct, print a Financial Statement through Print 

Financial Statements. 

 

21. Make any final changes necessary to the layout to produce a Financial Statement with the 

account information properly accumulated, printed, sub-totalled, placed in the columns 

properly, described, underlined in the right places, and in agreement with the Financial 

Statement layout from which you started.    

 

22. When you have carried out the procedure of steps 1 through 21 for each required Financial 

Statement, you are ready to print real Financial Statements with your real General Ledger 

information.  
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Financial Layout Legend  
 

LF -Line feed (skip a line) 

 FF -Form feed (start a new page) 

 UL -Print an underline 

 DL -Print a double underline 

 LEG -Print a predefined legend (heading) 

 TXT -Print text from the Text File 

 LIT -Print a “literal” (a “literal” is a line of text) 

 PAT  -Print Accumulated Total  

 PATR  -Print Accumulated Total Rounded 

 

 SR1-SR9 and ER1-ER9 -Compute Selected Ratio 

 SPR1-SPR9 and EPR1-EP -Print Selected Ratio 

 TXT1-TXT9    -Text Associated with Selected Ratio 

 LIT1-LIT9    -Literal Associated with Selected Ratio 

 

B -Balance Sheet 

 X -Supporting Schedule (balance sheet format) 

 F -Statement of Changes in Financial Position 

 

 

Functions used to calculate, print, and clear subtotals 

 

SUB1-SUB9 Print the subtotal for the level specified by the number (1 is the lowest level, 9 the 

highest), then clear the subtotals at the level specified and all preceding lower 

levels 

 

CLS1-CLS9 Clear the subtotal at the level specified and all preceding lower levels, without 

printing a subtotal  

 

Common references: 

 

N -Net change for the reporting period (this is the sum of types D and C 

below). This is the usual balance type for P&L format. This type is 

automatically set for Cash Flow Statement and Analysis of Changes in 

Working Capital. 

  B -Balance as of the beginning of the reporting period. 

E -Balance as of the end of the reporting period (this is the sum of types B 

above and C and D below). 
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Chapter 20 - Copy Layout / Make SAF 
 

 

Use this selection to: 

 

Copy layouts (create new layouts from existing layouts)   

 

Make SAF Layouts (automatically create from one to three Source and Application of Funds 

Statement layouts from an existing balance sheet layout)   

 

 

Copying a Layout 
 

This selection allows you to do three things with an existing layout:  add a new sub-account to it; 

copy it fully (including all sub-accounts); or copy it, but with only one sub-account appearing in 

the new layout. 

 

These functions are described in detail below. 

 

Select GL > Statement layouts > Copy layouts from the G/L Menu. 

 

A screen appears for you to enter the layout number to copy from and the action to take. 
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Copy from Layout # 

Enter the number of the layout to be copied from, or press [F1] to scan through the layouts on 

file. The type of statement and description will be displayed.  

 

 

Action to Take 

Select the action to take on the "copy from" layout.  

 

 C  -Copy full layout to another layout 

 A  -Add a sub-account to this layout 

 N  -New layout with a new sub-account 

 

 

C- Copy full layout to another layout 

Select C to create a totally new layout which is a duplicate of the existing one.  The new layout 

will have a different layout number but will have the same statement type as the original layout.  

Once the existing layout is copied, you can then change the new copy as required.  For example, 

a detailed Profit and Loss Statement can be copied and changed to create a summary Profit and 

Loss Statement.    

 

 Copy to Layout # 

Enter the new layout number. 

 

 Copy to Description 

Enter the description of the new layout. 

 

 

A- Add a Sub-Account to this Layout 

Select A to add a new sub-account to the existing layout, by copying from a sub-account already 

within the layout. 

 

 Sub-acct Section # 

Enter the section of the account you wish to copy from and to. 

 

 

 Copy from Sub-Acct 

Enter the number of the sub-account you wish to copy from. 

 

 Copy to Sub-Acct 

Enter the number of the new sub-account you wish to create within this layout.  
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N- New Layout with a New Sub-Account 

Select N to copy only one sub-account from the existing layout to a totally new layout. 

 

 Copy to Layout # 

Enter the new layout number. 

 

 

 Copy to Description 

Enter the description of the new layout. 

 

 

 Sub-Acct section # 

Enter the section of the account you wish to copy from and to. 

 

 

 Copy from Sub-Acct 

Enter the number of the sub-account you wish to copy from. 

 

 

 Copy to Sub-AcctEnter the number of the sub-account you wish to appear in the new layout. 

 

 

Making SAF Layouts 
 

This selection allows you to automatically make SAF (Source and Application of Funds) layouts 

from an existing balance sheet layout.  In order to make accurate SAF layouts, the balance sheet 

layout you select must contain all balance sheet accounts.    

 

The SAF layouts that can be made are:  

 

Statement of Changes in Financial Position 

Analysis of Changes in Working Capital 

Cash Flow Statements  

 

These statements will contain standard predefined headings and subtotals.   
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Source and Application of Funds 

The layout statement types C (for Cash Flow Statement), F (for Statement of Changes in 

Financial Position), and W (for Analysis of Changes in Working Capital) are for the three Source 

and Application of Funds Reports.  They use special processing and require a fixed structure to 

produce the correct results.    

 

You may also create them manually or change the automatically produced SAF layouts.   

 

Do not violate the basic structural requirements for these statements, or the statements will 

produce incorrect results.    

 

 

SSRC (Start of Sources [of Funds]) Code 

This code is used only in the layout for statement type F (Statement of Changes in Financial 

Position).  It identifies the start of the accounts that are sources of funds.    

 

SUSE (Start of Uses [of Funds]) 

This code is used only in the layout for statement type F.  It identifies the start of the accounts 

that are uses of funds.   

 

BSNI (Balance Sheet Net Income) Code 

This code is valid for SAF statement types C and F.  The calculated net income will appear at 

this line of the Financial Statement.   

 

You are requested to enter "Prt/Accum?" (Print/Accumulate?). Enter P or A, as appropriate.  If P 

is entered, "PRT COL" will be requested.  Enter 1, 2, or 3. 

 

Except for type E statements, the parentheses control is always assumed to be D, since net 

income is typically credit.   

 

For type E statements, you can reverse the balance of BSNI and override the parentheses control.  

This is useful when creating statements showing reconciliation of net income to cash flows from 

operations. 

 

SAF Types 

To understand these SAF statements, you must first be familiar with the SAF types.   
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Cash Flow Statement 
 

The Cash Flow Statement shows the effect of all the balance sheet accounts and net income upon 

cash during the current period and year-to-date.  It shows the beginning balance of cash at the 

start of the period and year, all the sources and uses of funds, and a final cash ending balance.    

 

All five types of SAF accounts (entered in the Chart of Accounts) and the BSNI (balance sheet 

net income) should be included in the balance sheet layout, from which the SAF layouts will be 

created. 

 

All cash accounts must be coded with an SAF type of C (in the Chart of Accounts File) or cash 

will not be handled correctly.  The cash accounts are summarized to produce a cash beginning 

balance, so individual cash accounts will not print on the Report.    

 

Cash accounts will accumulate, regardless of the "PRT/ACCUM" or PAT options you enter for 

them on the layout.  Therefore, if you manually create this layout, you must code a subtotal 

(SUB#) following the last cash account.    

 

Parentheses controls for accounts, subtotals, and PAT's are ignored on this statement, as on all 

SAF statements.   

 

There is a recommended format in which the detail of the Report appears, but the order of 

accounts in the Report is flexible.  The Cash Flow Statement Layout is created automatically in 

this format: 

 

1. First, all the cash accounts are coded.  These accounts are followed by a SUB2 for the 

total beginning balance of cash.    

2. Then the BSNI (balance sheet net income) code, followed by non-cash charges against 

income (type N) accounts, and a SUB1 for the total from operations. ("Operations" being 

BSNI minus non-cash charges against income.)  

3. After the total from operations come the current asset accounts, then the current liability 

accounts, and then the funds flow accounts.  

4. Next will follow a SUB1 for the total sources or uses of funds, then a SUB2 for net 

increase or decrease in cash, and finally a SUB3 for the cash ending balance.   

 

  



General Ledger                                     Copy Layout / Make SAF 

Samco Power Accounting 20.203 

Statement of Changes in Financial Position 
 

The Statement of Changes in Financial Position calculates the changes in working capital, using 

the non-current assets and liabilities, net income, and non-cash charges against income.  This 

provides a picture of the effects of these accounts on the working capital.    

 

The non-current assets and liabilities (also called funds flow accounts) are put into separate 

sections, depending on whether they are sources or uses of funds.  (An increase in an asset is a 

use of funds and an increase in a liability is a source of funds.  The opposite is true for 

decreases.)  

 

The BSNI (balance sheet net income) code, non-cash charges against income (SAF type N), and 

funds flow accounts (SAF type F) are included in this statement.  The funds flow accounts all 

appear twice in the layout:  once following the SSRC function code (start sources of funds), then 

again following the SUSE function code (start uses of funds).   

 

The sources and uses must appear at the end of the Report, after the BSNI and non-cash charges 

against income.  When the statement is printed, an account is printed as a source only if its 

amount is a credit and as a use only if its amount is a debit.  Consequently, each account will 

appear only once on the statement, even though it appears twice in the layout.    

 

The format which we recommend, and the format of the layout produced by Make SAF layouts, 

is as follows:  

 

1. First, the BSNI code, then the non-cash charges against income, and then a SUB1 for the 

total from operations.   

2. Next, an SSRC code, followed by all the funds flow accounts, and a SUB1 for the total 

sources.    

3. Then, an SUSE code, followed by all the funds flow accounts again (the exact same 

accounts as in the sources section), followed by a SUB1 for the total uses.   

4. Finally, a SUB2 for the net increase or decrease in working capital.   

 

 

Analysis of Changes in Working Capital 

The Analysis of Changes in Working Capital shows changes in current assets, minus changes in 

current liabilities, giving changes in working capital.  Its total should match the changes in 

working capital, which is the last line of the Statement of Changes in Financial Position.    

 

Cash, current asset, and current liability accounts should be included in the layout.  Parentheses 

control for accounts will be ignored.    

 

The format which we recommend, and the format of the layout produced by Make SAF layouts, 

is as follows: 

 

First all the cash accounts, then all the current assets, followed by a SUB1 for assets, whether an 

increase or decrease.   
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Then all the current liabilities, followed by a SUB1 for liabilities, whether an increase or 

decrease.  

Finally, a SUB2 grand total for the net increase or decrease in working capital. 

 

Select Generate SAF layouts from the Financial Statement Layouts Menu.  (GL > Statement 

Layouts > Generate SAF Layouts ) 

 

This is the screen you see: 

 

 
 

Entering the following information: 

 

 

[?] 1. Balance Sheet Layout # 

Enter the layout number of a Balance Sheet layout form the Financial Statement Layout File. The 

description will be displayed to the right of the layout number. The Balance Sheet layout must 

contain all balance sheet accounts, in proper order, for the created SAF layouts to be accurate. 

 

 

2. Changes in financial position layout # 

Enter the number of the new layout to be created for the Statement of Changes in Financial 

Position. 

 

 

3. Description 

Enter the description of the layout for this statement. 

 

 

4. Changes in working capital layout # 

Enter the number of the new layout to be created for the Analysis of Changes in Working 

Capital.  
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5. Description 

Enter the description of the layout for this statement. 

 

 

6. Cash flow layout # 

Enter the number of the new layout to be created for the Cash Flow Statement. 

 

 

7. Description 

Enter the description of the layout for this statement. 

 

 

Some Notes on Making SAF Layouts 

There are a number of ways in which the SAF Report layouts might be made incorrectly. 

 

For example, vital accounts such as cash or current assets might be omitted from the Balance 

Sheet. This would make an incomplete and incorrect SAF statement. 

 

Accounts might be in the balance sheet layout which, are not actually balance sheet accounts 

(which do not have a B for a Financial Statement type in the Chart of Accounts File). In this 

case, an error Report will be printed and the SAF layout will not be created. 

 

One or more accounts might not have an SAF type designated in the Chart of Accounts File. An 

Error Report will be printed, showing all accounts, which do not contain an SAF type, and the 

SAF layout will not be made. 

 

If an error Report is printed during the generation of SAF layouts, you must determine which 

errors occurred and make the necessary corrections, either to the Balance Sheet Layout or to the 

Chart of Accounts, then make SAF layouts again. 

 

If you want more levels of subtotaling or different headings and literals from the ones 

automatically made, you may change these, using the Enter option of Maintain Financial 

Statement layouts. 

 

An SAF Report layout made from a Balance Sheet with more than 999 actual accounts and 

account totals (PAT’s) will not include accounts after the 999th 
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Chapter 21 - Get Distributions 
 

 
Use this selection to transfer information from the Accounts Receivable, Accounts Payable, 

Canadian Payroll, Inventory Plus, and Job Cost distribution files to the General Journal 

Transaction File.   
 

This is also referred to as "interfacing" G/L to other Packages. 

 

Before running Get distributions, any outstanding entries in the General Journal Transaction File 
must first be posted to the General Ledger Transaction File. 

 

 

NOTE:  We strongly recommend that, before running this selection, you make a backup copy of 
the data files you are about to transfer. 

 

 

To Begin 
Select Get distributions from the G/L Menu. 

 

If there are un-posted entries in the General Journal Transaction File, a message displays telling 

you so.  To continue, you must post the entries first, and reselect this function.  If the General 

Journal Transaction File is empty, you see:  
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1. Interface with Which System? 

Enter the system (Package) from which that information will be transferred. Enter either: 

  

 AP  -Accounts Payable 

 AR  -Accounts Receivable 

 IC  -Inventory Control 

 FA  -Fixed Assets 

 JC  -Job Cost 

 PC  -Payroll 

 MP -Menu Point 

 BR  -Bank Reconciliation 

 

 

2. Cut-off Date 

Enter the last date for which entries will be transferred from the other system’s distribution file to 

the General Ledger Transaction File, or press [Enter] to use the ending date of the current 

accounting period. 

 

 

3. Type of Interface 

This determines the method of compression that will be used during transfer.  (See the 

explanation in the Summarize General Ledger Chapter.)  Enter : 

 

 P  -Period compress a maximum of two summarized entries will be created for each 

account for each accounting period. 

 D  -Date compress, a maximum of two summarized entries will be created for each 

account for each separate date. (The Journal number will also be retained.) 

 N  -No compress 

 G  -Compress, using the account compress code  
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NOTE:  See the Chapter titled Summarize General Ledger for a discussion of why a maximum 

of two entries are created. 

 

 

If you select N, all entries will be transferred in full detail with no summarization. 

 

These three choices apply for all accounts.  The fourth choice, G, applies on an account-by-

account basis.  If you select G, summarization is done according to the compression code in the 

Chart of Accounts record for each account. 

 

 

4. Purge Distribution File? 

This determines if distributions will be purged (completely removed) from the distribution file in 

the other Package as they are being transferred to the General Journal Entry File. 

 

If you don’t want to purge the distribution file during the interface, you can still purge the 

distributions at a later time from within the Package from which the information is being 

transferred. 

 

Answer Y to purge the distributions in the other Package, or N to keep them on file in the other 

Package. 

 

 

5. Use Vendor Name or Reference From A/P Distributions? 

This field is available for entry only if A/P is being interfaced, and either N (no compress), or G 

(compress, using the account compress code), is selected in field 3. 

 

For each payable, both the Vendor’s name and a reference are stored in the A/P distribution file, 

so you may choose which one to transfer to the general Journal. You should consult your 

accountant as to which one should be used. 

 

• Transferring the reference lets you see what was purchased (if that is what you entered in 

the reference field for the payable). 

 

• Transferring the Vendor name lets you see from whom the purchase was made. 
 

R   -To transfer the reference  

V   -To transfer the Vendor’s name. 
 Format:  1 character   
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Note on Transferring Distributions 

A Distribution to G/L File contains debits and credits (created by transactions posted in the 

particular Package) that must be transferred to General Ledger from that Package.  Accounts 

Receivable, Accounts Payable, Inventory Control, Payroll, Job Cost, Bank Reconciliation, Fixed 

Assets, and Menu-Point each contain their own individual Distribution to G/L Files. 

 

Prior to running Get Distributions, you should first print the Distribution to G/L Report.  All 

accounts should be printed. The date range should be for the dates for the accounting period 

which you are interfacing to the G/L.  Do not specify that the file is to be purged!  If you purge 

distributions before transferring them, you will have to enter these distributions again manually 

using General Journal. This defeats the purpose of the Get distributions selection. 

 

The purpose of printing the Distribution to G/L Report is to obtain an accurate list of the debits 

and credits that are to be transferred to G/L. You may wish to print the Report to disk and then 

obtain a printed copy using Print Reports from disk. In this way, you can retain a copy of the 

Report on the hard disk in case a spare copy of the Report should be needed. 

 

After printing the Report, you should than back up your data files and run Get Distributions.  

When running this selection, you should specify that the distributions are to be purged as they 

are copied to the General Journal Transaction File. If a power failure (and computer crash) 

should occur while running Get distributions, simply restore your backup and repeat the 

procedure. 

 

An alternative procedure is as follows: 

 

1) Back up your data files. 

2) Run Get distributions, specifying that the distributions as they are not to be purged. 

3) Run Distributions to G/L, specifying that the file is to be purged and that only interfaced 

distributions are to be purged. 

4) Print the General Journal Entry Edit List. The debits and credits printed on the edit list 

should be comparable to the debits and credits on the Distribution to G/L Report, 

provided that you have followed this procedure each period.  If you have not purged the 

Distribution File in a previous period, then the Reports will not be comparable. 

 

Note that if you specify that distributions are not to be purged by Get distributions, and you run 

Get distributions again for the same Package, you will still never transfer the same distribution 

from the Package to G/L more than once, because Get distributions prevents this. Thus, if after 

step (2) in the alternate procedure above you discover additional transactions for the accounting 

period which have not yet been entered into the Package, simply enter and post these transactions 

in the Package, and repeat the alternate procedure starting with step (1). 

 

If distributions are transferred for accounts that are not defined in the Chart of Accounts file, you 

will have to either add these accounts to the Chart of Accounts File before these entries can be 

posted or delete the entries and re-enter them for a different (valid) account. 

The program does not check the validity of the information being transferred. Please verify that 

all accounts in the Valid G/L Account File are in your Chart of Accounts File as well.  
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After Interfacing 

Use General Journal to change, delete, or print an edit list of the entries transferred.  Post the 

entries to the General Ledger Entry File when you are satisfied they were transferred correctly. 

 

Entries transferred to General Ledger using Get distributions are easily recognized.  The source 

field will contain the name of the Package from which the entry was transferred, and the 

reference field will contain a description of the original entry. 

 

If the entry has been compressed by date, the reference field shows “NET CHANGE FOR 

DATE/JRNL”.  “Jrnl” means “Journal number”. 

 

If the entry has been compressed by date, the reference field shows “NET CHANGE FOR THE 

PERIOD”. 

 

If the entry has not been compressed, the reference field depends on the origin of the 

distribution file; that is, 

 

Package  Reference 

 AP   -Vendor name or reference, depending on your choice in field 5 

 AR   -Customer name 

 IC   -Type 1 = Income 

    -Type 2 = Cost of goods sold 

    -Type 3 = Inventory adjustment 

    -Type 4 = Inventory liabilities 

    -Type 5 = Inventory value 

 JC   -From > Job Cost 

 PC    -Employee name 

 

 

If the entry is compressed, the document number is blank.  Otherwise, the document number 

depends on the origin of the distribution file, namely: 

 

Package  Document number 

 

 AP   -Invoice number for expenses and new A/P added 

    -Check number for payments and discounts 

 AR   -Document number used in A/R (typically, Invoice number)  

 IC   -Blank 

 JC   -Blank 

 PC   -Check number 

If entries are compressed by period, the Journal number is lost.  Otherwise, the original Journal 

number is retained.  (When entries are compressed by date, this means they are in effect 

compressed by date by Journal. 
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Chapter 22 - Summarized (Compressed) G/L Transactions 
 

This selection is used to summarize (compress) the entries in the General Ledger 

Transaction File, either by date or by period (depending on which method you specified for 

each account in Chart of Accounts). 

      

Run this function after Financial Statements have been printed for the current period. 

 

Before You Begin 

*** CAUTION *** 

 

While your GL entries in the transaction file are summarized, full detail is available in the 

Detail History File. 

 

General Ledger > F2 > Compress GL transactions 

 

1. Enter the cut-off date for the compression 

2. Enter the starting and ending account numbers. Enter either a single GL account 

number of a range of account numbers. 

3. Select the compression option. These options are the same as are used for the Get 

Distributions feature. 

 
D -For Date (one credit & one debit for each day) all accounts in range 

 selected 

 

When summarizing by date, all entries on a single day for one account are 

summarized into a maximum of two entries for that account: 

  one entry for the debit amount, and one entry for the credit amount.   

 

Also, amounts of entries marked as "correcting entries" are subtracted from the 

appropriate debit or credit amount before the summary debit or credit amount is 

calculated.    
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For example, if an asset account has a debit entry for $100 and also has a credit 

entry (marked as a "correcting entry") for $10, the summary entry is a debit for 

$90. 

 

If debits and credits exactly cancel each other, no summarized entry is generated.    

 

For example, Account #: 6000-100, "SALARY AND WAGES EXPENSE", 

contains the following entries:           

 

 Date    DR    CR   CORRECTING ENTRY? 

 

3/6/20  10.00     N 

3/6/20     10.00   Y 

3/6/20  345.80     N 

3/6/20  22.44     N 

3/6/20  182.40     N 

3/6/20  92.90     N 

3/29/20  252.08     N 

3/29/20  165.04      N 

             1,048.22        32.44          

After the entries are summarized, the file contains the following for this account:          

 

 Date    DR    CR   CORRECTING ENTRY? 

 

3/6/20 621.10     N 

3/6/20   22.44   N 

3/29/20 417.12     N 

 

The "Source" field of a summarized entry is set to "Comp" (for summarized), and 

the "Reference" field is set to "Entry summary this date".  

 

P -For Period (one credit & one debit for each fiscal period) all 

 accounts in range selected 

 

When summarizing by period, all entries for one account are summarized into a 

maximum of two entries for each accounting period.  Correcting entries are 

handled as described above for summarizing by date. 

 

Summarizing the entries of the preceding example (by period) results in the 

following:   
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Account #: 6000-100 SALARY AND WAGES EXPENSE  

 

 Date    DR    CR   CORRECTING ENTRY? 

 

3/31/20 1038.22    N 

3/31/20   22.44   N 

 

 

NOTE: Summarizing by period assigns the ending date of the period to the  

summarized entry. 

 

 

"Comp" (which stands for "Compressed") will be assigned as the source for the 

entry, and "Entry summary this period" will be assigned as the reference.  

 

 

G -To use the compression code of the GL account.  Your General Ledger 

 entries are then summarized. 

 

 

Notes on Compress G/L Transactions 

 

The purpose of this selection is to remove detail from the General Ledger Transaction File.  

 

2 Reasons:   

 

(1) You no longer need to see the detail and you would like your General Ledger Reports to be 

shorter. 

 

(2) You have so many detailed entries on file that processing is taking a long time. 

 

After you summarize, the total number of entries in your General Ledger Transaction File will be 

reduced.  This will speed up most other G/L functions. 

 

You can also now recover some disk space by rebuilding the TRXFIL.DAT file.  Refer to the 

appendix titled File Recovery Utilities in the Installation and System Guide for instructions on 

how to rebuild a file. 
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Chapter 23 - Year End  
 

Closing of Year End 
 

This selection is run at the end of your accounting year as part of the closing procedure.   

 

1 Print pre-closing Report-: This function is used to print the Year End Pre-Closing 

Report, which shows the net profit (loss) entries that will be made by Post closing entries 

when it is run.  This Report may be printed to verify the net profit for the year and should 

also be run Prior to closing G/L so that any final corrections can be made.  

 

2.Archive G/L data –The GL module retains all prior year information via the Detail 

history function, you may still want to Archive the G/L data and this function takes the 

G/L data for the closing year and stores it under a new Company ID.  

This allows you to refer back to the transaction detail for a prior year at any point in time. 

Users need to be out of the system to run this successfully.  

 

NOTE:  Before creating an Archive, and closing the year, be sure all correcting 

entries/adjustments have been entered for the year you are closing.  

 

3.Post Closing Entries Register/Report -This function is used to ‘Close’ the fiscal year. 

Once closed you will not be able to enter in any correcting or adjustment entries  

 

Please note:  When doing a year-end close, DO NOT run it more than once.  Running 

it again can over-write all entries and cause errors.  
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***IMPORTANT NOTE*** 

There are some basic rules in Samco G/L regarding the printing of BSNI (Balance Sheet 

Net Income). BSNI is the code which you include on your Balance Sheet layout in order to 

print the net profit (or loss) for the period. The rules regarding BSNI are as follows: 

 

Keep note of the fact that Statements need to be run in sequential order 

 

• Whenever Financial Statement printing begins (by selecting Print Financial Statements), 

BSNI is set by the software to be the total NET PROFIT (or LOSS) for all profit and loss 

entries on the file. BSNI is set to be the total NET PROFIT (or LOSS) whether or not you 

specified that account balances are to be recalculated. 

 

• The BSNI which is set at the beginning of Financial Statement printing should be used to 

show NET PROFIT (or LOSS) on the Balance Sheet for the entire Company. 

 

• Whenever a P&L or a supporting schedule for a P&L statement is printed, BSNI is set to 

the last amount printed on the statement. 

 

NOTE: Financial Statements for a New Year will not be able to be generated until the prior 

year-end is closed.  You will get an error.  

 

 

If You Are Not Ready to Close the Year 
 

It often occurs that you must start your new fiscal year before the old fiscal year is closed.  This 

occurs, for example, if your fiscal year ends on June 30th of the year, but the final adjusting 

entries for the fiscal year are not made available to you until August.  In this case, you must start 

your new fiscal year before closing the previous year. 

 

If you are not ready to close your General Ledger at fiscal Year End, you can take the 

following steps so that you can process information for the New Year: however, you will 

not be able to do a comparison with the New year, to the last year until the last year is 

closed.  

 

(1) Change the accounting periods to reflect the New Year.  (check that the Flag in 

Control Information is set to ‘Y’ to allow posting outside of the current year.)  

 

NOTE: We recommend setting this to Y if you are leaving your prior year open for 

adjusting entries.   

 

Option:  If you want to leave your accounting periods to stay at the previous year and  

(2) Make entries as usual.  The Trial Balance will include a beginning balance for your P&L 

accounts from last year until you close.  
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(3) When you are ready to close, change the accounting periods back to last year.  Make 

sure that the last day defined here is the last day of the year you intend to close. 

 

(4) Perform the End of Fiscal Year checklist in the Chapter 4> Titled ‘Guide to Daily 

Operations’. 

 

Do not make a Journal entry for "retained earnings".  The software will do this 

automatically. 

 

(5) Run Print Pre-Closing Report (if needed) followed by Post Closing Entries.(same 

report) 

 

 

Actions Performed by Post Closing Entries 
 

Review the following: 
 

This is a list of the actions performed by Post Closing Entries (which creates Post Closing 

Register): 

 

a. Automatically adds one year to all accounting period dates in the Accounting Period 

File: Sets the current period and the reporting period to the first new accounting period.   – 

 

 -You can manually change the accounting periods, current period, and reporting period if you 

wish. 

 

b. Sets the "comparative amounts" in the Chart of Accounts File for each G/L account.  

After Post closing entries is run, the comparatives for an account will contain the balances 

for that account for each period of the fiscal year just closed.   

 When comparative Financial Statements are run in the New Year, you will then be able to 

compare New Year balances against comparatives from the fiscal year just closed.  The 

"comparative amounts" stored by  

  

 NOTE: Post Closing Entries are called the "new comparatives" throughout this Chapter.  

They are the new comparatives which are set up for use in the new fiscal year, although their 

amounts correspond to the account balances from the prior year. 

 

c. Allows you to set budgets for G/L accounts in the Chart of Accounts File for the New Year.  

The budgets may either be left as they are currently, set to zero, or set in relation to the "new 

comparatives", as described above. 

 

d. Clears all entries from the General Ledger Transaction File for the year being closed.  Entries 

already made for the New Year are left unchanged.  
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e. Creates balance forward entries for all balance sheet accounts.  The date for these entries is 

the last day of the fiscal year being closed. 

 

f. Moves the amounts for each period to the prior-year comparative fields in the Chart of 

Accounts File. 

 

g. Automatically posts the net profit (loss) to the retained earnings account entered in Control 

information. 

 

h. Prints the Year End Closing Report/Register.   

 

 NOTE: As mentioned at the beginning of this Chapter, you may print the Year End Closing 

Report (prior to Closing the year) when Post Closing Entries is run, in order to view the 

information that will be printed on the Year End Closing Report/Register. 

 

Before You Begin 

We recommend that BEFORE you select this function, you do this: 

 

a. Have entered in all adjustments/corrections  

b. Printed closing Financial Statements, including a detailed year-end Trial Balance. 

c. Created a backup copy of all G/L data files if you do not use the Archive G/L data 

function. Off-site backup is always a good idea regardless of any other precautions. 

 

You will then have a permanent record of the activity for the fiscal year. 

 

 

To Begin 

Select End of Year > Print Pre-Closing Report from page 2 of the G/L Menu.  

 

NOTE: You will not be able to continue IF: 

 

• Any entries exist in the General Journal Transaction File (which means they have 

not yet been posted to the General Ledger Transaction File), or  

 

• Another User is using General Journal.   

 

• If today's date is during the fiscal year being closed, you will see a warning message   
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Print Closing Entries Report 
 

This selection will print the Year End Closing Report/Register, which shows what net profit 

(loss) entries Post closing entries will make. 

If this is run prior to ‘year-end closing’ the Closing Register does not perform any other 

function except showing what will occur when Post closing entries is run. (This way you can 

have a comparative. of the Pre-Closing Report, prior to posting) Save to disk for easy reference.)  

 

The Report is printed in two sections.: 

 

-  The first section is titled "Closing Entries" and will show all P&L 

accounts with the amount totals to be posted.  

   **The second section is titled "Retained Earnings Entries"**, which may 

also be referred to as Surplus/Deficit. This shows the profit (loss) amount to 

be posted. When closing year-end, do not make a Journal entry for "retained 

earnings".  The software will do this automatically. 

 

 

Archive G/L Data 
 

The General Ledger module retains all prior year information for viewing and reporting via the 

Detail history function. Although there is no need to Archive G/L data to another Company 

because it is all readily available, you may want to archive the G/L data to retain the compressed 

view of the transactions.  This selection creates a new Company ID, and copies the G/L data files 

and any common Company data files (Company file etc.) to this new Company ID. The purpose 

of which is to allow Users to inquire into prior year financial data in detail without disturbing 

current financial data. 

 

Select End of Year > Archive G/L Data from page 2 of the G/L main Menu. On the next screen, 

enter a new Company ID and a name for the new Company.  After a period of processing you 

will be returned to the G/L main Menu. 

 

To Report and view last year’s data, simply go into new Company ID the next time you start up 

your Samco Power Accounting or select Change Company number from page 2 of the G/L main 

Menu. 

 

 

Post-Closing Entries 
 

Select End of Year > Post Closing Entries from page 2 of the G/L main Menu. After a screen 

which describes the End of Year functions, this is the screen you see: 
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From this screen you can confirm or change your new accounting periods.  

 

- (Note: The periods are set to one-month increments) If you wish to change the 

accounting periods, use the same procedures described in the Accounting Periods 

Chapter. 

 

The purpose of the next screen is to allow you to set new-year budgets for each of your G/L 

accounts in the Chart of Account File.   
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Budgets 
 

You may select one of three different methods for handling the - New-Year Budgets: 

 

 

1) Leave Budgets as they are. 

In this case, the budgets for the New Year will be the same as they were for the fiscal 

year being closed. 

 

2) Set Budgets to zero. 

In this case, all budgets will be set to zero. 

 

3) Set Budgets to new comparatives. 

After Post Closing Entries/Register is run, the comparatives for an account will contain 

the balances for that account for each period of the fiscal year just closed.   

 

When comparative Financial Statements are run in the New Year, you will then be able to 

compare New Year balances against comparatives from the fiscal year just closed.   

 

NOTE: The “comparative amounts” which are created and stored by Post closing entries 

are call the “new comparatives”.   

They are the new comparatives which are set up for use in the new fiscal year, although 

their amounts correspond to the account balances from the PRIOR year. 

 

 

If you select to set your budgets based upon the “new comparatives”, (which are created when 

posting the entries), you are basing your New Year budgets on performance in the prior fiscal 

year. 

 

NOTE: If you choose - “Set Budgets to New Comparatives”-; you see a screen requesting you to 

enter the following: 

 

 

1.  Change By 

This field determines how you want to change the new comparative amounts to produce 

the budget amounts. 

 

NOTE:  Comparatives are automatically calculated, they can be used to set or create 

budgets.  

 

You may either: 

 

1) Use the new comparative amounts as they are, (no change) or 

 

2) Increase or decrease the comparative amounts by a specific dollar amount or, 

 
3) Increase or decrease the comparative amounts by a percentage. 

Enter either: 
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  A -Change by Amount 

  P -Change by Percent 

  N  -No change 

 

 
 

 

2. Amount of Change  

If you selected “No change” in field 1, this field is skipped. 

 

 

Change by Amount 

If you selected “Change by amount”, the Budget amounts will be the 

Comparative amounts plus the dollar amount you enter here. 

  The dollar amount may be positive for an increase, or negative for a decrease. 

 

Change by Percent 

If you selected “Change by percent”, the Budget amount will be the comparative amount, 

increased by the percentage you enter here. The percentage can be positive or negative. 
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Processing 

 

Once you have described the handling for the new-year budgets, Year End 

processing begins.  The first step is to print the Year End Closing 

Report/Register.  During processing, a screen appears showing the account 

number being processed. 

 

 

Processing Results 

 The following are the results of running Post Closing Entries (which creates a post-

closing register): 

 

 

The Accounting Period File has been updated for the New Year.  (You may 

need to update the current period and reporting period at this point, by using 

Accounting periods, if there were delays in closing your fiscal year.) 

 

The comparative amounts for each account in the Chart of Accounts have been 

updated to be the ending balances for the periods of the fiscal year just closed. 

Budgets for each G/L account have been set for the New Year.  Budgets are set 

according to your wishes, as entered during Post closing entries. 

 

All entries from the fiscal year just closed have been cleared form the General 

Ledger Transaction File.  (Entries already made for the New Year are left 

unchanged.) 

 

Balance forward entries for all balance sheet accounts have been created.  The 

date for these entries is the last day of the fiscal year just closed.  

 

If. A net profit (loss) entry has been made to the Retained Earnings Account 

entered in Control information. If” (Varies by sub-account)” was entered for 

the retained earnings account, then individual entries have been made for each 

of the sub-accounts of the retained earnings account. 

 

 

 

After You Run This Function 

After you run this function, the total number of entries in the General Ledger Transaction File 

will be reduced. This will speed up processing most other G/L functions but to recover the hard 

disk space which these entries occupied see appendix titled:  File Utilities, rebuild a file.
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Chapter 24 - Ledger Connection 
 
Introduction 

Ledger Connection is an easy to use utility program which enhances the functionality of the 

General Ledger System; providing advanced trial balance reporting, importing chart of account 
budgets from a file created by a spreadsheet, and a simple method of extracting data for use with 

today's most popular spreadsheet applications. 

 

 

Extended Trial Balance 

The Extended Trial Balance function within Ledger Connection takes the standard Trial Balance 

Report a step further, by incorporating: 

 

• Sorting by account section 
• Summarizing by account section 

 

 

Spreadsheet Link 
Today's popular spreadsheet applications provide Users with an ideal forum for manipulating, 

presenting, and reporting data.  By using the extraction facilities built into Ledger Connection 

you will be able to take data from your General Ledger and import it into a spreadsheet, bringing 

ease of use to: 
• Analysis of current and year-to-date data 

• Restructuring of comparative data 

• Development of and modification to budget data 

• Additional reporting formats 
• Importing Budgets 

•  

In addition, L/C allows you to prepare budgets in a spreadsheet, save them to an ASCII file, and 

import them into your G/L chart of accounts.  
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How is the G/L Data Extracted? 
 
First of all, Ledger Connection utilizes the Financial Statement layouts set up in the General 

Ledger as a basis for data extraction.  From there, you create selection criteria which stipulate 

what you want pulled out, how you want it reported, and the name of the file to send the output 

to. 
 

Once the extraction process is run, a delimited ASCII file is created which can then be retrieved 

into your spreadsheet application. 

 
 

To Start Samco Ledger Connection 
 

Select Ledger connection from the General Ledger Menu 

 

The Ledger Connection Menu then appears: 
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Ledger Connection 

One of the functions of the Ledger Connection module (L/C), included with your General 

Ledger Package, is to generate output files of your financial data for use in a spreadsheet. 

L/C uses Financial Statement layouts to create these text files. 

-  

-  

Extract Specifications 
 

To Begin 

Select Extract specifications from the L/C Menu. 
 

From the Extract Specifications Menu, select Enter Extract Specifications.   
 

 

 

 

New and Existing Specifications 

From this screen you can work with both new and existing specifications. 

 

 

*1. Specification # 

Enter the number that identifies the specification (the number cannot be zero) OR: 

 

   [F1]  -To scan through the specifications on file 

 
Format:  999 

 

We recommend that you group specifications numerically so that it will be easy to select all 

specifications within a particular numeric range for printing.  For example, assign specification 
numbers 1 to 100 for Financial Statements for monthly reporting, 101 to 200 for quarterly 

reporting, and 201 to 300 for year-end and budgeting Reports. 
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2. Layout # 

Enter the existing layout number to which these specifications will be applied, OR: 

 

  [F1] -To scan through the layouts on file 
 

  [F2] -To print data for "All" G/L accounts in account number sequence. 

 

 
NOTE: Only active G/L accounts (i.e. accounts with postings) are included in the 

extractions.  Budgets and/or comparatives may be included. If an account has one  

 

 

3. Selection Type 

Ledger Connection can extract data for importing into a spreadsheet model in statement or 

planning format.  The statement format provides actual and / or budget and / or comparative data.  

The number of periods of data extracted is determined from the G/L accounting period file. 

 
The planning format presents up to 13 period balances of actual and / or budget and / or 

comparative data.  As with the statement format, the number of periods of data extracted is 

determined by the G/L accounting period file. 

 
  [S]  -To generate a statement style format file 

  [P]  -To generate a planning style format file 

 

NOTE: For further information on maintaining accounting periods, refer to the Chapter 
Accounting Periods.  
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4. Single Row Output?  

 

 

5. Output File Name 

Enter any alphanumeric file name with no intervening spaces. When Perform data extracts is 

run, a file is generated in your primary Samco application directory (C:\SSI under usr/ssi in 

Xenix/Unix for example) with a .PRN extension.  
 

Format:  8 characters 

 

 
NOTE:  Do not use symbols such as !, ?, &, % etc. in your file names.  Failure to adhere to 

proper names can result in problems when extracting the data. 

 

 
It is recommended that each of your specification files be named differently in order to eliminate 

the possibility of overwriting an existing extracted file. 

 

 
Extract Next Run ? 

This determines if the extracting of data for this specification will be done the next time Perform 

data extracts is run.  Answer [Y] or [N]. 

 
 

Section/Group Selection 
 

The number of times you are prompted in the next set of fields depends on how many sections 

your G/L account structure is.  For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 
or twice respectively. 

 

From the section prompt, press [F1] to select "All" values for this account section, OR: 

 
 

   [F2] -To select a specific section value.  This is most useful when   

    selecting a section which may have multiple accounts within the   

    same section. 
 

   [F3]  -To select a section group.  For more information on sub-account 

groups, see the Chapter titled Sub-Account Groups.  

 
The second input screen is displayed for further selection criteria.  The format of the screen is 

dependent on the 3. Selection type specified on the first input screen (S = Statement Format, P = 

Planning Format). 
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Planning Format 
 
If the selection type is [P], the following screen appears: 

 

 

1. All Amounts Described Below ? 

 
    [Enter]   -To include actual, budget, and comparative figures in the data 

extraction, OR: 

   [N]  -To answer each selection individually. 

    [Y]    -The cursor will skip fields 2 through 4.  Make any necessary  
      changes. 

   [Enter]   -"Field number to change ?". 

 

 

2. Actual ? 

 

   [Enter]   -To exclude actual figures from the data extraction, OR: 

   [Y]  -To include actual figures in the data extraction. 

 
 

3. Budget ? 

 

   [Enter]   - To exclude budget figures from the data extraction OR:  

   [Y]  - To include budget figures in the data extraction. 
 

 

4. Comparative ? 

 

   [Enter]     -To exclude comparative figures from the data extraction OR: 
   [Y]  -To include comparative figures in the data extraction. 

 

Make any necessary changes, and press [Enter] at "Field number to change ?".  
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Statement Format 
 
If the selection type is [S], the following screen appears: 

 

 

 
 

 

 

1. 14 All Amounts Described Below ? 

 
   [Enter]   -To include all figures below in the data extraction OR: 

 

   [N]  -To answer each selection individually. 

 
    [Y]   - The cursor will skip fields 2 through 12.  Make any necessary 

 changes, and press [Enter] at "Field number to change ?". 
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 [Enter] -To exclude the corresponding figure from the data extraction OR: 
 

   [Y]  -To include the corresponding figure in the data extraction. 
 

 

 

Deleting Specifications 
 

To delete an extract specification that is already on file, enter the specification number, or press: 
[F1] to scan through the specifications on file.  Once the specification you wish to delete is 

displayed, press: 

[F3] to delete and confirm. 

 
 

Clear Extract Selections 
 

Select Clear extract selections from the Maintain extract specifications Menu. 

 

Use this selection to set the "Extract next run ?" field to [N] for all extract specifications on file.  
All specifications will then be set so that none will be extracted on the next Perform data 

extracts run.  
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Generalized Extract Selection 
 
Select Generalized Extract Selection from the Extract Specifications Menu. 

 

 

This function allows all specifications (or any group of specifications) to be selected for 

extraction without having to change each "Extract next run ?" answer to [Y], one by one, in field 

5 of Enter extract specifications. 
 
You can also select a specific section value, or an account section group to be selected 

automatically. 

 

1. Starting Specification # 

2. Ending Specification # 

Enter the range of specifications to select for extraction.  Follow the screen instructions. 
 

Section/Group Selection 

The number of times you are prompted in the next set of fields depends on how many sections 

your G/L account structure is.  For example, if you have a 3-section account number, you will be 
prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 

 

From the section prompt: 
 

   [F1]    -To select "All" values for this account section, OR: 

 

   [F2]  -To select a specific section value.  This is most useful when   
      selecting a section which may have multiple accounts within the  

      same section. 

 

   [F3]  -To select a section group.  For more information on sub-account 
 groups, see the Chapter titled Sub-Account Groups in your G/L Manual.  

 

Make any changes, and press [Enter] at "Field number to change ?". 

 
 

Printing a Specifications List 
 

Select Print Extract Spec. List from the Extract Specifications Menu. 

 
Use this list to verify the specifications you have entered for the extractions.  A screen appears 

for you to enter the starting and ending numbers of the specifications to be printed. 
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1. Starting Specification # 

2. Ending Specification # 

Enter the range of specifications to be printed.  Follow the screen instructions. 
 

 

Data Extracts 
 

Introduction 

This selection is used to perform the actual extraction of data using the specifications set up 
Extract specifications above. 

 

 

To Begin 
Select Perform Data Extracts from the L/C Menu. 

 

The screen will prompt you with "Do you wish to recalculate account balances ?" if you have run 

a previous extract within the current period.  Answer [Y] or [N]. 
 

If you have changed accounting periods, the system will automatically recalculate all account 

balances. 

 
Once completed, you will be prompted with the following screen for each extract specification 

which is selected to extract on the next run. 

 

Answer [Y] to the corresponding question if you wish to include those accounts with zero 
balances for the current period.  Otherwise, answer [N]. 

 

You can end the processing of extract files by pressing [Tab] when this screen appears. 

 

 
After all processing is complete, you are returned to the Ledger Connection Mail Menu.  
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Extended Trial Balance 
 

Use this selection to print an extended G/L Trial Balance for a range of selected accounts.   

 

You can print the trial balance in either summary or detail (showing individual entries).  

 
The extended trial balance is usually run after all entries have been entered and posted for the 

specified period.  However, it can be run at any time during General Ledger processing. 

 

The period used is the reporting period defined in Accounting periods. 
 

The Extended trial balance differs from that generated by the Trial balance function in the 

General Ledger, in two ways: 

 
  1. The Report can be sorted by section or group value.  This is only useful for   

  companies with more than one G/L account section. 

 

3. Account sections can be summarized.  Again, a useful tool if you have more than one 
G/L account section. 

 

 

Printing an Extended Trial Balance 
 

NOTE: This Report can be exported to Excel 
 

 
 

Enter the following Report criteria:  
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1. Starting Account 

2. Ending Account 

Enter the range of accounts to be included on the extended trial balance.  Follow the screen 
instructions. 

 

 

3. Starting Date 

4. Ending Date 

Enter the date range to be included on the extended trial balance. These dates do not rely on the 
reporting period from the G/L accounting period file, this variation of the trial balance can be 

useful for those with more than two G/L account sections. 

 

 

5. Sort Sections ? 

Press [Enter] to follow the standard sorting method for reporting G/L accounts, OR: 

 

[Y] When  yes.  you will be allowed to select which section to sort by in the 

Section / Group selection criteria below. 6. Cash Flow Type ? 
 

(For an explanation of cash flow types, see the Chart of Accounts Chapter)   
If one or more cash flow types are entered, this occurs: 

 

 • All accounts related to each cash flow type are printed in their own    

  section totals.   
 

 • Accumulating total debits and total credits, credit entries marked as    

  correcting entries are added to total debits, and debit entries marked as   

  correcting entries are added to total credits. 
 

To use only specific cash flow types in the extended trial balance, enter one or more of these 

choices: 

 
 [O]  -Include Operations Types 

 [I]  -Include Investment Types 

 [F]  -Include Financing Types 

 [Enter] -Ignore Cash Flow Types in printing the extended trial balance 
Format: 1 character 

 

If a type is chosen, the extended trial balance will be grouped by cash flow type.  If types are 

ignored, the extended trial balance will be grouped by account number. 
 

 

7. Show Detail ? 

A detailed extended trial balance shows individual entries.  A summary extended trial balance 

shows only account totals.   
 

Press [Enter] to show individual entries, or answer [N] to show only totals.  
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8. Summarize ? 

Summarizing allows you to summarize or total each account by section or group value. 
 

Press [Enter] to ignore summarizing by account section or group. 

 

 
NOTE: This field is skipped if sort sections or show detail are [Y]. 

 

 

9. Print Each Acct on Separate Page ? 

(This field appears only if you are printing a detailed extended trial balance.) 
 

Answer [Y] to start printing each account on a new page.  This makes it easier to distribute 

information about different accounts to different areas of an organization.   

 

 

Section/Group Selection 

The number of times you are prompted in the next set of fields depends on how your G/L 

accounts are structured.  For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 
or twice respectively. 

 

From the Section Prompt Press: 

 
  [F1]  -To select "All" values for this account section OR: 

 

   [F2] -To select a specific section value.  This is most useful when selecting  

    a section which may have multiple accounts with the same section. OR: 
 

  [F3] -To select a section group.  For more information on sub-account   

   groups, see the Chapter titled Sub-Account Groups in your G/L   

   Manual.  
 

 

Sum 

If you answered [Y] to summarize in field 6, you will be prompted for each account section to 
whether or not summarize that section value. 

 

Press [Enter] to ignore summarizing by that section, or answer [Y] to Report a summary for that 

section value. 
 

Sort 

If you answer [Y] to sort in field 3 above, you are offered the option of sorting the accounts in 

order of any account section. 
 

Enter the Order number (1 - 5) which the accounts should be sorted by.    
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For example, if you have a three-section account number, and the third section designates a 
region, second the department, and first the G/L account, you may want your extended trial 

balance sorted by region first, department second, and G/L account last. 

 

Pag 
If you answer [Y] a page break will occur when the section value changes. 

 

The extended trial balance shows the beginning and ending balance, total debits, total credits, 

and net change.  If extended trial balance (T/B) subtotal levels were entered in Chart of accounts, 
they will be used in printing the extended trial balance. 

 

The detailed form of the Report also shows all entries for each account, unless Summarize 

General Ledger has been run and then the detail is no longer visible.  
 

 

Budget Import  
 

This feature allows you to import budget figures that have been prepared in a spreadsheet 

application such as Microsoft Excel.  

 

These instructions provide guidelines as to what is required by SAMCO Power Accounting in 

terms of a data file.   

 

These instructions are not intended to teach you how to use your spreadsheet.   

 

We recommend that you have a working knowledge of your spreadsheet application before 

using the import feature. 

 

Using this feature, you can import budget data for each account: either one budget amount for the 

whole year OR one budget amount per fiscal period for each account.  A spreadsheet may have all 

of your accounts together or you can split each profit centre into separate spreadsheets and import 

the spreadsheets “one at a time”.  

 

When preparing spreadsheets by profit centre, you can put the “full” account number in the 

spreadsheet or leave out the profit centre and specify it at time of import. 

 

• If you specify a “whole year” budget amount per account, the system will divide the 

budget figure by the number of fiscal periods that you specify when doing the import.   

 

• If you specify budget amounts per fiscal period per account and there are not enough 

columns in the spreadsheet for all periods, then zero is assumed for the “missing” 

periods. 
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Creating Your Spreadsheet: 
 
Account Number: 

 

1. If your account numbers have only one section, then type the account number in the first 

column of your spreadsheet 

 

2. If your valid accounts have two sections: 

 

▪ Type the first section of the account number in the first column and the second section in 

the second column 

OR 

▪ Type the first and second sections of the account number in the first column 

separating them with a hyphen/dash (-) 

OR 

▪ Split your accounts into different worksheets by profit centre and type the first 

section of the account number into the first column of each spreadsheet 

OR 

▪ Import the chart of accounts from your Company into Excel:  Data > Import 

External Data > New Database Query then choose file CHARTF and record 

CHRT_ACCT_NUM.  Edit the contents of each cell as follows: 

▪  

The first section of the account number is in the first column and the second section 

is in the second column, etc. 

 

All sections of the account number are in the first column but the sections and 

separated with a hyphen/dash (-) 

 

If splitting your accounts into different worksheets by profit centre, the first section 

of the account number is in the first column and the second section is specified as 

a constant at time of import  

 

 

• Amount: 

Each amount must be in “whole” dollars only, no decimal places.  Do not use extraneous 

characters such as currency indicators (e.g. $, £, etc.), commas (,), periods (.), etc. 

 

1. Yearly budget amount – type only one amount per account; the system will “divide” 

the amount by the number of fiscal periods that you specify when doing the import.  

2. Period budget amount – type one amount per period per account  

 

If you enter a budget amount for an account that has a parenthesis control code of D for debit 

(i.e. liability, equity and revenue account; these accounts normally have a credit balance) the 

program will reverse the sign of the budget amount accordingly.  

If you enter a credit amount it must be entered as -12345, NOT 12345- or (12345).   

 

The format for cells that contain an amount should be text. Do not format the numbers as 

accounting, currency, etc. as these formats may be misinterpreted by the import process. 
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When saving your spreadsheet: 

 

Use the “File > Save as” feature in Excel to save your spreadsheet. Create the delimited file ( text 

to Column)   When prompted, specify the file type as: 

 

CSV (Comma delimited) (*.csv) – Samco import default 

Text (Tab delimited) (*.txt) 

 

 

When you import your budget figures: 

 

Go to GENERAL LEDGER > LEDGER CONNECTION > BUDGET IMPORT 

 

 

 
 

 
 

 

 

File Name:   

Type the name of the .csv or.txt  file in which you saved your spreadsheet. 

File. The file is usually found in your SSI directory/folder, under 

Company ID > file name. The file path could also be under a shared folder 

> share/rwtab/  
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File Separator:  

• “,”  -For file type .csv  

• [F1]  -For file type .txt 

 

Format: 

• P =   -Period Budgets  

• Y =  -Yearly Budgets 

 

 

Periods Per Year:  

For period budgets, enter the number of period budget columns in the 

spreadsheet 

For yearly budgets, enter the number of periods into which the yearly budget 

is to be divided 

 

 

First Budget Column #: 

   Enter the number of the column in which the first budget figures are  

  contained – e.g. column A = 1, column B = 2, etc.    

 

 

Main Acct:  

   Enter the column number of the spreadsheet in which the main acct has  

  been entered – e.g. column A = 1, column B = 2, etc. or leave blank to enter 

  a constant value.  At [ENTER], the system will prompt you to enter the  

  fixed value of the main account.  Type the main account number [ENTER]. 
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Profit Ctr:  (only used if you have defined profit centres for your GL accounts) 

 

NOTE:  The OR Value is a constant value where you have prepared a spreadsheet for each 

department/profit centre.  This would result in your importing the budgets for department 1, then 

department 2, etc., each from a separate file.  The system will build the full account number from 

the columns of the import in conjunction with the constant department specified. 

 

- -If the profit centre is in the same column as the main part of the account number, 

press [F1] 

OR  

- Type the column number [ENTER] 

OR  

- Leave blank to enter a constant value [ENTER].  When the system prompts you to 

enter the fixed value of the profit centre, type the profit centre [ENTER].   

 

 

Clear All Budgets First?  

- Y (es) All existing budget amounts in the system prior to this import will be zeroed 

out 

 

- N (o) All existing budget amounts in the system prior to this import will be left as 

they are with the exception of those that will be overwritten according to your input 

specifications 

 

NOTE: When importing multiple budget spreadsheets, use Y(es) for the first import and N(o) for 

all subsequent imports so the budget amounts accumulate. 

 

• To check your imported budget figures: Once posted, use the Chart of Accounts > Enter 

feature and view the budgets for each account  

• You can also print the data using Chart of Accounts > Print out accounts for a range of 

accounts answering yes to Show budgets and comparatives?
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Chapter 25 - Detail History and Reports 
 
 

 
 

 

The Detail History and Reports offer historical reports for Statements, Trial Balance History and 

Historical Extended Trial Balance.  
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Extended Trial Balance 
 

Use this selection to print an extended G/L Trial Balance for a range of selected accounts.   
 

You can print the trial balance in either summary or detail (showing individual entries).  

 

The extended trial balance is usually run after all entries have been entered and posted for the 
specified period.  However, it can be run at any time during General Ledger processing. 

 

The period used is the reporting period defined in Accounting periods. 

 
The Extended trial balance differs from that generated by the Trial balance function in the 

General Ledger, in two ways: 

 

  1. The Report can be sorted by section or group value.  This is only useful for   
  companies with more than one G/L account section. 

 

  2. Account sections can be summarized.  Again, a useful tool if you have more   

  than one G/L account section. 
 

 

Printing an Extended Trial Balance 
 

NOTE: This Report can be exported to Excel 
 

 
 

Enter the following Report criteria: 
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1. Starting Account 

2. Ending Account 

Enter the range of accounts to be included on the extended trial balance.  Follow the screen 

instructions. 
 

 

3. Starting Date 

4. Ending Date 

Enter the date range to be included on the extended trial balance. These dates do not rely on the 

reporting period from the G/L accounting period file, this variation of the trial balance can be 
useful for those with more than two G/L account sections. 

 

 

5. Sort Sections ? 

Press [Enter] to follow the standard sorting method for reporting G/L accounts, OR: 
 

  [Y]  -To answer yes.  You will be allowed to select which section to sort  

    by in the Section / Group selection criteria below. 

 
 

6. Cash Flow Type ? 

(For an explanation of cash flow types, see the Chart of Accounts Chapter)   

 

If one or more cash flow types are entered, this occurs: 
 

 • All accounts related to each cash flow type are printed in their own    

  section totals.   

 
 • Accumulating total debits and total credits, credit entries marked as    

  correcting entries are added to total debits, and debit entries marked as   

  correcting entries are added to total credits. 

 
To use only specific cash flow types in the extended trial balance, enter one or more of these 

choices: 

 

 [O]  -Include Operations Types 
 [I]  -Include Investment Types 

 [F]  -Include Financing Types 

 [Enter] -Ignore Cash Flow Types in printing the extended trial balance 

 
Format: 1 character 

 

If a type is chosen, the extended trial balance will be grouped by cash flow type.  If types are 

ignored, the extended trial balance will be grouped by account number. 
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7. Show Detail ? 

A detailed extended trial balance shows individual entries.  A summary extended trial balance 

shows only account totals.   
 

Press [Enter] to show individual entries, or answer [N] to show only totals. 

 

 

8. Summarize ? 

Summarizing allows you to summarize or total each account by section or group value. 

 

Press [Enter] to ignore summarizing by account section or group. 

 
 

NOTE: This field is skipped if sort sections or show detail are [Y]. 

 

 

9. Print Each Acct on Separate Page ? 

(This field appears only if you are printing a detailed extended trial balance.) 

 

Answer [Y] to start printing each account on a new page.  This makes it easier to distribute 

information about different accounts to different areas of an organization.   
 

 

 

Section/Group Selection 
The number of times you are prompted in the next set of fields depends on how your G/L 

accounts are structured.  For example, if you have a 3-section account number, you will be 

prompted 3 times, if you have a 1 or 2 section account number you will only be prompted once 

or twice respectively. 
 

From the Section Prompt Press: 

 

  [F1]  -To select "All" values for this account section OR: 
 

   [F2] -To select a specific section value.  This is most useful when selecting  

    a section which may have multiple accounts with the same section. OR: 

 
  [F3] -To select a section group.  For more information on sub-account   

   groups, see the Chapter titled Sub-Account Groups in your G/L   

   Manual.  

 
Sum 

If you answered [Y] to summarize in field 6, you will be prompted for each account section to 

whether or not summarize that section value. 

 
Press [Enter] to ignore summarizing by that section, or answer [Y] to Report a summary for that 

section value.  
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Sort 

If you answer [Y] to sort in field 3 above, you are offered the option of sorting the accounts in 
order of any account section. 

 

Enter the Order number (1 - 5) which the accounts should be sorted by.   

For example, if you have a three-section account number, and the third section designates a 
region, second the department, and first the G/L account, you may want your extended trial 

balance sorted by region first, department second, and G/L account last. 

 

 

Pag 

If you answer [Y] a page break will occur when the section value changes. 

 

The extended trial balance shows the beginning and ending balance, total debits, total credits, 
and net change.  If extended trial balance (T/B) subtotal levels were entered in Chart of accounts, 

they will be used in printing the extended trial balance. 

 

The detailed form of the Report also shows all entries for each account, unless Summarize 
general ledger has been run and the detail is no longer available.  
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Chapter 26 - Company Consolidation 
 

 

NOTE:  The Flag for multi companies and for Consolidation of a Company you would need to 

be set to Yes > Multi Companies 

 

Use this selection to sum the business activity from several individual companies into a whole, 

so that you can produce an overall set of Financial Statements. 

 

The ability to produce consolidated Financial Statements is very useful to any organization 

consisting of more than one Company.  Such consolidated statements are often necessary in 

managing the overall organization and in seeking capital. 

 

 

First, some definitions: 

 

Consolidate:  "Consolidate" means to summarize the business activity from several companies 

into a whole, as though they were one Company.  For example, the activity from companies A, 

B, and C could be summarized into Company X.  Company X would not be a real Company, but 

just a dummy Company to hold the consolidation.  

 

Consolidation:  This word is used in two senses: 

 

1. The action of summarizing the accounting activity of several companies into a whole. 

 

2. The dummy Company that you set up to hold the accounting activity of a group of other 

companies. 

 

Member:  A "member" is an individual Company whose business activity is consolidated (along 

with other companies) into a Consolidation Company.  For example, in the diagram, companies 

A, B, and C are members of a Consolidation Company X (called the "Consolidation Company" 

or, simply, the "Consolidation"). 
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Link:  To "link" means to tie a specific account in a member Company to a specific account in 

the Consolidation Company.   

 

The account in the Consolidation Company is also referred to as a "consolidated account".  For 

example, business activity from account 1000-000 in member B could be linked to consolidated 

account 1000-200 (or to any other, as you choose) in the Consolidation Company.   

You must link each account in each member to one and only one account in the Consolidation 

Company before the actual consolidation and summarizing can be done.  (The consolidated 

account and the member account can have the same or a different account number.) 

 

Parent Company:  A "parent Company" is a legally recognized entity that has its own 

accounting records.  It has subsidiaries, each of which has its own separate accounting records.  

Each Company's accounting records must not be altered, whether the Company is a subsidiary or 

a parent. 

 

 

NOTE:  A parent Company is not the same as a Consolidation Company. 

 

 Do not ever consolidate entries from a subsidiary into the accounting records of its parent 

Company.  Always set up and use a separate dummy Company for the consolidation.  In a 

consolidation, parent companies and subsidiaries are equally members.  
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The Company Consolidation selection provides the means of adding the entries of members 

together into the Consolidated Company.   

 

This selection does NOT deal with inter-Company accounting problems such as a sale of an asset 

between two companies.  Your accountant is the expert on such matters.  

 

This selection helps you to create a chart of accounts and a set of Financial Statements for the 

Consolidation Company, based on the charts and Financial Statement layouts of its members. 

 

You may have several Companies using Samco G/L, some of which you want to consolidate and 

some of which you want to remain completely separate.  Accordingly, you can specify which of 

your companies are to be members of a consolidation. 

You can have more than one Consolidation Company, and you can designate each actual 

Company to be a member of one or more Consolidation Companies. 

 

The Consolidation Company and all its members must have the same number of accounting 

periods; however, members are not required to have the same dates for their accounting periods.  

This allows a member in a remote location to close out its fiscal year before the rest of the 

members, so that its information can be ready at the time of the consolidation. 

 

 

To Begin 

To set up this function for use, follow Checklist A: "Setting Up Company Consolidation", at the 

end of this Chapter.  Use this checklist as a guide for the rest of this Chapter.  All of the steps on 

the checklist are needed to set up the structure to allow consolidation.   

 

 

Normal Operation 
 

To do the Company consolidation for each subsequent fiscal year, follow the steps in Checklist 

B, "Consolidating Entries for Subsequent Years".   

 

Before you produce Financial Statements for the Consolidation Company, you must consolidate 

(add to the Consolidation Company) entries from its members. 

 

During the year, entries from member companies can be consolidated whenever you want.   

 

Once they are consolidated, the entries are automatically restricted from being consolidated 

again, so that the same entry is not added twice to the same Consolidation Company.  

  

NOTE:  You may override this restriction.  This override is provided so that, if a Company is a 

member of more than one Consolidation Company, the member's entries can be consolidated 

more than once.  Thus, member A's entries (for example) can be consolidated into Consolidation 

Company X and again in Consolidation Company Y.  Refer to Consolidate entries later in this 

Chapter for more information.  
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At the end of the fiscal year, all members' entries should be transferred into the Consolidation 

Company.  Then the final consolidated Financial Statements can be printed. 

 

Select Company Consolidation from the G/L Menu. 

 

NOTE:  You must follow the steps in the Checklist A, "Setting Up Company Consolidation", 

before this selection will appear on the Menu.  If you haven't already done this checklist, do it 

now, then return to this section and continue. 

 

 

Entering Member Companies 
 

This function is used to define the member companies, the linkage method to use between 

accounts, and the correlation between account sections. 

Select Maintain members > Enter members from page 2 of the G/L Main Menu. 

 

 

[?]1. Member 

 

For a new member 

Enter the member Company ID that you want to add to this Consolidation Company.  The 

Company must already exist and be in the Multi-Company File. (See the Define Multiple 

Companies Chapter in the System Functions Guide.)  

  

For an existing member 

Enter the Company ID or press [F1] to scan through the members on file. 

 

The account structure of the member is displayed. 

 

 

2. Linkage Type 

This function is used to define the linkage type for the member Company's accounts.  To "link 

accounts" means to tie each member account to one and only one Consolidation Company 

account. 

 

Accounts can be linked either automatically, or manually. 

 

This function is used, not to create the links, but rather to set the criteria by which the member 

accounts will be linked to the Consolidation Company. 

 

For a more detailed explanation on "linking accounts", refer to the section titled, Linking 

Accounts Automatically or Manually, later on in this Chapter. 
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Select ‘M’ if you will be manually linking the member Company's accounts individually for 

consolidation. This is most commonly used where the member and Consolidation Company's 

account structure and numbering system are different. 

 

By selecting ‘A’ you will be able to set the criteria for automatically linking the member and 

Consolidation Company's accounts. 

 

 

Linkage Criteria (section fields 3 through 7) 

 

There are two methods of using sub-accounts.  You can arrange the consolidation accounts either 

to show member companies, or to show sub-account groups.   

 

 

Showing Member Companies 
 

The first method is to use "consolidated sub-accounts", which shows the member companies.  

With this method, a member Company's sub-accounts are consolidated into one sub-account in 

the Company.   

 

For example, if the member has accounts 1000-100, 1000-200, and 1000-300, they would be 

combined into the single consolidation account 1000-400, (assuming the member was assigned 

the "consolidated sub-account" number of 400).   

 

Even if the members do not use sub-accounts, each member is assigned its own sub-account in 

the Consolidation Company.  This method must be used if the member Company does not use 

sub-accounts. 

 

This sub-account serves to identify this member within the consolidation.  All entries from a 

member Company will be consolidated into accounts with this sub-account in the Consolidation 

Company.   
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Showing Sub-Accounts 
 

The second method is only for members that use sub-accounts, and will show the sub-accounts, 

but not the member companies.  You can retain the original sub-accounts, but the different 

member companies will be combined.  

 

For example, suppose you have three members - A, B, and C, and that each member has three 

sub-accounts: 

100 - Men's clothing 

200 - Women's clothing 

300 - Children's clothing 

 

Each member has these accounts: 

 

5555-100 (Sales, Men's clothing), 

5555-200 (Sales, Women's clothing), and  

5555-300 (Sales, Children's clothing). 

 

Not Specifying a Consolidated Sub-Account 

 

In the example, the Consolidation Company will have these accounts: 

 

· 5555-100, summarizing account 5555-100 in companies A, B, and C, 

· 5555-200, summarizing account 5555-200 in companies A, B, and C; and  

· 5555-300, summarizing account 5555-300 in companies A, B, and C. 

 

 

Specifying a Consolidated Sub-Account 

If you specify that each member Company will have a consolidated sub-account associated with 

it in the Consolidation Company, the sub-accounts from within the member are not shown in the 

Consolidation Company.  However, each member Company is shown. 

 

For example, consider the three-member companies above:  A, B, and C, each of which has 

sub-accounts 100, 200, and 300. 

 

Assign Member A consolidated sub-account 700 in the Consolidation Company; Member B, 

800; and Member C, 900. 

 

Then, using the same accounts 5555-100, 5555-200, and 5555-300 as examples: 

 

All entries from accounts 5555-100, 5555-200, and 5555-300 from Member A are summarized 

into consolidation account 5555-700.  
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All entries from accounts 5555-100, 5555-200, and 5555-300 from Member B are summarized 

into consolidation account 5555-800. 

 

All entries from accounts 5555-100, 5555-200, and 5555-300 from Member C are summarized 

into consolidation account 5555-900.  

 

 

To Choose Which Method to Use 

Whether or not you specify a consolidated sub-account for a member affects how the Financial 

Statements of the Consolidation Company will look. 

 

Identical Account Structures: If you chose to automatically link the accounts, and the 

member and Consolidation Companies have identical account structures, the system defaults 

to link section 1 to 1, 2 to 2, 3 to 3, etc. 

 

This only occurs if the sections are identical in size and type (numeric / alphanumeric), and 

the profit centre is the same section. 

 

Dissimilar Account Structures: Although it is not recommended that you automatically link 

accounts when the member and Consolidation Company accounts are different in structure, it 

is possible - with a little work. 

 

 

To show member sub-accounts for this section, enter ‘M’ and the section number, or use [F1] to 

default to the corresponding member section (only if the member and consolidated account 

structures are the same). 

 

Enter ‘S’ and then the valid section value, if you want the sub-accounts in this section reported 

under one account. 

 

 

Printing a List of Member Companies 
 

Select Maintain members >Print out list of members from page 2 of the G/L Main Menu. 

 

A list of members belonging to the Consolidation Company will print.  Follow the screen 

instructions. 
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Linking Accounts Automatically or Manually 
 

As defined earlier, to "link accounts" means to tie each member account to one and only one 

Consolidation Company account.  

 

 

Producing a Chart of Accounts for the Consolidation Company requires two steps: 

 

 1) Linking each member account to a Consolidation Company account.  

 

 2) Creating a consolidated Chart of Accounts from the links created in the first step. 

 

 

You can do this in several different ways, depending on how closely you want the Consolidation 

Company's chart of accounts to resemble the members' charts of accounts.   

 

 a. If the Consolidation Company's Chart of Accounts is to be exactly the same as the 

members', create the links and the consolidated chart of accounts all in one step.  

 

  Select - Link and consolidate chart. 

 b.  If the Consolidation Company's Chart of Accounts is to be almost the same as the 

members', you can use a combination of automatic and manual linking.   

 

 -First: -Select Link accounts automatically and create the links.  

 -Next: -Select Link accounts manually, and "tailor" those links which you want to 

be different.   

 -Next: -Select from same Menu, Print link edit list to produce a list to check that 

the links are correct.   

- Finally: -Use Generate Consolidated Chart. 

 

 c.  If the Consolidation Company's Chart of Accounts is to be considerably different from 

the members', Use; Link accounts manually throughout.   

 

-First: -Link each member account to a consolidation account.   

-Next: -Use edit list to produce a list to check that the links are correct.   

-Finally: -Use Generate Consolidated Chart. 

 

 

Linking Accounts Automatically 

Select Link accounts automatically from the Link accounts automatically Menu. 

 

A screen appears for you to enter the ID of the member Company whose accounts you want to 

link automatically to the consolidation Company (using the same main account number).  Enter a 

2-character ID or press [F1] to link the accounts of "All" member companies. 

 

A screen appears to enter the range of account numbers to link.  
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[?]1. Starting Account 

[?]2. Ending Account 

Enter the range of account numbers to link.  Follow the screen instructions. 

 

The member's accounts and the corresponding consolidation accounts are then linked.  A screen 

informs you of which account is being processed. 

 

 

Generating a Consolidated Chart 
 

Select Generate Consolidated Chart from the Link accounts automatically Menu.  Or you can 

select Generate Consolidated Chart from the Link accounts manually Menu.  

 

This is the screen you see: 

 

 
 

If this is the first time you have run this selection for this Consolidation Company, you do not 

have to clear the budgets and comparatives.   

If this is not the first time you have run this selection for this Consolidation Company, you must 

clear its budgets and comparatives before generating the consolidated chart of accounts again.  

(The next three pages have more information on this.)   

 

Answer Y, or press [Enter] for N. 

 

 

NOTE:  You may press [Esc] if you decide you do not want to run this selection at this time. 

 

This is the next screen you see: 
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NOTE: "SUBTRACT BUDGETS/COMPARATIVES?" does not appear if the Consolidation Company 

does not yet have a chart of accounts, or if you selected to clear the budgets and comparatives on 

the previous screen. 

 

[?] 1. Member 

Enter the ID number of the member from which you want to generate accounts in the 

Consolidation Company, or use [F1] to generate accounts from "All" members. 

 

 

[?]2. Starting Account 

[?]3. Ending Account 

Enter the range of account numbers from which you want to start creating consolidation 

accounts.  Follow the screen instructions. 

 

 

Budgets and Comparatives 
 

The next two questions (Add/Subtract) are asked so that you can easily do the following 

things: 

 

i. Establish budgets and comparatives ("B&C's") for your Consolidation Company when 

you first create it. 

 

ii. Change the B&C's of the Consolidation Company when the member companies' B&C's 

change. 

 

 iii. Recreate the B&C's of the Consolidation Company at the beginning of a new fiscal 

 year.   

 iv. Add the B&C's of new accounts at any time.  
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  A. To Establish Budgets and Comparatives (B&C's) for Your Consolidation 

Company When You First Create It: 

 

Answer Y to question 4 ("Add in Budgets/Comparatives?") to automatically add the 

member's B&C's to the Consolidation Company.  Answer N if you don't want this member's 

B&C's included in the Consolidation Company (because you are going to enter them 

manually, using Chart of Accounts). 

 

If you do not automatically add in B&C's here, you should not change B&C's as in (b) below, 

or add the B&C's of new accounts as in (d) below.    

 

Later in the year, if you want to use automatic addition and subtraction of B&C's, first clear 

the existing B&C's (at the first screen).  Then answer Y to "Add in Budgets/Comparatives?" 

to add the ones from your members, including those for any new member accounts entered 

since you first did the setup. 

 

 

  B. To Change the B&C's of the Consolidation Company When the Member  

Companies' B&C's Change: 

 

1. Before changing the member Company's B&C's, subtract its current B&C's out of the 

consolidation Company's B&C's by answering N to "ADD IN BUDGETS/ 

COMPARATIVES ?", then answering Y to "SUBTRACT BUDGETS/ 

COMPARATIVES ?". 

 

2. Change the member's B&C's. 

 

3. Add the member's new B&C's to the Consolidation Company by answering Y to "ADD 

IN BUDGETS/ COMPARATIVES?". 

 

In other words, take the member Company's current B&C's out of the Consolidation 

Company, change the B&C's, then add the new B&C's back in.  

 

 

  C.  To Recreate the B&C's of the Consolidation Company at the Beginning of a 

New Fiscal Year:  

 

1. From the first Generate consolidated chart of accounts screen, answer Y to "Do you wish 

to clear the Budgets and Comparatives of your consolidated Cart of Accounts now?" to 

zero out the Consolidation Company's B&C's. 

 

2. Add the new B&C's from each member Company by answering Y to "Add in Budgets/ 

Comparatives?". 

 

Refer to Checklist B for the complete year end procedure.  
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 D.  To Add the B&C's of New Accounts at Any Time:  

 

1. Establish any new links needed from the member Company's new accounts to the 

Consolidation Company accounts.  

 

2. Add the B&C's from the member Company's new accounts by answering Y to "Add 

Budgets/Comparatives?". 

 

NOTE:  Only the B&C's from the new accounts will be added, since B&C's already added once 

from a member will NOT be added again until they have been subtracted through question 5 

below or have been cleared to zero by answering Y to "Do you wish to clear the budgets and 

comparatives of your consolidated chart of accounts now?". 

 

 

4. Add in Budgets/Comparatives? 

This determines if budgets and comparatives from this member's accounts will be added to the 

consolidation accounts.  Answer Y or N.   

 

If you answer Y, the next field is automatically set to N. 

 

 

5. Subtract Budgets/Comparatives?  

This determines if budgets and comparatives for this member's accounts are subtracted from the 

consolidation accounts.  Answer Y or N.   

 

The consolidation accounts are then created.  B&C's are also added to (or subtracted from, as 

appropriate) previously existing consolidation accounts. 

 

Previously existing consolidation accounts retain their account descriptions.   

 

Newly created consolidation accounts are given the same description,  

as found in the "link from " account in the first member Company processed.   

 

You can change any consolidated account description through Chart of Accounts. 
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Linking and Consolidating a Chart 

Select Link and Consolidate Chart from the Link accounts automatically Menu. 

 

This selection performs the actions of both linking ACCOUNTS AUTOMATICALLY and 

generating a CONSOLIDATED CHART simultaneously. 

 

 

 
 

Answer Y to clear budgets and comparatives; otherwise, press [Enter] to default to N.  (See the 

earlier discussion under Budgets and Comparatives.)  Press [Esc] if you do not wish to run this 

selection at this time. 

 

The processing occurs automatically.  The account number and member being processed are 

displayed.   

 

 

Linking Accounts Manually 

Select Link accounts manually from the Link accounts manually Menu. 

 

From the following screen, you can work with both new and existing links.  If a link exists for 

the information you specify, that link will appear and be available for changes or deletion.  



General Ledger                                       Company Consolidation 

Samco Power Accounting                            26.260 

 

 

 
[?]Member 

Enter the member's Company ID whose accounts you want to link to consolidation accounts, or 

press [F1] to scan through the members on file. 

 

The Consolidation Company's account sections appear. 

 

Link From: 

[?] 1. Account  

Enter the member's account number to consolidate from, OR: 

 

  [F1]  -To scan through the accounts of the member 

[F3] -To scan through the account links on file 

 

If a member was previously linked; (to a consolidation account), account appears automatically.  

 

 

Link to: 

[?] 2. Account  

If you have not previously linked this member account to a consolidation account, enter the 

number of the account to link to, or use [F1] to use the main account number from field 1 and the 

consolidated sub-account specified for this member.  

 

If no consolidated sub-account was specified, the sub-account from field 1 is used. 

 

Next, enter a description of the consolidation account, or press [F1] to use the description 

previously entered, which is displayed.  
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When assigning main account numbers for the consolidation accounts, the same meaning should 

be attached to the same account number wherever it is used.   

 

For example, if main account number 1000 is for "Cash in bank" in a member Company, then it 

should mean "Cash in bank" in every other member Company, as well as in the Consolidation 

Company. 

 

If account 1000 means "Accounts Receivable" in one member and "Accounts Payable" in 

another, your end results will not be easy to work with.  However, you can still manually 

establish links that will place each in the correct account in the Consolidation Company. 

 

 

Printing a Link Edit List 
 

Select Print link edit list from the Link accounts manually Menu. 

 

This selection will show an edit list of the account links that have been entered.  You can enter a 

member Company ID, OR: [F1] for “All”. 

 

If you print the edit list for all members, you are asked to select the Order for the Report to be 

printed.  Enter either: 

 

1 Print in member order 

 

2 Print in consolidation account number order 

 

 

Copying Layouts 
 

Select Copy layouts from the Setup Consolidation Menu. 

 

Use this selection to copy whichever member Company's Financial Statement layouts you want 

to use for your Consolidation Company's Financial Statements.   

 

If a member layout is close to how you want a Consolidation Company layout to be, copy it then 

make changes to it as described in the Chapter titled Financial Statement Layouts.  If a layout is 

radically different, create an entirely new layout without using this selection. 

 

This is the screen you see:  
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[?] Member  

Enter the member Company ID whose layout you want to copy, or press [F1] to scan through the 

members on file. 

 

 

[?] 1. Layout Number 

Enter the layout number of the existing layout you want to copy, or press [F1] to scan through 

the layouts on file for this member. 

 

 

2. New Layout Number 

Enter the number which you want to assign to this new layout in the Consolidation Company, or 

press [F1] to use the same number as the member Company's layout. 

 

 

3. New Description 

Enter the description for the new layout in the Consolidation Company, or press [F1] to use the 

description in the member Company   

 

This description is only for your use in managing your layouts; it does not appear on the 

statement. 
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4. Copy Text? 

This lets you copy texts that are already in the Text File of the member.  Otherwise, you must 

enter entirely new texts directly into the Text File of the Consolidation Company through Texts. 

 

Answer Y to copy the text from the layout you have selected. 

 

If two-member companies each have a text identified by the same number (for example, 3), only 

the text which you copied first will be available.  You will have to manually enter the second 

member's text number 3, assigning it a different number in the Company's Text File and 

Financial Statement layouts.  

 

 

Verifying Consolidation Setup  
 

Select Verify Consolidation Setup from the Company Consolidation Menu. 

 

This selection verifies the account links and prints the Setup Verification Report. 

 

You should always run this selection before actually consolidating entries.  It lists the status of 

each printed account as an aid for you to correct missing links. 

 

An account will be listed on the Setup Verification Report if: 

 

1.  It is a member account that is not linked to any consolidation account. 

 

2. There is a link to a member account which does not exists. 

 

3. There is a link to a consolidation account which does not exist. 

 

4. A consolidation account exists for which there are no links to any member accounts.  

 (This may not be an error, because not all consolidation accounts will necessarily be linked to 

member accounts.  Such consolidation accounts will still be printed for your review.) 

 

If any link is invalid per the above criteria, a status message appears on the Report. 

 

Use the status messages as the basis for entering, changing, or deleting links (or determining if it 

is an account such as a clearing account which does not have to be linked). 

 

A screen appears for you to enter the member Company ID whose links you want to verify.  

Enter the ID or press [F1] to verify the links of "All" members.  
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Consolidating Entries 
 

Select Consolidate entries from the Company Consolidation Menu. 

 

All of the preceding selections are used to prepare for Consolidate entries.  This selection is 

where you actually perform the consolidation. 

 

Use this function periodically to transfer entries from the members to the Consolidation 

Company.  After transfer, you can make any necessary adjustments directly in the Consolidation 

Company. Consolidation can be done at the end of the year, or periodically during the year so 

that Financial Statements for the Consolidation Company can be obtained for each accounting 

period. 

 

As each member's entries are added into the Consolidation Company, the entries are marked 

"consolidated" in the member's file.  These entries will be skipped in future runs, thus preventing 

the same entry from being added in twice to the same Consolidation Company.  You can 

override this safeguard if you wish (see field 7 below). 

 

This is the screen you see: 

 

 

 
 

 

[?] 1. Member  

Enter the Company ID of the member whose entries you want to consolidate, or use [F1] to 

consolidate the entries from “All” members. 

 

  



General Ledger                                       Company Consolidation 

Samco Power Accounting                            26.265 

 

[?] 2. Starting Account 

[?] 3. Ending Account 

Enter the range of accounts to consolidate.  

 

 

4. Starting Date 

5. Ending Date 

 

 

6. Compression Code 

During consolidation, entries from the member will be compressed according to the code entered 

here. 

 

Your choice here affects only how the entries appear in the Consolidation Company’s files. The 

member’s G/L files are not changed in any way. 

Refer to the Chapter titled Summarize General Ledger for an explanation of compression codes. 

 

Enter either: 

 

   N  -No compression 

   D  -Compress by date 

   P  -Compress by period 

 

 

7. Include Entries Already Consolidated? 

You would not include entries already marked as “consolidated”. This is to avoid entries being 

used twice in this consolidation. 

 

However, if the same member Company belongs to more than one Consolidation Company, you 

can include entries, even if they have been consolidated before. (You would do this only so these 

entries can be transferred to more than one Consolidation Company.) Answer Y or press [Enter] 

for N. 

 

If you answer Y here, be certain that the entries you are about to consolidate have not already 

been consolidated into this Consolidation Company. 

 

 

8. Print Report Only? 

 

NOTE: Answer Y to only print the Consolidation Edit List, without actually consolidating 

entries.  This list shows what will be in the Consolidation Company’s file after an actual 

Consolidation.   It is useful in locating errors in the Consolidation. 
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If you answer ‘N’, you will print the Consolidation Register and actually Consolidate the entries 

from members. 

 

If you chose to compress the entries (in field 6 above), the Report will show how the entries are 

compressed in the Consolidation Company’s files. 

 

If you included entries already consolidated (field 7), and are actually Consolidating Entries 

(field 8), you will be warned that you might be adding the same entries twice to the same 

Consolidation Account. 

 

 

Some of the information provided on the Consolidation Edit List is: 

 

Source:   -First 2 characters are the member Company’s ID from which the entries  

  are consolidated from.  Other digits are the sub-account of the member Co. 

 which entries are being consolidated.  

 

Reference:  -This is set to: “Consolidation from Co. XX”, “XX” is the member Company 

ID  

 

Doc#:   -First 2 characters are member Company’s ID from entry, last 6 are consolidation 

date.  
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Setting Up Company Consolidation 

 
 
Checklist to set up for Company Consolidation. 

 

References needed: 

  

• -Multiple Companies Chapter in the System Functions Guide 

• -Company Information Chapter in the System Functions Guide 

• -Using Samco General Ledger Chapter in this User Manual 

• -Accounting Periods Chapter in this Manual 

• -This Chapter 

 

Step 1 
Define your Consolidation Company. See the Chapter titled Multiple 

 Companies in the System Functions Manual.  

 

Step 2 
Run you General Ledger Package.  Enter the Consolidation Company as the Company to 

process (when asked for Company ID).  Refer to the Chapter titled Using Samco General 

Ledger.         

 

Step 3 
Run Company Information to enter information for the Consolidation Company.  Refer to 

that Chapter in the System Functions Manual. 

 

 

 

NOTE:  For a Consolidation Company, you must select to use sub-accounts. 

 

 

 

Step 4 
Enter the accounting periods for your Consolidation Company.  (See the Chapter titled 

Accounting Periods.) 

 

The Company and EACH of its members must have the same number of accounting periods.  

The dates of these periods may be different, but for simplicity they should be the same. 

 

For example, period 3 for member A might be from June 1 to June 30, and period 4 for 

member B might also be from June 1 to June 30.  In this case, the entries from member A’s 

period 3 would be consolidated with entries from member B’s period 4 in the Consolidation 

Company. Chapter, section titled “Enter Member Companies”, provides a guide for checklist.  
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Step 5 

Run G/L Control information to enter information for G/L. Refer to that Chapter. 

 

Step 6 

Select Company Consolidation on the G/L Menu, then select Enter member companies.  

Specify which companies are to be members of the Consolidation Company.  Refer to the 

“Enter Member Companies” section of this Chapter. 

 

Step 7 
Read the section in this Chapter titled “Linking Accounts Automatically” or “Manually” to 

determine the linking method that best fits your situation. 

 

 

Step 8 
Create the links between member accounts and the consolidation accounts according to the 

method you chose in the section titled “Linking Accounts Automatically”, or “Manually”.   

Then set up the Consolidation Company’s Chart of Accounts, based on these links.  You can 

do this automatically (as explained in Link accounts automatically), or on an account-by-

account basis (as explained in Link accounts manually). 

 

Step 9 
Create the Consolidated Chart of Accounts, using Generate Consolidated Chart.  (If you 

used Link and Consolidate Chart this has already been done.) 

 

Step 10 

Create the consolidated Company’s Financial Statement layouts by copying selected layouts 

from member companies, then editing them if necessary. 

 

Step 11 
If you used Link accounts manually, run Verify Consolidation Setup and handle any errors 

reported as needed.  You may have some accounts in your Consolidation Chart of Accounts 

File which will show as errors, but in fact are not (as explained in the section titled “Verify 

Consolidation Setup”) 

Step 12 

You are now ready to begin normal operation, which includes consolidating entries from 

member companies into the Consolidation Company. 

 

If you would like to consolidate entries now, run Consolidate entries as described in this 

Chapter. 

Step 13 
Refile this checklist in the General Ledger User Manual and review the text under “Normal 

Operation” in the beginning section of this Chapter. 

 

 

NOTE:  After completing this checklist, you are ready to run Financial Statements for the 

Consolidation Company. 
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Consolidating Entries for Subsequent Years 
 

 
Consolidation starts over for the next fiscal year.  You do not have to redo the setup, since the 

Chart of Accounts and layouts already exist for the Consolidation Company. 

 

Refer to: 

• -This Chapter 

• -General Journal Chapter 

• -Initializing Data Files Appendix 

 

 

Step 1 

Use Initialize data files to create a new G/L Transaction File for your Consolidation Company. 

 

Step 2 
Change your Accounting Period Dates in the Consolidation Company to reflect the New Year. 

 

Step 3 

If you have made any changes to the Chart of Accounts of any of your member companies, use 

Link accounts manually to update the links to the Consolidation Company. 

 

Step 4 
Use the Print link edit list selection to verify that your links are correct.  If any errors are noted, 

restart this checklist at step 3 above. 

Step 5 
Run Generate Consolidated Chart, and answer Y to “Clear budgets and comparatives?” This 

procedure will create the budgets and comparatives in your Consolidation Company’s Chart of 

Accounts File. 

Step 6 

Run Verify Consolidation Setup and handle any errors reported as needed by restarting this 

checklist at step 3. 

Step 7 
Run Consolidate entries to add the member entries into your Company’s General Ledger Entry 

File. 
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Chapter - 27 Data Integrity Check 
 

This function prints the Data Integrity Report and verifies the accuracy of information (data) in 

your files.  Because of this, you should be sure that no one else is using your Samco software 

when you print this Report.    

As entries are entered and processed, their amounts are added together and the totals are saved. 

These totals represent the "calculated" balance of the information that should be in the data files. 

 

When the Data integrity check function is run, the "actual" amount of information in the data 

files is totalled, and the "actual" and "calculated" amounts are compared on the Report.      

 

The "actual" and "calculated" amounts should always be equal. A difference between the two 

indicates that an unexpected error has occurred. 

 

Such errors could include: 

 

• Hardware failures 

 

• Turning off or rebooting the machine while processing is still going on.  (Never do 

this intentionally.)  

 

• Power surges due to electrical storms. 

 

Because this Report shows differences between the actual and calculated amounts, you may 

locate errors by referring to edit lists and registers run since the previous Data Integrity Report 

was printed. 

 

If a difference is noted between the actual and calculated amounts, you will be asked whether 

you wish to reset the calculated amount to match the actual amount.  If you answer Y, the 

calculated amount will be set equal to the actual amount.  This does not mean the problem is 

fixed, only that the amounts are now equal.    

 

To Begin 

Select Print Data Integrity Report from page 2 of the G/L Menu. The Menu appears to select 

how to print the Report.  Follow the screen instructions 
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Chapter 28 - Calculate Loan Payments 
 

Use this selection to calculate loan payments and to print an amortization schedule.   

 

For each calculation, enter any three of these four fields: 

 

• Principal 

• Interest rate 

• Number of payments 

• Payment amount 
 

The program then calculates and displays the fourth field for you. 

 

These four fields are identified by asterisks (*) on the screen. 

 

To Begin 

 Select Calculate loan payments from page 2 of the G/L Menu. 
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1. Description 

Enter a description to be printed on the amortization schedule, or press [F1] to print "Loan 

repayment information". 

 

Press [Enter] to skip (set to zero) the field to be calculated, either:  

 

"Principal" 

"Interest rate" 

"Number of payments", or  

"Payment amount". 

 

 

*2. PrincipalEnter the principal amount of the loan.  

 

 

*3. Interest Rate 

Enter the interest rate charged. 

 

 

4. Compounding Per Year 

Enter the number of compounding periods in the year. 

 

 

5. Payments Per Compound 

Enter the number of payments to be made per compounding period. 

 

 

*6. Number of Payments 

Enter the total number of payments to pay back the loan.   

 

If you leave this field set to zero, you are asked "Allow change to payment amount ?".  If you 

answer Y, the payment amount you enter in field 7 may be adjusted by the calculation.  If you 

answer N, the payment amount in field 7 will not be adjusted. 

 

 

*7. Payment Amount 

Enter the amount of each payment.   

 

The field you skipped is calculated and displayed.   

 

The displayed total repayment amount (principal plus interest) and total interest amount are 

approximate.  Print the amortization (payment) schedule to get their correct values. 

 

You are asked if you want to print a payment schedule.  If you do, enter "First payment date" 

when asked.  (This is the date the first payment is to be made.) 
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Chapter 29 - “X” Export Printer Reports 
 

 

Printing Reports to an Export File 
 

Most of the Current Reports and History Reports in the GL can be exported. 

Excluding the worksheet and the source cross reference sheet. 

 

If you see the letter ‘X’ on the list of printer’s windows, then that report has the export 

function. 

 

We are continually adding more. 

 

In order to open Reports printed to the ‘X’ printer, the User must have access to their local 

directory. If you are a Thin Client® User, you must identify the directory in SYSTEM FUNCTIONS 

 COMPANY DATA. The default is C:\SSIDOCS\.  

 

Each Report printed to the ‘X’ printer is assigned a default file name. After you select the ‘X’ 

printer, a pop-up window will prompt [F1] to accept the default filename displayed or enter your 

own filename. Remember to assign a unique filename to each Report that you wish to keep as 

filenames can be reused and the data over-written. 

 

NOTE: A Report printed to disk cannot be later printed to the ‘X’ printer.  

 

The first time that you select the ‘X’ Export “printer” from the pop-up Printer Selection window, 

the system may prompt you to identify which program should be used to open the file. The 

export files are designed to be opened with Excel. However, they can be opened with any 

software that can access tab delimited files (e.g. Windows, Thin Client®). 

 

Please note that there may be a delay between the time the Report has ‘finished printing’ and the 

time the Excel worksheet opens.  This delay is dependent upon your system activity levels and if 

you have the default to open automatically.  
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Enter the parameters for your 

Report as you normally do.  

 

When the Printer selection popup 

window is displayed, select the ‘X’ 

printer. 

Follow the system prompts to 

cancel the Report request or 

accept the default file name 

OR 

Type a new file name. 
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In Windows 10 you will be promoted on how you want to open file: Check if your default in the 

Control Panel  > Default Programs has been set to ‘Excel;’ 
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Appendix  
 

Initializing Raw Data Files 

 

"Initialize" means to create a new raw data file.  When you initialize a raw data file which 

already exists, any information in it is completely erased, and the file is newly created. 

 

This function allows you to initialize one or more raw data files. 

 

You probably won't need to initialize data files very often.  Usually, only when fixing a 

corrupted file. 

 

If you suspect you have a "corrupted" (fouled up) data file, don't initialize it without first 

checking with your supplier OR IT Support when attempting other recovery actions (see the 

Installation and System Guide related to the File Recovery Utilities). 

 

*** Caution *** 

 

DO NOT USE this function unless you really want to initialize a data file. The data file when 

initialized will completely erase all information. 

 

To Begin 

From your operating system prompt, change into the top-level directory where your Samco 

applications reside; i.e. C:\SSI (DOS), F:\PUBLIC\SSI (LAN / Network), /usr/ssi (Linux / Unix) 

etc.  From there, type sh GLINIT 

 

Enter in the ID number for the Company whose G/L file(s) you want to initialize. 

 

You will see a screen similar to this:  
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NOTE: Files 31, 32, and 33 appear only if the Company you are working with is a 

Consolidation Company.  Refer to the Company Consolidation Chapter. 

 

Answer Y for each file you want to initialize, N to not initialize a file. 

 

 

1. Company File 

This file contains your Company's name and address and various information about how your 

software runs - including the G/L account structure. 
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2. G/L Control File 

This file contains a number of parameters that define your general ledger structure.  Each 

parameter defines specific values to be used in other programs. 

 

 

3. G/L Notes File 

This file contains all the notes you have entered in the various G/L selections which allow notes, 

except for notes entered through General Journal, which are not saved after posting. 

 

 

4. Valid G/L Acct File 

All G/L accounts to which other Packages may distribute must be entered in this file. 

 

 

5. Accounting Period File 

The Accounting Period File defines all of the accounting periods in the fiscal year and designates 

the current and reporting periods. 

 

 

6. Text File 

The Text File contains text that is to be printed on Financial Statements. 

 

 

7. Chart of Accounts File 

The Chart of Accounts Files defines all of the accounts to be used by General Ledger and 

contains basic data about each account. 

 

 

8. Change Chart of Accts File 

This file records changes to the Chart of Accounts record, and the record after the change was 

made.  This file will be used only if the change log feature is used. 

 

 

9. Gen Journal Trans File 

This file contains transactions entered using G/L or interfaced from other Samco Packages.  This 

file is cleared when General Journal transactions (entries) are posted. 

 

 

10. Gen Journal Notes File 

This file contains the notes you have entered through the General Journal selection for entries 

which would have not been posted. (When General Journal entries are posted, the notes are not 

saved.) 

 

 

11. Gen Journal Lock File 

This file is used to protect the General Journal Transaction File. 
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12. Recurring Journal File 

This file contains recurring transaction information from which general Journal entries are 

created periodically. 

 

 

13. Std Journal Trans File 

This file contains standard Journal transactions (entries). 

 

 

14. Std Journal Lock File 

This file is used to protect the Standard Journal Transaction File. 

 

 

15. Gen Ledger Trans (Entry) File 

This file contains records from General Journal and Standard Journal transactions after they are 

posted.  It is the permanent G/L file. 

 

 

16. Gen Ledger Lock File 

This file is used to protect the General Ledger Transaction File. 

 

 

17. Layout File 

The Layout File contains the instructions that determine the appearance of each Financial 

Statement. 

 

 

18. SAF Layout File 

This is a work file used in automatically generating standard Financial Statement layouts for the 

source and application of funds Reports. 

 

 

19. Stmnt Specification File 

This file contains one record for each statement to be printed. 

 

 

20. Statement Pass File 

This file is used to carry control information for statement printing and is only used internally. 

 

 

21. Statement Work File 

This file is used to organize the statement file and is only used internally. 

 

 

22. Sub-Account Group File 

This file contains one record for each section sub-account group defined. 
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23. Criteria Header File 

This file contains the information entered on the first screen of the Add criteria and Change 

criteria in the Automatic Journal Maintenance mode. 

 

 

24. Criteria Line File 

This file contains the information entered on the second screen of the Add criteria and Change 

criteria, in the Automatic Journal Maintenance mode. 

 

 

25. Criteria Lock File 

This file is used to protect both the Criteria Header File and Criteria Line File from other Users 

in a multiple-User system. 

 

 

26. Extract Specification File. 

 

 

27. Extract Work File 

 

 

28. Extract Pass File 

 

 

29. General Ledger transaction detail 

 

 

30. General Journal transaction detail 

 

 

31. Member File 

This file defines all member companies of consolidations and contains the section sub-account 

designations to be used for each member Company. 

 

 

32. Account Link File 

This file defines the links between the chart of accounts in each member Company and in the 

Consolidation Company.  It also contains a description of each account linked.  In addition, it 

specifies whether or not each member's budgets and comparatives have been added to the 

Consolidation Company's budgets and comparatives. 

 

 

33. Company Consol Lock File 

This file is used to protect the Company Consolidation selection from other Users in a multiple-

User system. 
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Handling Periodic Inventory 

 

NOTE: The following method of handling inventory is based on the Periodic Method. The 

Samco Inventory Plus Package is based on the Perpetual Method; so, if you are using that 

Package, disregard this appendix. 

 

 

For inventory and cost of goods sold to appear correctly on a Profit and Loss Statement, you 

must follow certain procedures before you print the statement.  If these steps are followed, the 

cost of goods sold section will appear as follows: 

 

 

 CURRENT-PERIOD  YEAR-TO-DATE 

 

Beginning Inventory 9,999.99   99,999.99 

Purchases    999.99     9,999.99 

Ending Inventory (9,999.99)   (99,999.99) 

 _____________   _____________ 

Cost of Goods Sold    999.99      9,999.99 

 

 

Purchases are added to beginning inventory.  Then ending inventory is subtracted to yield cost of 

goods sold. 

 

Additional accounts for purchase returns and allowances, purchase discounts, etc., may be 

included.  What is represented above is the basic structure of the cost of goods sold section. 

 

 

In manual bookkeeping, the above entries for beginning and ending inventory appear as 

adjustments to the trial balance.  Beginning inventory is brought onto the P&L statement by 

posting a debit to "Beginning Inventory" and a corresponding credit to the balance sheet 

"Inventory" account.  Ending inventory is noted by posting a credit to "Ending Inventory" and a 

corresponding debit to the balance sheet "Inventory" account. 

 

In the Samco General Ledger, the first step in entering and posting these adjustments is to define 

a G/L account which will be used for net changes to inventory.  Let us call this account "Net 

Change to Inventory". 

 

The second step in entering and posting these adjustments is to make an entry which debits "Net 

Changes to Inventory" for an amount equal to the opening balance of inventory for the period.  

The corresponding credit is to "Merchandise Inventory".  For example, 

 

DR Net Change to Inventory  96,833.45 

CR Merchandise Inventory     96,833.45 

 

The net result of these debits and credits is that the beginning balance of "Merchandise 

Inventory" (within the Samco G/L) is the opening inventory balance, the ending balance of 

"Merchandise Inventory" is the balance of inventory as of the end of the period, and the net 
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change (period to date) of "Net Change to inventory" is the net change to inventory. 

 

The "Net Change to Inventory" account will have a credit balance for the period if there is more 

inventory on hand at the end of the period than at the beginning of the period and represents the 

amount by which inventory increased during the period. 

 

The "Net Change to inventory" account will have a debit balance for the period if there is less 

inventory on hand at the end of the period than at the beginning of the period and represents the 

amount which inventory decreased during the period. 

 

The above entries should be dated within the period for which you are printing Financial 

Statements. 

 

On your P&L layout, enter account codes similar to the following: 

 

Acct-# or    Bal  Prt/  Prt Paren 

Function Description    Typ  Accum  Col Cntrl 

 

a) CLS1 

LIT COST OF GOODS SOLD: 

b) 1410      Merchandise Inventory  B   A 

c) PAT      Beginning Inventory         C 

d) 5010      Purchases    N  P    C 

e) 5020      Purchases Discounts  N  P    D 

f) 1410      Merchandise Inventory E   A 

g) PAT       Ending Inventory          C 

 UL 

h) SUB1 COST OF GOODS SOLD: 

 

The functions of the above lines are to: 

 

a) Clear subtotal one. 

 

b) Accumulate the beginning balance of inventory using the Merchandise Inventory account.  

The accumulated will be the opening balance of the Merchandise Inventory account for the 

period being printed. 

 

c) Print the accumulated beginning balance (using the PAT code to name the balance 

"Beginning Inventory"). 

 

d) Print the net changes in purchases and the net changes in purchase discounts. 

 

e) Accumulate the ending balance of inventory using the Merchandise Inventory account.  

Accumulate this using the ending balance of this account "reversed".  The amount 

accumulated will be the ending balance of the Merchandise Inventory account for the period 

being printed "reversed".  In the normal case, this will result in a credit balance being 

accumulated.  
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f) Print this accumulated ending balance (using the PAT code to name this balance "Ending 

Inventory"). 

 

g) Print the subtotal "SUB1", naming it "COST OF GOODS SOLD". 

 

 

Continuing with the example above, if purchases were $ 10,000 for the period and purchase 

discounts were $ 1,000 for the period, the debits and credits above would result in the following 

printout using this layout: 

 

Beginning Inventory   96,833.45 

Purchases   10,000.00 

Purchase discounts (   1,000.00) 

Ending Inventory (101,520.61) 

 _____________ 

 

COST OF GOODS SOLD:    4,312.84 

 

Note that the account, "Net Change to Inventory", does not appear on the P&L Statement. The 

beginning and ending balances of the inventory account are used directly.  The ending balance, 

which would normally be a debit, is reversed (multiplied by minus one) thereby showing a 

credit.  Since the parentheses control at the PAT code for line (g) is "C" the printed amount is 

enclosed by parentheses. 

 

This procedure meshes with automatic year end closing, since the net changes to inventory have 

been posted to a P&L account.  The year ending procedure picks up this net change and includes 

it in net income entries that are posted as part of the Close a Year selection. 

 

 

File Utilities 

 

This function will allow you to "recover" the data files that have become corrupted (fouled up).  

It will also allow you to recover disk space by converting, then restoring, a raw data file that has 

been purged or compressed.   

 

As well, you can run a complete backup of your General Ledger data files (in ASCII format) to 

either the fixed disk or to a floppy (any density).  This function is also used to upgrade raw data 

files from previous releases of Samco's and Real-World's General Ledger. 

 

NOTE: Under Xenix and Unix the files can only be backed up to the fixed disk. 
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Corrupted Data Files 

 

Data file corruption does not occur very often, but you do need to be aware of it just in case one 

of your raw data files become corrupted.  This can occur for only a handful of reasons.  The most 

common being: 

1. The power to your computer gets turned off when you are using your Samco 

applications. 

 

2. Your hard disk has developed a defect. 

 

NOTE: Corrupted data files can't be used reliably afterward, and any attempt to use them causes 

unusual error messages and you are  removed from running the Samco applications. 

 

 

If this occurs, or if you begin to get unusual results while using your Samco Software and 

suspect that there may be a corrupted data file, you should get technical support. 

 

Your supplier or an independent professional may be able to provide this support.  If not, contact 

Samco Software Inc.'s support department directly (there may be a fee). 

 

 

Handling 

Data file corruption does not mean that all of the data in the file is no longer usable.  Usually, 

just a few of the records in the file have become corrupted. 

In Backup file utilities, the function Convert a file will take out the good records in the data file 

and place these in a temporary file.  Once this is done, the function Restore a converted file is 

used to transfer the good records from the temporary file into a new permanent file. 

If the file you are attempting to convert has become so corrupted that the Convert a file function 

fails to run, refer to the end of this section the recovery utility "vutil". 

 

To Begin 

Select File utilities from the second page of the G/L Menu.  
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Exporting a Raw File 

 

Select File utilities > Export a File from page 2 of the G/L main Menu. 

 

You’ll see a screen similar to this: 

 

 
 

NOTE:  Fields 20, 21, and 22 only appear if this is a Consolidation Company. 

 

Please Select File 

Enter the number (1 - 22) of the file, or press [F1] to select "All" of the files for conversion. 

 

Please Enter Device for Converted File 

Enter 1 character for the disk on which the converted file is to be created.   

 

- NOTE: For Linux / Unix Users it doesn't matter what letter is entered, as the file will be 

created in the root Samco directory of the fixed disk; i.e. /u/ssi. 

-  

Please Enter Device Size in Kilobytes 

Enter up to a 5-digit number which represents the device you are backing up to in kilobytes, 

or press [F1] for "Unlimited" Hard disk drive. 

 

- NOTE: If you choose to convert "All" files, the screen will move immediately into 

displaying the file and record being backed up.  It skips past the "(C) CREATE NEW 

CONVERTED FILE OR (A) ADD RECORDS TO EXISTING CONVERTED FILE", "STARTING FILE 

KEY", AND "ENDING FILE KEY" prompts. 

On the next screen enter a starting and ending File Key range: 
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1. Starting File Key 

Enter the file key for the first record to convert, or press [F1] to begin conversion at the "First" 

record on file. 

 

A person who knows the exact record key layout for that file may enter the exact starting record 

key here, thereby enabling a partial conversion.  The key would have to be entered exactly as it 

appears in the record with leading zeros or spaces. 

 

 

2. Ending File Key 

Enter the file key for the last record to convert, or press [F1] to end conversion at the "Last" 

record on file. 

(C) Create or (A) Add 

 

You are asked whether to "(C) create new converted file or (A) add records to existing converted 

file". 

 

If you have never converted this file before, answer C.  A new file with the same name, but an 

extension of "EXP" will be created. 

 

If you have previously converted this file, and you wish to add data to it, answer A. 

 

NOTE: If you choose A, records are added to the ".EXP" file regardless of the records 

already there.  Be sure not to overlap file key ranges when using this method, otherwise you 

will get duplicates on the ".EXP" file. 

 

 

The file will now be converted.  The screen will show a count of the records as they are 

converted.  The converted file will be located on the device specified earlier, and have the same 

name as the original file, except the extension will be .EXP. 

 

After you have completed running the convert routine, you will be prompted to select a printer 

destination for the backup log.  A backup log shows the file(s) converted, the number of records 

per file, and the date and time. 

 

 

Restoring the Raw Data through an Exported File 

 

This selection is used to restore files that have been converted through the Export a file function.  

All of the data contained in the converted files will be transferred to the files which you are 

restoring. 

 

Select Restore an exported file from the File Utilities Menu. 

 

A screen similar to the following appears:  
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NOTE: Fields 20, 21, and 22 only appear if this is a Consolidation Company. 

 

Please Select File 

Enter the number (1 - 22) of the file, or press [F1] to select "All" files to restore. 

 

Please Enter Device for Converted File 

Enter 1 character for the disk or diskette which contains the converted file.   

 

NOTE: For Linux / Unix Users it doesn't matter what letter is entered, as the file must 

always reside in the root Samco directory of the fixed disk; i.e. /u/ssi. 

 

Please Enter Device Size in Kilobytes 

Enter up to a 5-digit number which represents the device you are restoring from in kilobytes, or 

press   [F1] for "Unlimited". 

  

NOTE: If you choose to restore "All" files, the screen skips past the "(C) CREATE NEW 

CONVERTED FILE OR (A) ADD RECORDS TO EXISTING CONVERTED FILE", "STARTING FILE KEY", 

AND "ENDING FILE KEY" prompts. 

 

On the next screen enter a starting and ending file key range: 

 

 

1. Starting File Key 

Enter the file key for the first record to restore, or press [F1] to begin restoration at the "First" 

record on file. 

 

A person who knows the exact record key layout for that file may enter the exact starting record 

key here, thereby enabling a partial conversion.  The key would have to be entered exactly as it 

appears in the record with leading zeros or spaces.  
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2. Ending File Key 

Enter the file key for the last record to restore, or press [F1] to end restoration at the "Last" 

record on file. 

(C) Create or (A) Add 

 

You are asked whether to "(C) create new data file or (A) add records to existing data file". 

 

If you answer C (create new file), all of the existing data records in the original file will be 

destroyed, and the data records contained in the converted file will be transferred to the original 

file. 

 

If you answer A (add records to file), all of the existing records in the original file will remain, 

and the data records contained in the converted file will be added to the original file. 

 

Answer Y or N, as appropriate. 

 

The file(s) will now be restored. A message will be displayed on the screen showing the count of 

the records as they are store. 

 

Once complete, select a printer destination for the restore log.  A restore log shows the files(s) 

restored, the number of records per file, and the date and time. 

 

 

NOTE:  You can use the Export and Restore functions on an entire raw data file to recover disk 

space from a file that has been purged or compressed (or from a file that has had many 

deletions).   

 

First do a full (first record to last record) Export of the file.   

 

Then do a full Restore of the exported file, using the (C) Create new data file option. 

 

 

Upgrading G/L Data 

This selection allows you to upgrade data files from previous releases of the Samco and Real 

World General Ledger. Instructions for its use are provided with the upgrade notes for the 

specific version you are upgrading from. 

 

 

Copy File from Another Company 

This function allows you to copy files from an existing Company into your current Company. 

 

 

NOTE: By running this function you will overwrite the existing file(s) so be absolutely sure this 

is what you’re wanting to do before continuing. 

 

 

 

Select Copy file from another Company from the File Utilities Menu.  
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Please Select 

Specify which of the four files you wish to transfer over. 

 

If you select to copy the Chart of Accounts you will be prompted to "Clear which fields ?" - B = 

Budgets, C = Comparatives, A = All, or N = None.  This allows you to reset the appropriate 

fields in the chart of accounts file to .00 (as per your choice) or to leave them as they are. 

After you have made your selection, you will be prompted to enter the number of the Company 

to be used as the source of information.  Enter the two-character code. 

The source Company name, and a count of the records being processed are display 
 

 

Rebuild a Raw Data File  
 

Rebuilding raw data Files can be used for one of two reasons: 

 

1. A data File has become corrupted and needs to be recovered. 

2. To recover disk space and clean out deleted or purged records. 

 

The Rebuild a File function essentially takes the good records out of a File, removes the old File, 

and creates a new File with the good records. 

 

To begin, select Rebuild a File from the File Utilities Menu.  
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Enter the following information: 

 

Please Select File 

Enter the number of the File you wish to rebuild,  OR: 

 

[F1] -To rebuild all of the raw data Files. 

A new screen will appear showing the status of each File as it is being rebuilt.  Once completed, 

you are returned to the Rebuild a File screen. 

 

Rebuild Chart Comparatives  
 

This function is used to recalculate the chart of account comparatives using the historical G/L 

transaction data. It is useful where you’ve changed your year end and the numbers don’t match.  

 

To begin, select Rebuild chart comparatives from the File utilities menu. A screen displays the 

starting and ending year that will be used to calculate the monthly comparatives from the Setup > 

Accounting periods. 

 

Answer Y if the comparative year starting / ending date is correct. Otherwise, answer N and 

change the account periods to reflect the proper current year. 

 

 

_______________ 

 

 

 
 


